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This document has been prepared for: 
Federal Highway Administration 
Eastern Federal Lands Highway Division 
21400 Ridgetop Circle 
Sterling, Virginia 20166 

The software products referred to in this publication are furnished under a 
license and may only be used in accordance with the terms of such license.  

The information in this publication is subject to change without notice. 
Bentley assumes no responsibility for errors that may appear in this software 
or occur as a result of its use, or the use of these CADD standards. 

Trademarks 

Bentley, the “B” logo, Microstation, and GEOPAK are registered trademarks of 
Bentley Systems, Incorporated.  

AutoCAD is a registered trademark of AutoDesk, Inc. 

Software Versions 

Microstation Version 8.5.02.55 

GEOPAK      Version 8.8.02.40 
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Chapter 1 Introduction 
Purpose 
This document is intended to outline the Federal Highway 
Administration’s Eastern Federal Lands Highway Division’s (EFLHD) 
use of Bentley’s MicroStation V8 Version 8.5.02.55 and GEOPAK 
Version 8.8.02.40, as well as internally developed tools and 
procedures. The CADD (Computer Aided Design and Drafting) 
Standards Manual will address issues such as: software, tools, 
techniques, standards, and procedures, which will aid the user in the 
efficient production of PS&E plans. 

The CADD Standards Manual and the associated electronic files are to 
be used in the generation of electronic plans by both EFLHD internal 
designers and the A/E firms doing business with EFLHD. 

The proper use of CADD Standards can produce many desirable 
results, including: 

• Increased efficiency and productivity 
• Re-usability of data 
• Increased ability to share resources 

The CADD Standards Manual is intended to be as all encompassing 
as possible. However, there will be circumstances, such as with 
various scales of drawings, where there is no one correct answer. In 
these cases the engineer or designer must use his or her judgment to 
stay as close to the original intent of this manual as possible. 
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Outline of Manual 
The CADD Standards Manual covers the use of both MicroStation and 
GEOPAK. The first section of Chapters covers the use of MicroStation 
V8, Version 8.5.02.55, including topics such as: 

• Directory structures 
• File naming conventions and locations 
• Seed files 
• Annotation 
• Line styles 
• Color Table 
• Cell libraries 
• Levels and Symbology 
• Batch Printing 

 
The second section of Chapters covers the use of GEOPAK Version 
8.8.02.40, including topics such as: 

• User Preferences 
• Project Manager 
• Survey 
• DTM creation 
• Design and Computation Manager 
• Horizontal and Vertical Design 
• Cross-Sections 
• Plan & Profile Sheet Clipping  
• Quantities 
• Reports 
• File exchange procedures 
• Models 
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Conventions 
The CADD Standards Manual contains special features designed to 
help the users find information quickly and easily. Below is a 
description of the conventions used throughout this manual. 

Use of Bold and (>) Greater-Than Symbol 
Bold letters are used to identify program commands, menus, and file 
names. The greater-than symbol (>) is used to divide a series of 
commands. 

For example: 
Open the file TTL.dgn using the File>Open command. If it is not in the 
expected folder, click the Cancel button. 
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Caution is to be shown when the reader should take 
particular note of the information being discussed. 

 

 

 

Information is used to provide helpful information 
about a particular item when it is being discussed, or 
to provide general information about the standards 
as needed. 

 

Hyper linking 
Throughout the manual there will be references to information found 
on the EFLHD website, along with the accompanying web link to this 
information. Links will be as shown below: 
 
http://www.efl.fhwa.dot.gov/

http://www.cflhd.gov/
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Terms and Abbreviations 
Abbreviation Description 
CADD Computer Aided Drafting and Design 

EFLHD/EFL Eastern Federal Lands Highway Division 

Excel Spreadsheet software from Microsoft 

FHWA Federal Highway Administration 

GEOPAK Civil Engineering highway design software from Bentley 
Systems, Inc. 

MicroStation Drafting Software from Bentley Systems, Inc. 

PS&E Plans, Specifications, & Estimates 

Symbology Color, weight, and style of graphical elements 

Working units MicroStation’s system of precision including MU, SU, and 
UOR 

MU Master Units, part of MicroStation's unit system 

SU Sub-units, part of MicroStation's unit system 

UOR Units of Resolution 

Table 1-1:  Terms and Abbreviations 

Standard File Extensions 
Extension Description 
. DGN MicroStation graphics design file 

. DWG AutoCAD graphics design file 

. DDB GEOPAK D&C Manager database file 

. RSC MicroStation resource file 

.X30 GEOPAK Criteria files version 

.DTM Microstation design file containing 3D graphics used to 
create GEOPAK .TIN file 

.TIN GEOPAK digital terrain model 

.DAT Hydraulic model file (ASCII file containing Northing, Easting, 
Elevation. 

.SMD Survey manager database 

.GPK GEOPAK coordinate geometry database 

.TXT Final ASCII survey control file 

.DGNLIB MicroStation library containing levels, text styles and 
dimension styles 

Table 1-2:  File Extensions 
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Support 
CADD Support help using this manual, comments, and suggestions for 
these CADD standards should be submitted using the standard 
change form, which can be downloaded here, and e-mailed to: 

Richard.McDaniel@fhwa.dot.gov     

Shoukat.nawaz@fhwa.dot.gov   

FLHD’s use of MicroStation V8, 2004 Edition 
While there are many new tools in MicroStation V8 Version 8.5.02.55 
that EFLHD will take advantage of, there are others that will not be 
endorsed by EFLHD at this time.  If the use of a particular tool is not 
outlined in this section, or in its appropriate place in the CADD 
Standards Manual, check with the EFLHD project manager as to the 
acceptance of its use.  The most important of these tools and the 
EFLHD use of these tools is outlined below.  As EFLHD is currently 
testing some of these tools to determine the best use for EFLHD, 
comments on potential uses are welcome and should be sent to the 
above e-mail address. 

New Generation of Standard Files 
EFLHD is implementing a new generation of MicroStation/GEOPAK 
standard files. This new generation is known as the X30 Generation of 
standard files.  Listed below are links to MicroStation V8/GEOPAK 
2004 – X30 Generation of Standard Files and Off-Site Configuration 
instructions.  Consultants working on EFLHD projects should download 
the CADD_Resource_V8.zip and configure their CADD environment 
with X30 Generation of Standard Files. 

MicroStation V8 / GEOPAK 2004 - X30 Generation of Standard Files

Off-Site Configuration Instructions

Design History 
At this time EFLHD will not be using Design History.  However, AE 
firms may use design history if desired.  EFLHD is currently evaluating 
the best uses for Design History, comments and suggestions may be 
submitted to the e-mail address listed above. 

Macros 
MicroStation Basic Macros and MicroStation Visual Basic Applications 
(MVBA) help the user to streamline processes, check geometry, and 
enhance overall efficiency.  Currently EFL does not use macros or 
MVBA but may in the future. Please check back to see what has been 
added.  

mailto:Richard.McDaniel@fhwa.dot.gov
http://www.cflhd.gov/cadd/standard-files/micro8-geopak04-x30.cfm
http://www.wfl.fha.dot.gov/design/cadd/microstation_2004/downloads.htm
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 The Macros for MicroStation 2004 are in the process 
of being updated or being converted to MVBA. Please 
check back often as they will be added to the website 
as completed.  A list of macros and descriptions will 
also be available at a later date. 
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Chapter 2 Directory Structures 

Project Directory Structure 
Project related files, including CADD drawing files, survey and 
mapping data, and engineering data files, will be contained 
within a specific project directory structure. Files also 
contained within this directory structure include, 
correspondence, project documentation, reports, etc. 
Following the directory structure as indicated in this chapter 
will allow for consistent handling of all project files, as well as 
allow for easier archiving at project completion. The first level 
project directory is shown below, the following pages outline 
each first level directory in much greater detail, including 
subdirectories, purpose of each directory, and types of files 
typically stored within each directory. 

 

Figure 2-1: Project Directory 

 

While not all directories will be needed for each project, the 
structure naming convention must be followed where 
applicable. The sub-directory addressed in this chapter is 
proj_dev. 
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 The project directory structure has evolved over the last 
few years so the directory structure for older projects 
may not match what is shown here.  The directory 
structure and file locations for older projects need not 
be changed. The directory structure will be set up 
for the Project Manager at the beginning of the 
project. 

 

 

 
 
 

Proj_dev 

The sub-directories of the proj_dev directory are detailed below. 

 
Figure 2-2: Proj_dev Directory 

Each sub-directory contains specific files related to each 
project. The table below outlines the files to be contained 
within each sub-directory. 
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CADD Overall files other than mapping. Including; 
Alignment file, utility and drainage, traffic control, 
signing and striping, erosion control, GEOPAK 
superelevation shapes and patterns, and overall 
cross-sections including ref-hub cross sections. 

Geopak Project GPK file, GEOPAK input, output files, and 
log files 

Std_Det Standards and Details 

Correspd Print files, used by contracts group 

Distribu Distribution Files 

e-mail Project e-mails 

misc All other documentation 

Pictures Project photos 

Plots Plot files.  (.ini, .000, etc.) 

         ADOBE Sub-folder to Plots.  Contains all pdf format files 

Quantity Project quantity estimates 

Scoping Scoping report documentation 

SCR Special contract requirements 

sow_ige Statement of work 

Table 2-1: proj_dev Sub-directory Files 

 

Bridge 

 

Figure 2-3: Bridge Directory 
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Design Design calculations 

Microsta MicroStation drawing 

Plots Plot files 

Specials Special Provisions 

Table 2-2:  Bridge Sub-directory Files 

CADD Support Directory Structure 

The CADD support directories contain the standard CADD 
resource files detailed in the following chapters. These include 
set up, configuration, and resource files for MicroStation and 
GEOPAK such as MicroStation seed files and cell libraries, and 
GEOPAK database files and superelevation tables.   

 
For EFLHD employees the individual CADD machines 
have been configured with project configuration 
files (.pcf) to automatically find and attach these files. 
See workflow 1 to make sure these .pcf files are in the 
correct directory.  Use of fonts, line styles, etc., should 
be seamless. 

 For our consultants, the X30 Generation of 
standard files download (CADD_Resource_V8.zip) 
can be used to setup the standard CADD support 
directory structure.  Project configuration files 
(EFLHD_Eng_30.pcf and EFLHD_Eng_30.pcf) are 
also provided in the download for the ease of setting 
up project configuration.  

 

 

 

 

 

 

 

Select to link to the EFLHD Website and to download files: X30 
Generation of standard files downloads
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This link is not set up at this time.

The standard CADD resource files are set up and maintained 
by the CADD Coordinator.  The resource files are "read-only", 
as are the directories they reside in, so users cannot make 
changes to these files or create additional alternate versions of 
them on the server.  These resource files are the "official" 
versions that should be used throughout EFLHD.  Any errors 

http://www.cflhd.gov/cadd/standard-files/micro8-geopak04-x30.cfm
http://www.cflhd.gov/cadd/standard-files/micro8-geopak04-x30.cfm
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discovered in these files should be reported to the CADD 
Coordinator so that they can be fixed. 

The standard CADD resource files are located on the designers 
M: drive in subdirectories under the Standards directory and 
are accessed by all EFLHD users from here. The directories are 
shown below: 

                                         

 

Figure 2-4: CADD Resource Files 
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Batch_Plot Batch plot setup for EFLHD’s Acrobat  Plan sheets generator. 

Borders EFLHD standard borders – English and Metric in different 
models 

Cross_Section_Shts Cross section sheet layout libraries(*.xssl) and instruction 

Engineers’s_Estimate Instruction to export into dgn tabulation sheet 

Master_GPK_Number Excel file for GPK number – Only for EFLHD’s Project Manager 

Plan&Profile_Shts Plan and profile sheet layout libraries(*.psll) and instruction 

Project_Configurations Location of EFLHD pcf files (EFLHD_Eng_30.pcf and 
EFLHD_Met_30.pcf)  

Quantity_Shts Quantity dgn sheets, quantity Excel worksheet, and instruction 
– EFLHD’s quantity and schedule sheets are attached with Excel 
file  

Sample_Shts Includes EFLHD’s Title sheets, Symbol & abbreviation sheets. 

Std_Det_Shts Instruction to use FLH Standard sheets. 

3PC Miscellaneous criteria files, including MicroStation Basic user 
interface macros. 

Cell_Lib Standard Cell Libraries (*.cel), FLH_Criteria.cel – Standard 
criteria cell library. 

Config FLHD pcf file (FHWA_English_30.pcf and FHWA_Metric_30.pcf)-
not used by EFLHD 

DDBS US Customary and Metric D&C Manager database files (*.ddb) 

Help Diagrams  

Input_Files EFLHD’s earthwork input files for X30 and ancillary data (*.inp) 

Library_Files Standard criteria level library and text style library (*.dgnlib) 

MVBA  

Plotting EFLHD standard plot drivers-Includes shades, color, black and 
white, and pdf plot drivers.  

Resources EFLHD’s font and custom linestyle resource files (.rsc) 

Seed US Customary and Metric 2D and 3D seed files (*.dgn) 

Seed_runs  

Tables Standard color and superelevation tables for X30 

Table 2-3: CADD Support Sub-directory Files 
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Chapter 3 File Naming Conventions 
and Plan Sheet Organization 

 
 
There are many types of files in use at EFLHD. Of utmost 
importance is the naming convention of the Microstation design 
files produced throughout a project. The file naming convention is 
set up to allow anyone to identify the contents of a CAD file 
without actually opening the file. The following design File Naming 
Convention is to be implemented on all new projects. This 
convention is to be used by all EFLHD users and A&E consultant.   

Also shown, at the end of this section, is the order of plan sheets 
for a typical EFLHD project. It is hard to imagine every type of file 
that may be created in a special case. If a file is not shown, best 
judgment must be exercised to place the file in an appropriate 
place within the plan set. 
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Naming Convention, Microstation Design Files  

For Highway Design Section 

There are two types of design files that are produced in the 
process of generating construction plan sheets; Sheet design files 
and Master design files; Sheet design files represent the finished 
construction documents for a project, and the Master design files 
will be used as a reference to the sheet design files.  

Assigning file names to CADD design files is to be done with consistency 
to make future searches for the files a simpler task.                                             
All EFLHD Microstation design files should be named with the following 
formats: 

 

   XXX-YYYYYYYY_ZZZ.dgn 

                                      

      File type descriptor (See table 3.4) 

                       Project number descriptor (See table 3.3) 

                         Section number descriptor (See table 3.1) – Master Design Files 
                Sheet Number descriptor (See table 3.2) –Sheet Design Files                
               

 
 
 
For All Master Design Files: 
       
Section 
Number 
Descriptor 

Description 

01 Highway Design Section  
02 Survey 
03 Hydraulics 
04 Safety Engineering/Environmental Engineering 
05 Geotechnical Engineering 
06 Traffic Engineering/Pavement Engineering 
07 Bridge Design Section 
08 Construction Engineering 
09 A&E (All Consultants) 

Table 3.1 
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Plan Sheet Organization: 
       
Sheet 
Number 
Descriptor 

Description 

A Title Sheet, Conventional Plan Symbols and Abbreviations, 
Location plan, Survey and horizontal alignment information 
plan 

B Typical Sections 
C Tabulation of quantities and Summaries & Schedules 
D Mainline Plan and Profile Sheets 
E-K Minor Roadways Plan and Profile Sheets and others. 
M Erosion Control Plan & Narrative, Landscape Plan (last) 
N Temporary Traffic Control Plans 
P Permanent Signing & Striping Plans 
R Bridge Plans 
S Standard Details Sheets and Special Details 
T Mainline Cross Section Sheets 
U-Z Minor Roadways and others Cross Section Sheets 

Table 3.2 
 

Note:-             I, L, O, and Q letter designations are not to be 
used so as not to cause confusion between these 
letters and the numbers 0 and 1. 

 
 
 
Project Number Organization: 
 
 Forest 

Highway 
Park, Refuge 
Road 

Other 

Project Name AR PFH 65-3(5) PRA RICH 300(1) MT OMAD 18(33) 

State/Park/Progr
am 

Arkansas Richmond State 
Park 

Missile Road 

Highway Route 65 300 18 

Segment of 
Route 

3 N/A N/A 

Project Number 5 1 33 

Project Number 
Descriptor 

AR653(5) RICH300(1) OMAD18(33) 

Table 3.3
 
File Type Descriptor:
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 File Type Descriptor 
Title Sheet     ttl  
Vicinity Maps/Location Sheet   loc 
Symbols and Abbreviations        sym 
Survey & Horizontal Alignment Inf.  sur 
Typical Sections    typ 
Summary of quantities/Tabulation  qnt 
Plans and profiles    Pln(for plan), prf(for profile), 

p&p(for plan & profile)            
Storm drainage plan    dpl 
Storm drainage profile    dpr 
Box Culvert  Plan & Profile   bpp 
Drainage cross section    xsd 
Utility Plans and profiles   upp 
Erosion Control Plan/narrative   e&s 
Landscaping Plan lnd 
Temp Traffic control plan   tcp 
Permanent Signing & Striping plan  ssp 
Bridge Plan     brp 
Roadway Cross sections  sheets 
  

xss 

Master Design Files  

Project Border File bdr 
Master file for design and Alignment       des 
Master file for Profile                             pro 
Super elevations, pattern for x-sections  wrk 
Area Pattern for new pavement   etc.     pat 
Master Cross section (mainline)             Dxs 
Minor Roadways cross section& others    Exs, Fxs, Gxs, Hxs,  etc. 
Hydraulic, drainage, sediment & erosion hyd 
Master Survey, ROW & Utility Files   

Ground Mapping (3D) map 
Cadastral mapping ( Property, 
boundary & ROW)    

cad 

Utility Mapping                               utl 
Aerial Mapping – break-lines & Points 
(3D)       

dtm 

Aerial Mapping Intermediate and Index 
Contours (3D)    

tpo 

Aerial Mapping Planimetrics (2D)            plm 
Aerial Ground Cross Sections     xsc 
Right –Of-Way Plans row 
Federal Lands Transfer Plans flt 

 
Note: The 3-digit file descriptor is given for most of the sheets in 
STANDARDS FOR USE WITH X30 CRITERIA 3-4 
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a typical plan set and master design files. As it is hard to foresee 
every type of file that may be included in a plan set, a special 
case may arise where there is no file descriptor for a file that has 
been created. In such a case, follow the rest of the naming 
convention as closely as possible, while generating a unique file 
descriptor for the new file.  

 

Standards and special Details:  

All standards and details should be downloaded from WFLHD and 
not renamed. 

All EFLHD Details are copied from EFLHD’s Standard directory and 
also not renamed. 
Standards, Details, and Special Details will be kept in Std-Det 
directory on the project directory. 

Note: 1. A special Detail is a modified standard, detail, or project 
specific    detail and should have next alpha. 
2. The Standard Sheet number should have S prefix on it 
as shown in Table 3.1  
2. The sheet numbers of the specials and details are 
determined after all the standards, details, and special 
details are assembled. 

 

Naming Convention of EFLHD GEOPAK Job number 
files:  

                                                   Job###.gpk 

 
This binary file is created when the user starts a coordinate 
geometry (COGO) session for the first time or created through 
Project Manager. All coordinate geometry elements are stored in 
this file. Multiple users can access this file at the same time, and 
only one file should be created for each project. The “###” is the 
only variable in this filename. It represents a job number (up to 3 
alphanumeric characters) unique to a project and is defined by 
the user upon creation. 

When working on EFLHD projects, the .gpk number will be 
assigned by the Project Manager. The convention will be a 
standard numeric system, starting at 600 for year 2006 and 700 
for year 2007 and so on. The first .gpk file assigned in year 2006 
would be job600.gpk, then job601.gpk, etc. Internally, EFLHD 
personnel will request a .gpk number from the Project Manager. 
The Project Manager will then check out a number, from a file on 
the wheels server, documenting the project information for the 
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number is assigned to. This document will be the master list of all 
.gpk files assigned for all projects. Design Project Manager Can 
checkout the .gpk number from 
M:\Cadd_resource_v8\Master_GPK Numbers\MasterGPK-List.xls.  

 

Example: Suggested Naming Convention for NWR Project -RRP 
LOP 10(2) :  

Sheet 
Series 

Sheet 
No. 

Description Design File 
names 

Remarks 

A A01 
A02 
A03 
A04 

Title Sheet 
Location Map Sheet 
Symbol & Abbreviation 
Sheets 
Survey Information Sheet 

A01-
LOP10(2)_ttl 
A02-
LOP10(2)_loc 
A03-
LOP10(2)_sym 
A04-
LOP10(2)_sur 

 

B  
B01 
B02 

 
Typical Section Sheet 1 
Typical Section Sheet 2 

B-LOP10(2)_typ 
Model name B01 
Model name B02 

Typical Sections 
 

C  
C01          
C02          
C03          
C04 

 
Tabulation Of Quantity Sheet 
Summaries & Schedules 1 
Summaries & Schedules 2 
Summaries & Schedules 3  
etc. 

C-LOP10(2)_qnt 
Models name 
C01 
Models name 
C02 
Models name 
C03 
Models name 
C04 

Quantity Sheets 

 
D01 
D02 
D03 
D04 

 
Plan & Profile Sheet 1 of 
Road 1 
Plan & Profile Sheet 2 of 
Road 1 Plan & Profile Sheet 3 
of Road 1 Plan & Profile 
Sheet 4 of Road 1 

D-LOP10(2)_pnp 
Models name 
D01 
Models name 
D02 
Models name 
D03 
Models name 
D04 

Plan & Profile sheet for 
Mainline Roadways 

D 

D05 
D06 
D07 
D08 
D09 

Plan & Profile Sheet 1 of 
Driveway 
Plan & Profile Sheet 2 of 
Parking lot 
Plan Sheet of  Box Culvert 
Profile Sheet of Box Culvert 
Plan & Profile Sheet Utilities 

D5-
LOP10(2)_p&p 
D6-
LOP10(2)_p&p 
D7-
LOP10(2)_pln 
D8-LOP10(2)_prf 
D9-
LOP10(2)_p&p 

Driveway, Parking lot, 
culvert and utilities related 
to Mainline roadways 

E-K  
 

Road 2, all minors roads, and 
other roadways 
 

 Follow same as D series 
Sheets 
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M M01 
M02 to 
M03 
M04- to 
M05 

Erosion Control Narrative 
Erosion Control Plan sheet 
Road 1 
Erosion Control Plan sheet 
Road 2 

M01-
LOP10(2)_e&s 
MA-
LOP10(2)_e&s 
MB-
LOP10(2)_e&s 

 
Use models M02 & M03 
Use models M04 & M05 

N N01 to 
N03 
N04 to 
N05 
N06 

Temp. Traffic Control Plan  
Road 1 
Temp. Traffic Control Plan  
Road 2 
Temp. Traffic Control Plan  
others 

NA-
LOP10(2)_tcp 
NB-
LOP10(2)_tcp 
N06-
LOP10(2)_tcp 

Use models N01 N02, & 
N03 
Use models N04 & N05 
 

P  Permanent Signing & Striping 
Plan 

 Follow as N Series sheets 

T T01 to 
T30 

Cross Section Mainline Road 
1 

T-LOP10(2)_xss All cross section sheets of 
Road 1 will be in one 
design file 

U T01 to 
T10 

Cross Section minors Road 2 U-LOP10(2)_xss Same as in T Series 

Table 3.5 

 

 

 

Example - Plan Sheet Organization for the project: 
 
Sheet No. Description 
A01 
A02 
A03 
A04 

Title Sheet 
Location Map Sheet 
Symbol & Abbreviation Sheets 
Survey Information Sheet 

B01 –B02 Typical Sections 
C01             
C02 –C04    

Tabulation Of Quantity 
Summaries & Schedules  

D01-D09 Plan & Profile Sheet of Mainline Road, Driveway, Parking Lots, 
and Utilities. 

E01-E06 Plan & Profile Sheets od minor road 2, Driveway, Parking Lot 
M01- M05 Erosion Control Plan and Narrative 
N01-N06 Temp. Traffic Control Plan 
R01-R09 Bridge Plans 
S01-S19 Standard Details Sheets 
T01 to T30 Cross Section Mainline Road 1 

Table 3.6 
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Chapter 4 Seed Files 

Seed files 

Seed files form the base for most newly created MicroStation 
design files. Seed files act as a template for a new design file 
containing information such as, working units, global origin, 
coordinate readout, etc. Creating a new design file with the 
seed file and opening the new design file using with project 
configuration file (*.pcf) will give the user access to the EFL 
level library, outlined in the EFL levels and symbology chapter, 
as well as EFL text styles and dimension styles, outlined in the 
annotation chapter. 

At EFLHD, there are currently 4 seed files in use, each with 
attributes pertaining to a different design case. These seed files 
should be used to create all new files for EFLHD work.  See 
Workflow 1 for help with creating a new MicroStation design 
file using these seed files. 

EFLHD Seed Files 

Name Description 

Sur_ft2D.dgn US Customary 2D based on US Survey foot 

Sur_ft3D.dgn US Customary 3D based on US Survey foot 

Int_ft2D.dgn US Customary 2D based on International foot 

Int_ft3D.dgn US Customary 3D based on International foot 

Table 4.1:  Seed files for X30 Criteria 

These seed files are located at: 
 
M:\cadd_Resource_V8\X_30\Standards\Seed\English\  

M:\cadd_V8_Resource-V8\X_30\Standards\Seed\Metric\ 

 US survey foot seed files are widely used on EFL 
projects.  International foot seed files (Int_ft2D.dgn 
and Int_ft3D.dgn) shall only be used on EFL projects 
that have state requirement for these working units.   
Consultants should contact your COTR if unsure of 
which seed files to use.  Note: The above seed files 
have a resolution of 10,000.
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Working units have changed significantly in MicroStation V8.  No 
longer does changing the basic working units affect the size of 
elements contained in the .dgn file.  A conversion is now done within 
the software to display the correct length of elements when the 
working units are changed from Metric to English, or from drawings 
with different master and sub units.  The design plane has changed as 
well, to be virtually unlimited.  As such, global origin is no longer a 
factor. 
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Workflow 1: Creating A New 
Microstation Design File 

 

 
1. When starting Microstation, the first dialog 

shown is the Microstation Manager. From 
Microstation Manager, select File>New. 

 

Figure 4-1:  New file 

2. The Create New Design File dialog will 
activate.  Under the Seed File heading a file is 
already selected. Click on the Select button to 
select the correct seed file.  The Seed File dialog 
below shows the path to the EFLHD seed file.  
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Figure 4-2:  New File 

From this dialog the user can give the file a new name, select 
the directory where the file will reside, and select the 
appropriate seed file to act as a base for the new design file. 
 

3. Once the user has reached the correct 
directory the available seed files will display in 
the files section of the dialog box. Select the 
correct seed file and click OK. 

 

Figure 4-3:  Select Seed File 

 
STANDARDS FOR USE WITH X30 CRITERIA 4-3 

3/27/2007 



EFLHD CADD Standards Manual 
Chapter 4 — Seed Files  

 

 

 

 

4. Give the new design file a name, make sure 
the path to where the file should be created is 
correct, and then click OK. 

 

Figure 4-4:  Create a new design file 

5. Under the seed file section, the correct EFLHD 
seed file is now displayed. In the directories 
box the example shows the path to where the 
user would like the file to be created, and in 
the files box, in the example above a new file a 
name has been typed in.  

6.  Prior to opening the new design file, select 
the project configuration file from the 
Microstation Manager as shown below. 
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             Figure 4-5:  Project Configuration Setting 

                        Project Configuration file (*.pcf) 

 
Using the Project Configuration file will give the 
user access to the X30 Generation of Standard Files 
(Level library, line styles, cell library, color table, 
text styles, ddb files, etc.) 

 

 

 

              

Coordinate Readout and Working Units 

The Microstation coordinate readout settings and working unit’s 
settings control how measurements are displayed.  However, 
the working unit’s settings no longer control the precision of 
measurements and elements within the design file, as 
Microstation V8 design files now have 64-bit floating-point 
accuracy.  Care should still be taken when selecting the correct 
EFLHD seed file located at: 

M:\Cadd_resource_v8\X_30\Standards\Seed 

If all new design files are created using the EFLHD seed files as 
outlined in Workflow 1, the coordinate readout and working 
unit’s settings will always be correct, giving the user the correct 
output.  This section shows how to check these settings. 

STANDARDS FOR USE WITH X30 CRITERIA 4-5 
3/27/2007 



EFLHD CADD Standards Manual 
Chapter 4 — Seed Files  

 

 The workflow below explains how to determine what the 
MicroStation working units settings are for the active design file.  
The dialog box that displays the working unit’s settings also 
allows the user to change those settings.  Changing these 
settings will no longer affect the size of elements within the 
design file.  However, if the user selects the correct seed file, 
these settings should not need to be changed.  This workflow 
also shows how to change the MicroStation coordinate readout 
for the active design file.  Changing the coordinate readout 
settings will simply change the number of decimal points shown 
when measuring an element. 
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Workflow 2: Accessing the working 
units and Coordinate Readout dialog 

1. From MicroStation select Settings>Design File. 

 

Figure 4-6: Design File Settings 

2. From the design file dialog box select 
Coordinate Readout or Working Units.  

Coordinate Readout 
The coordinate readout section of the Design File Settings 
contains several settings including, format and accuracy for 
both coordinate readout and angles, and mode for coordinate 
readout. Format, for coordinates, lets the user select to display 
coordinate readout in terms of master units, sub units or 
working units. The generally accepted format and the selection 
for FHWA are master units. For angles, format allows the user 
to display angles in decimal degrees or degrees-minutes-
seconds. Accuracy, as used on the coordinate readout dialog, 
does not refer to the accuracy of the design file, but rather the 
number of decimal places to be displayed. The mode selection 
allows the user to select how angles are displayed: 
conventional, azimuth, or bearing. 

The figures below show the different working units and 
coordinate readout settings contained within the EFLHD seed 
files. To access these dialog boxes use the preceding workflow. 
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Figure 4-7: Coordinate Readout for English Roadway Seed 
Files 

 

 

Figure 4-8: Coordinate Readout for Metric Roadway Seed Files 
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Working Units 

 

Figure 4-9: Working Units for English International Foot 
Roadway Seed File 

 

Figure 4-10: Working Units for English US Survey Foot 
Roadway Seed File 
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Figure 4-11: Working Units for Metric 2D seed file 
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Introduction 

Annotation, as it pertains to this chapter, includes both text and 
dimensions.  This chapter will outline the text styles and dimension styles 
in use at EFLHD, as well as some of the key settings associated with these 
styles. 

Text 
MicroStation 2004 gives the user the ability to save the various text 
settings as a text style.  With MicroStation 2004 text styles the user no 
longer needs to set text parameters such as text font, height, width, etc. 
each time text is needed.  Each of these settings are saved within a text 
style. 

 

Figure 5-1:  Place Text 

In the example above, the user has selected the place text tool.  The tool 
settings window, shown above, allows the user to select the correct text 
style, the Text Editor – Word Processor also becomes active allowing the 
user to begin annotating the design file. 
 
Also new with Microstation 2004 Edition is annotation scale.  Annotation 
scale allows the user to set an annotation scale for the current model 
allowing text to be scaled to fit the desired output.  With this tool, the 
drawing elements are at a 1:1 scale, but the text will be placed to fit the 
final scale of the drawing.  This also allows EFLHD to have 1 text style for 
each type of text; title, standard, italic, non-italic, etc., rather than 1 for 
each type and each scale within each type.  For consultants, Annotation  
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scale definition files are available through the CADD_Resources_V8.zip 
download.  Annotation scale definition files for U.S. Customary and Metric 
units can be found on the EFLHD designers local computer at:  
M:\Cadd_resource_v8\X_30\Standards (English or Metric)\  
 

At EFLHD there is 1 text style for each italics and non-italics for both 
standard text and title/heading text, for both English and Metric EFLHD 
projects.  This is a total of 4 text styles for English and 4 for Metric. 

The main attributes of each are the text height, width, and line spacing, 
at a scale of 1”=100’ for U.S. Customary and 1:1000 for Metric, and the 
font.  Federal Lands Highway will use the Verdana true type font 
for all projects. 

 

Figure 5-2:  EFLHD Text Styles 

 

As mentioned above, available in Microstation 2004 Edition is the use of 
true type fonts and AutoCAD .shx fonts.  Microstation will automatically 
find true type fonts installed on each computer in the operating system 
\fonts directory, and will find AutoCAD .shx file in the AutoCAD system 
\fonts directory.  The original Microstation fonts are still available for use. 
 
 
 
 

STANDARDS FOR USE WITH X30 CRITERIA 5-2 
3/27/2007 



 

 

EFLHD CADD Standards Manual 
Chapter 5 — Annotation 

 
 
 

 

EFLHD text styles are contained in 2 Libraries called 
eflhd_eng_text_styles.dgnlib and eflhd_met_text_styles.dgnlib.   

For consultants, EFLHD text style libraries are available through the 
CADD_Resources_V8.zip download.  The EFLHD DGN library can be 
found on the EFLHD designers local computer at:  

M:\Cadd_resource_v8\X_30\Standards\Library_Files\ 

 
DGN Libraries are the containers for 3 important features in 
MicroStation V8.  These include:  Levels, Text Styles and 
Dimension Styles.  With the DGN library attached each of these 
will be available to the user.  For EFLHD employees, DGN 
Libraries are automatically attached while opening a design file 
using the Project Configuration (*.pcf).  For EFLHD consultants, 
using the Project Configuration (*.pcf) files provided with the 
CADD_Resources_V8.zip download will automatically attach 
the dgn libraries. 

 

 

Workflow 1:  Manually attaching the EFLHD 
DGN Library 

1. Select Workspace>Configuration from the main 
Microstation pull down menus 

 

Figure 5-3:  Workspace Menu 
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2. In the Workspace configuration list, select 
MS_DGNLIBLIST 

 
Figure 5-4:  DGNLIBLIST Configuration Variable 

 

3. Choose the select button, and path to the location of 
the DGN Library. 
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4. Select the library and click the Add button to add the 
file to the File List section in the bottom of the dialog 
box. 

 
                      Figure 5-5:  Select DGN Library 

 

5. Select Done. 
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6. When prompted to save changes to workspace, select 
Yes. 

 

Figure 5-6:  Microstation Alert Dialog 

7. In order for these changes to take affect you must exit 
Microstation and restart. 

 

Workflow 1 - Manually attaching the EFLHD dgn 
library is for information only.  EFLHD designers 
should not manually attach or edit configuration 
variables.  For EFLHD, the CADD Coordinator 
sets the configuration variables. 
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Workflow 2:  Annotation Scale, Setting the 
Model Properties (See the section on the use of models on 
page 1-4.) 

1. From the MicroStation Primary toolbar, select the 
Models icon. 
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Figure 5-7:  Primary Tools 

2.  From the Models dialog box, select Model Properties. 

 

Figure 5-8:  Models Dialog 

3.  Select the Edit Model Properties Icon. 

 

Figure 5-9:  Model Properties 
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4. You can rename the model, give a new description and 
select the annotation scale from the dialog above.  In 
the example above, the annotation scale has been set 
to 1”=100’.  Once the model properties have been set, 
select OK. 

Workflow 3:  Annotation Scale, Setting 
Annotation Lock and Placing Text 

1. Annotation Lock can be selected from the main 
Microstation pull down menus by selecting 
Settings>Locks>Annotation Scale, as shown on the left 
below, or by using the locks menu on the Microstation 
status bar, as shown on the right below. 

  

Figure 5-10:  Annotation Scale 

2. With Annotation Scale lock on, text will now be placed 
at the proper size for the output scale. 
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3. Select the Place Text tool. 

 

Figure 5-11:  Text Menu 

 

 

4. From the tool settings window, select the desired text 
style. 

 

 

Figure 5-12:  Select Text Style 

5. By selecting the English Italics Standard Text, the 
proper text size, font, line spacing, etc. will be set 
automatically. 

 

 

Figure 5-13:  Place Text Dialog 
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6. Begin placing text. 

 

 

Text Sizes 

The following tables outline the text sizes to be used on EFLHD plans.  
These text sizes have been incorporated into the use of annotation scale. 

Metric Text sizes 

11x17 Sheet size Scale n:1 

Description 50 100 200 250 300 400 500 1000 2000 

Standard Text 0.1 0.2 0.4 0.5 0.6 0.8 1 2 4 

Text Spacing 0.05 0.1 0.2 0.25 0.3 0.4 0.5 1 2 

Title/Heading Text .015 0.3 0.6 0.75 0.9 1.2 1.5 3 6 

Title Sub-Heading Text .125 .25 .5 .625 .75 1 1.25 2.5 5 

           
Sheet Layout 
Information          

           

Meters per plan sheet 17.5 35 70 75 100 140 175 350 700 

Major tick spacing 2.5 5 10 25 25 25 25 50 100 

Minor tick spacing 0.5 1 2 5 5 5 5 10 20 

Table 5-1: Metric Text Sizes 
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English Text sizes 

11x17 Sheet size Scale ft/in 

Description 10 20 40 50 100 200 500 

Standard Text 0.8 1.6 3.2 4 8 16 40 

Text Spacing 0.4 0.8 1.6 2 4 8 20 

Title/Heading Text 1.2 2.4 4.8 6 12 24 60 

Title Sub-Heading Text 1 2 4 5 10 20 50 

               

Sheet Layout Information              

               
Feet per plan sheet 140 280 550 700 1400 2800 7000 

Major tick spacing 50 100 100 100 500 1000 1000 

Minor tick spacing 10 25 50 50 100 100 500 

 

 

 

 

 

 

 

 

Table 5-2: English Text Sizes 

 

 

 

Standard text height for Metric drawings is calculated 
as: Scale x 0.002.  The standard text height for English 
drawings is calculated as:  Scale x 0.08.  Text width will 
always = text height.  Text spacing = text height x .5 
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Dimensions 
Also new in MicroStation V8, 2004 Edition, is the introduction of 
Dimension Styles.  This is a huge benefit for users of the dimensioning 
tools in MicroStation.   

 

Figure 5-14:  Dimension Settings dialog box 

In Microstation V8, 2004 Edition the user may setup the parameters for 
dimensioning and save these parameters as a dimension style, much like 
text styles, for use at a later time, as shown below.  As discussed above, 
these styles will be contained in a DGN Library that will be attached 
automatically for EFLHD employees, and will be attached through a 
project configuration variable for consultants working on EFLHD projects.   

As with text, dimension styles also use the Annotation scale to control the 
size of dimension text.  Currently there are 2 dimension styles currently 
used for Metric and U.S. Customary units.  These dimension styles use 
the correct levels and text styles for EFLHD work.  As with text, simply 
select the dimension tool, then from the Element Dimensioning dialog 
box, select the correct dimension style, as shown below. 
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Figure 5-15:  Dimensioning dialog boxes 

 

As EFLHD has not used dimensioning in the 
past, the creation of these styles will be an on-
going process.  Check the standard 
downloads at EFLHD website often to see 
updates as they are posted 
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Chapter 6 Line Styles 

Overview 

Microstation comes with 8 standard Line Styles, which is 
usually enough for only the most basic Microstation drawing. 
Custom Line Styles are Microstation’s way of creating other 
Line Style for specific purposes. Line Styles for utilities that 
have text imbedded in the line, fence Line Style with X’s 
along it are examples of Line Styles that can be created. 
Custom Line Styles, unlike the fonts discussed in chapter 5, 
are still contained in resource files with the extension .rsc. 
The only change will be how we access custom line styles for 
use and viewing prior to placing.  This chapter contains 
information about these resource files including: 

• Names 
• Locations 
• Descriptions 
• Workflow for attaching resource file 
• Workflow for creating basic custom Line Styles 

Line Styles 

There are many custom Line Styles in use at EFLHD. There 
are multiple standard Line Style resource files. They are 
automatically read by Microstation and will be shown as 
available Line Styles, provided your machine is properly 
configured. These files will be attached when entering 
Microstation through a project configuration variable and the 
use of these will be seamless.   

The EFLHD custom Line Style resource files can be found on 
the EFLHD designer’s local computer at:  

M:\Cadd_resource_v8\X_30\Standards\Resources 

For consultants, EFLHD line style resources files are available 
through the CADD_Resources_V8.zip download.   

Selecting custom Line Styles in Microstation V8 is a simple 
process as each Line Style found in the attached .rsc file will 
automatically show up in the Line Styles dropdown menu, as 
shown below. 
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Figure 6-1:  Select Custom Line Style 

Each of the Line Styles available may be selected by using the 
scroll bar to find and select the desired Line Style. 

As shown above, there is also a selection for ByLevel.  This 
allows a Line Style to be attached to a particular level.  
Setting the level as the active level will automatically select 
the Line Style as set in the level library.  See chapter 9, 
Levels and Symbology, for more information on ByLevel 
attributes. 

To view a custom Line Style before placing, select 
Element>Line Styles>Custom, as shown below. 

 

Figure 6-2:  Element Menu 
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With the dialog box for custom Line Styles, shown below, you 
have the ability to select Line Styles and set Line Style scales. 

 

Figure 6-3:  Custom Line Styles 

 
For EFLHD employees, custom Line Styles are 
automatically attached while opening a design file 
using the Project Configuration (*.pcf).  If the correct 
Line Styles is not displaying, contact CADD support 
to have this setup. 
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Line Style Diagrams 

See figures below for view of each Line Style in use at EFLHD. 

Line Style 

 Tree_Line_2 

 Tree_Line 

 Township/Range 

 Silt_Fence (FLH) 

 
Silt_Fence(EFLHD) 

 Section 

 Scarp 

 
Rock_Lined_Ditch 

 
Railroad_Tracks_2 

 Railroad_Tracks 

 Property_Line 

 Permanent_Easement_Right 

 Permanent_Easement_Left 

 Permanent_Easement_Inline 

 P_Water_Line 

 P_Wall 

 P_Underground_Telephone 

 P_Underground_Power_and_Telephone 

 P_Underground_Power 

 P_Underground_Oil 

 P_Underground_Gas 

 P_Underdrain 

 P_Two_Posted_Sign 

 P_Storm_Drain 

 P_Sanitary_Sewer 

 P_Road 

 P_Right_of_Way_Right 

 

Figure 6-4: Line Style Diagram 
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Line Style 

 P_Right-of-Way_Left 

 P_Right_of_Way_Inline 

 P_PavedDitch 

 P_Overhead_Telephone 

 P_Overhead_Power_and_Telephone 

 P_Overhead_Power 

 P_Guardwall 

 P_Guardrail 

 
P_Gate 

 P_Fence 

 
P_Culvert (FLH) 

 D_Pipe12, … (EFLHD-Culvert of different 
sizes) 

 
P_Concrete_Barrier 

 Metric_Custom_Slope 

 Metric 4:1 

 Metric 2:1 

 Metric 1:9 

  Metric 1:8 

 Metric 1:7 

 Metric 1:6 

 Metric 1:50 

 Metric 1:5 

 Metric 1:4 

 Metric 1:3 

 Metric 1:20 

 
Metric 1:2.5 

 

Figure 6-5: Line Style Diagram 
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Line Style 

 Metric 1:2 

 Metric 1:100 

 
Metric 1:10 

 
Metric 1:1.75 

 Metric 1:1.5 

 Metric 1:1.25 

 
Metric 1:1 

 Metric 1:0.75 

 
Metric 10:1 

 Metric 100:1 

 
Mailboxes 

 Forced_Slope_Tie 

 
Edge_of_Water 

 E_Water_Line 

 E_Wall 

 E_Underground_Telephone 

 E_Underground_Steam 

 E_Underground_Power 

 E_Underground_Oil 

 E_Underground_Irrigation 

 E_Underground_Gas 

 E_Underground_Force_Main 

 E_Underground_Fiber_Optic 

 E_Underground_CATV 

 

Figure 6-6: Line Style Diagram 
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Line Style 

 E_Underdrain 

 E_Two_Posted_Sign 

 E_Storm_Drain 

 E_Sanitary_Sewer 

 E_Road 

 E_Right-of-Way_Right 

 E_Right-of-Way_Left 

 E_Right-of-Way_Inline 

 
E_Permanent_Easement_Right 

 
E_Permanent_Easement_Left 

 E_Permanent_Easement_Inline 

 E_Overhead_Telephone 

 E_Overhead_Power_and_Teleph
one 

 E_Overhead_Power 

 E_Overhead_Fiber_Optic 

 E_Overhead_CATV 

 E_Maintenance_Limits 

 E_Irrigation_Ditch 

 E_Intermittent_Drainage 

 E_Guardwall 

 E_Guardrail 

 E_Ground 

 

E_Gate 

 E_Fence 

 E_Dam 

 E_Culvert 

 
E_Concrete Barrier 

 

Figure 6-7: Line Style Diagram 
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Line Style 

 Dike 

 
Depression 

 
Cut_Line 

 Construction_Easement_Right 

 Construction_Easement_Left 

 Construction_Easement 

 EFL_Temporary_Easement 

 EFL_Existing_Easement 

 Brush_Line 

 Boundary_NWR 

 Boundary_National_Park 

 Boundary_Forest 

 Boundary_BLM 

 Boundary_BIA 

 Berm 

 Bench_Cut 

 ¼ Section Line 

 1/16 Section Line 

 Wattle 

 
 

P_Road 

 E_Road 

 Ditch 

 
CL1 

 Break2 

 Break1 

 
Diversion Berm(EFLHD) 

 

Figure 6-8: Line Style Diagram  
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Workflow 1:  Resource file setup 
1. Download CADD_Resources_V8.zip from the 

EFLHD web site.  

2. As this file is specific to EFLHD projects the 
user should leave this in the 
M:\Cadd_resource_v8\X_30\Standards\Res
ources directory. 

3. In Microstation select 
Workspace>Configuration. 

 

 

 

 

Figure 6-9: Workspace Configuration Menu 
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4. From the workspace configuration dialog 
box, select Symbology from the list on the 
left. 

 

 

 

Figure 6-10: Configuration Symbology 

 

 

5. Click on the Select button. This will allow the 
user to select the EFLHD line style resource 
files downloaded above (step 4). 
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Figure 6-11: Symbology Resources 

 

 

6. Pick the path to the directory where the .rsc 
files are stored from the upper right directory 
box. Highlight the appropriate file(s) from 
the upper left box, and then click the Add 
button to add the desired file to the file list.  
Repeat this procedure for each file to be 
added. 

7. Click the Done button. 

8. The files will now be shown in the Expansion 
window of the user configuration box. 
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Figure 6-12: User Configuration Symbology 

 

9. Click the OK button. The user will see a 
Microstation alert dialog box asking if 
changes to the configuration file should be 
saved, Answer by selecting the Yes button. 
The correct custom line styles will now be 
available.  
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Workflow 1 will allow user level configuration, which is not the 
recommended method for the X30 standard files. 

 
Workflow 1 – Resource file setup is for 
information only.  EFLHD designers should 
not manually attach or edit configuration 
variables.  For EFLHD, the CADD 
Coordinator sets the configuration variables.
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Chapter 7 Color Table 
 
 
 

Color Table 

The current color table in use at EFLHD for the X30 Generation of 
standard files is: color1.tbl. This file can be found on the EFLHD 
designers local computer at: 

M:\Cadd_resource_v8\X_30\Standards\Tables 

Workflow 1:  Attaching EFLHD Color Table 
1. From MicroStation select Settings>Color Table… 

 

Figure 7-1:  Settings Menu 
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Figure 7-2:  Default Color Table 

 

2. This will open the current color table, usually the 
MicroStation default color table, shown in Figure 7-2. 
From the color table palette, select File>Open…, and 
then select the EFLHD color table to be attached. 

 

Figure 7-3:  Open Color Table 

3. Click OK and the EFLHD color table will now be shown. 
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Figure 7-4:  EFLHD Color Table 

 

4. From the workspace configuration dialog box, select 
colors. 

 

 

5. When the correct color table,color1.tbl, is displayed, 
click on the attach button. The correct color table will 
now be attached to this drawing. 

 

 

 

For EFLHD employees, color tables are automatically 
attached while opening a design file using the Project 
Configuration (*.pcf).  If the correct color table is not 
displaying, contact CADD support to have this setup. 
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Workflow 2:  Attaching the Color Table 
Permanently 

1. To attach the correct color table more permanently, 
select Workspace>Configuration… from the main 
Microstation pulldown. 

 

Figure 7-5:  Workspace Menu 

2. From the workspace configuration dialog box, select  

colors. 

 

 

Figure 7-6:  User Configuration 
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3. Highlight Default Color Table from the upper right 
window on the palette. Click on the select button and 
select the correct color table, color1.tbl. Once selected, 
click the OK button. This will prompt an alert from 
Microstation, asking if you really want to save changes 
to your .ucf file (user configuration file). 

 

Figure 7-7:  Alert Dialog Box 

 

 

 

4. Choose Yes and the color table will be attached each 
time Microstation is launched.  For all configuration 
changes, exit Microstation and re-enter for the changes 
to take affect. 

 

 

 
Workflow 2 - Attaching the Color Table 
Permanently is for information only.  EFLHD 
designers should not manually attach or edit 
configuration variables.  For EFLHD, the 
CADD Coordinator sets the configuration 
variables. 

STANDARDS FOR USE WITH X30 CRITERIA 7-5 
3/27/2007 



 

STANDARDS FOR USE WITH X30 CRITERIA 

EFLHD CADD Standards Manual 
Chapter 8 — Cell Libraries 

8-i 
3/27/2007 

Table of Contents 
CHAPTER 8 ~ Cell Libraries 

About EFLHD Cell Libraries   ...………………………………..………..…8-1 

New to Microstation V8, 2004 Edition  ………………………………….8-1 

EFLHD Cell Libraries……………………………………………………………8-2 

Table 8-1: Cell Libraries    ………………………………………...…..….……….8-2 

WORKFLOW 1: Attaching EFLHD Cell Libraries  ……...……….…….8-3 

Figure 8-1: Element Menu  …….………………………………...…..….……….8-3 

 Figure 8-2: Cell Library Dialog Box ….……….…………………..……….….8-4 

 Figure 8-3: Populated Cell Library Dialog Box ……………………...…..8-4 

WORKFLOW 2: Attaching EFLHD Cell Libraries ……...…….….…….8-5 

Figure 8-4: Cell Library Dialog Box.…………………………………….…......8-5 

Figure 8-5: Create Cell Library Dialog Box  ……………………….…......8-5 

Microstation Cell Configuration Variables  …………………………….8-6 

WORKFLOW 3: Modifying Cell Library Configuration Variables ..8-6 

Figure 8-6: Workspace Menu  …………………………………...…..….……….8-6 

 Figure 8-7: Configuration Dialog Box ……..….…………………..………….8-7 

 Figure 8-8: Cell Library Path Dialog Box  .…………………………......….8-7 

Figure 8-9: File Selection List for Cell Libraries………………............8-8 

Figure 8-10: Microstation Manager Dialog Box    …………........….8-10 

Figure 8-11: Models Dialog Box…………………………………….........….8-10 

WORKFLOW 4: Creating a New Model ..……………..…………….….8-11 

Figure 8-12: Models Menu  …………….…...………………………............8-11 

Figure 8-13: Models Dialog Box  …………..………………………........….8-11 

Figure 8-14: Create Models… ……………………………………….........….8-12 



 

STANDARDS FOR USE WITH X30 CRITERIA 

EFLHD CADD Standards Manual 
Chapter 8 — Cell Libraries 

8-1 
3/27/2007 

Chapter 8 Cell Libraries 

About EFLHD Cell Libraries 

The cell libraries currently in use at EFLHD contain signs, figures, 
symbols, borders, title maps, etc.  The cell libraries have been 
organized based on cells types within the libraries.  This, in most 
cases, will prevent the user from having to search through many 
cells to find the desired one. 

New to Microstation V8, 2004 Edition 
New in Microstation V8 2004 is the file format of cell libraries.  
Cell libraries now have the same format as .dgn files, making it 
much easier to edit and create new cells.  Also new, is that the 
restrictions on placing 3D cells in 2D drawings has been removed.  
3D and 2D cells may now be placed in any drawing, and you can 
have both 3D and 2D cells in the same cell library. 
 
This chapter contains information about the EFLHD cell libraries 
including: 

• Names of cell libraries 
• Description of each cell library 
• Locations of cell libraries, both internally and for 

consultants 

There are also helpful workflows for using these cell libraries 
placed throughout this chapter, including attaching cell libraries, 
using cell selector, and defining variables within Microstation to 
make finding cells and cell libraries easier. 
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EFLHD Cell Libraries 

At EFLHD there are currently 3 cell libraries for general use.  The 
EFLHD cells have been divided into cell libraries based on the type 
of sheet the cells will most likely be used on.  See the table below 
for a list of cell libraries and a short description of each.   

Cell Libraries 
File Name Description 

eflhd_engborder.cel English Borders used by  EFLHD 
eflhd_EngCell.cel EFLHD cel 
eflhd_MAPS.CEL All states USA maps 
eflhd_SIGN.CEL All Signs (MUTCD, NPS etc) 
FLH_Criteria.cel FLH criteria cel 
Work_dd.cel WFLHD cel 

Table 8-1: Cell Libraries 

 

 

 

 

The cell libraries for the x30 generation of standard 
files are in the process of being updated. Please 
check back often as they will be added to the website 
as completed.   

 
These cell libraries are to be used on all EFLHD projects and are 
located on the EFLHD network at:   
 
M:\Cadd_resource_v8\X_30\Standards\Cell_Lib 
 
For consultants, EFLHD cell libraries are available through the 
CADD_Resources_V8.zip download.   
 

These cell libraries are not to be edited by anyone other than 
EFLHD CADD support.  If you have suggestions for new cells, 
edits to existing cells, or general suggestions regarding the EFLHD 
cell libraries please address these to EFLHD CADD support as 
detailed in Chapter 1. 
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Workflow 1:  Attaching EFLHD Cell 
Libraries 
 
 

1. For EFLHD consultants, begin by downloading 
CADD_Resources_V8.zip from the EFLHD web 
site.  As the cell libraries are specific to EFLHD 
projects, the user should leave the libraries in 
the 
M:|Cadd_resource_V8\X_30|Standards\Cell_Lib 
directory. 

2. From the Microstation drop down menu’s, select 
Element>Cells. 

 

 

 

Figure 8-1:  Element Menu 

 

 

3. The cell library palette will now be accessible.  
Select File>Attach, and navigate to the correct 
cell library. 
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Figure 8-2:  Cell Library Dialog Box 

4. Once selected, the cells will be visible in the 
windows on the Cell Library palette. 

 

 

Figure 8-3: Populated Cell Library Dialog Box 

 

Project Specific and Personal Cells 

There is often a need for an individual user to create cells during 
the course of a project for things such as: 

• Creating standards notes to be used on multiple 
sheets. 

• Copying information from sheet to sheet. 
• Copying information for another user within the 

project. 
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While these are valid reasons for creating cells, they must not be 
placed within the EFLHD standard cell libraries listed above.  In 
these cases, simply create a new cell library and create the new 
cell there.  Once the information has been used the temporary 
cell library may be deleted, or the temporary cells within the cell 
library may be deleted.  See workflow 2 below, for information on 
creating new cell libraries. 

Workflow 2: Creating a New Cell Library 
1. Access the cell library palette as shown in 

Workflow 1.  From the cell library palette, select 
File>New 

 

Figure 8-4:  Cell Library Dialog Box 

2. Pick a path to the directory where the cell library 
is to be created. 

3. Type in a name for the new cell library. 

 

Figure 8-5:  Create Cell Library Dialog Box 
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4. Once the new name has been given, the OK 
button will activate.  Select OK and the new cell 
library will be attached. 

 

Microstation Cell Configuration Variables 

There are several configuration variables that will make the 
selection of cell libraries easier.  The list below shows these 
variables and a brief description. 

• Cell library directories Where Microstation will look 
first for cell libraries. 

• Cell library list The list of cell libraries to be 
shown in the File pull down. 
(Shown below) 

• Output cell libraries  Default directory where new cell 
libraries are placed. 

 
 

 
For EFLHD employees, cell libraries are 
automatically attached while opening a design file 
using the Project Configuration (*.pcf).  If the 
correct cell libraries are not displaying, contact 
CADD support to have this setup. 

 
 
 

 

 

 

Workflow 3: Modifying Cell Library 
Configuration Variables 

1. From the Microstation pull down menu’s, select 
Workspace>Configuration. 

 

Figure 8-6:  Workspace Menu 
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2. From the workspace configuration palette, select 
cells from the category list on the left side of the 
dialog box. 

 

Figure 8-7:  Configuration Dialog Box 

3. Highlight the Cell Library Directories and press 
the Select button.  The default Microstation 
directories may be listed in the directory list, as 
shown below.  Highlight these directories and 
click on the Remove button. 

4. Path to the directory where the EFLHD cell 
libraries are stored. Once the directory is 
displayed, press the Add button. After the 
correct directory populates the directory list, 
select the Done button to return to the 
Configuration dialog.  

5. Repeat steps 3 and 4 to set the Output Cell 
Libraries variable. 
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Figure 8-8:  Cell Library Path Dialog Box 

6. Highlight the Cell Library List variable and press 
the Select button. 

7. Select the directory where the EFLHD cell 
libraries are stored.  When the directory has 
been selected, the available cell libraries will be 
displayed.     

 

Figure 8-9:  File Selection List for Cell Libraries 
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8. Double-clicking the desired cell library, or 
highlighting the desired cell library and selecting 
the Add button will place the cell library in the 
File List box at the bottom of this dialog.  Select 
the cell libraries that the user most commonly 
uses.  When finished select the Done button. 

9. At the Configuration dialog box, select OK, to 
accept the changes that were made. 

10. Microstation will ask if changes to the 
configuration file should be saved, answer by 
selecting the Yes button. 

11. After changing configuration variables, you 
must exit Microstation and re-enter for these 
changes to take affect. 

 

Workflow 3 will allow user level configuration, which is not the 
recommended method for the X30 standard files. 

 

 Workflow 3 – Modifying Cell Library Configuration 
Variables is for information only.  EFLHD designers 
should not manually attach or edit configuration 
variables.  For EFLHD, the CADD Coordinator sets 
the configuration variables. 

 

 

 

 

 

As described at the beginning of this chapter, cell libraries now 
have the same file format as .dgn files, and may be opened and 
edited the same as a .dgn file.  As shown in the figure below, 
there is now a filter for opening .cel files through the Microstation 
Manager dialog box, as well as the standard file>open dialog. 
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Figure 8-10:  MicroStation Manager Dialog Box 

Once the cell library is opened, each cell will be contained in its 
own model.  From the models dialog box shown below, arrows, 
concrt, earth, etc. are cells within the cell library.  As such they 
may be edited in this file, and new cells may be created here as 
well. 

 

Figure 8-11:  Models Dialog Box 

When creating cells in the cell library create a new model and 
begin drawing.  When finished, the resulting drawing created in 
the new model will be a cell. 
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Workflow 4: Creating a New Model 
1. From the Microstation pull down menu’s select 

File>Models 

 

Figure 8-12:  Models Menu 

2. From the models dialog box select the Create a 
new model icon. 

 

Figure 8-13:  Models Dialog Box 

3. Once selected, the following dialog box will 
activate. 
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Figure 8-14:  Create Models  

4. Fill in the dialog box as above with the exception 
of Name.  The name field is the desired name of 
the new cell.  Select OK. 

5. You will now be in the new cell, named North 
arrow in the example above. 

6. Begin drawing your new north arrow as desired. 

The newly created north arrow is now a cell within the cell library.  
It will be available when accessing the cell library from any 
drawing. 

 Due to the new format of cell libraries, creating new cells in 
Microstation V8 is as easy as creating a new model in the cell 
library and drawing the new elements.  However, it is 
important to remember that creating a cell in this manor will 
not automatically place the origin.  In creating cells this way 
the origin will always be at the coordinates of 0,0.  Create the 
drawing at these coordinates or when finished select the entire 
cell and move to the correct origin by selecting the move 
command, issuing a data point at the desired origin then, in 
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Chapter 9 Levels and Symbology 

Overview 

Symbology includes which level, color, line style, and weight 
are associated with each element to be drawn.  Following the 
symbology outlined in this chapter is essential for several 
reasons, but perhaps the most important reason is the 
standardization of the final output.  Following the standard 
symbology will ensure that each element, line work, text, 
etc., will plot the same from drawing to drawing. 

This chapter will detail the levels in use at EFLHD, the 
associated level symbology, the use of the EFLHD DGN 
library, and EFLHD level filters, including workflows for many 
of the new Microstation 2004 Edition tools. 

Levels 

Within Microstation 2004 Edition, a design file may contain an 
unlimited number of levels in which data may be displayed.  
There are two primary ways in which to assign symbology to 
each element: first, the color, weight, and line style of the 
graphic elements are set independently. Second, a new 
addition introduced in Microstation V8, is ByLevel 
symbology.  With ByLevel symbology each level may have a 
pre-assigned color, line style, and weight.  By selecting the 
desired level, these attributes are automatically set. 

As discussed above, the level symbology for any level may be 
set individually.  This includes the ability to set some 
attributes of elements to ByLevel and other attributes 
independently.  More levels are used by EFLHD in 
Microstation 2004 than the 63 available in previous versions. 

 

While some manual drafting is necessary and 
expected, most elements should be placed with the 
GEOPAK D&C manager, the .ddb file.  This is the best 
way to insure that elements are placed with the proper 
symbology, for final output and for use at later stages 
for GEOPAK criteria files and for computing quantities. 

 

 

 

 

DGN Libraries 

In Microstation 2004, levels and the associated ByLevel 
symbology are stored in a DGN library, and may be attached 
to any Microstation file.  In order to maintain the X30 criteria 
and future versions of Geopak criteria files, 
FLH_Combined.dgnllib is controlled FLH wide.  EFLHD 
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designers and consultants will not be able to add new levels 
to the FLH_Combined.dgnllib file. 

DGN libraries may also contain information for text styles and 
dimension styles.  See the appropriate chapter for these 
tools.  The workflow below outlines how to attach levels 
contained in the DGN library to the current file. 

 

 

 

For EFLHD employees, the standard DGN 
Library will be automatically attached while 
opening a design file using the Project 
Configuration (*.pcf).  Workflow 1, shown below, 
can be used to manually attach the DGN 
Libraries to a design file.

 

Workflow 1: Attaching a level library 

1. Open the Level Manager by selecting the icon in 
the Primary Tools tool bar, or by selecting 
Settings>Level>Manager. 

 

 
Figure 9-1:  Accessing Level Manager 

 
Figure 9-2:  Accessing Level Manager 

2. Notice the dialog that is activated has only one 
level shown, Default.  These are also no level 
filters available. 
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Figure 9-3:  Level Manager 

3. Select Levels>Library>Attach. 

 
Figure 9-4:  Attaching DGN Library 

4. Browse to the file FLH_Combined.dgnlib, select 
OK. 
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Figure 9-5:  Level Manager with DGN Library Attached 

 

 

Level Filters 

Also new in Microstation 2004 are level filters.  With an 
unlimited number of levels it could easily become very 
cumbersome to navigate to the desired level.  Level filters are 
designed to group levels together creating a more 
manageable set of levels.  For example the FLH levels have 
been broken down to Design, Cross_Sections, and Survey.   

Selecting the appropriate filter will display only the desired 
levels.  This does not turn the display of levels on or off, but 
simply allow the user to work with a smaller sub-set of levels. 
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Chapter 10 Batch Printing 
About Batch Printing 
Batch printing is a MicroStation utility used to print and re-print sets of drawings.  Job 
sets are created containing the desired drawing files and a set of print specifications 
are created for each job set.  The print specifications are defined containing 
information such as printer, print area, layout, and display.  This chapter will detail 
each of the necessary settings associated with Batch Printing. 

Workflow 1:  Accessing Batch Printing 
1. From the main MicroStation pull-down menus, select File>Batch Print. 

 

Figure 10-1:  File>Batch Print 

2. Once selected the Batch Print dialog box is activated.  The top bar on this dialog 
will show the current Job Set.  Shown below as [Untitled].  Once a new Job Set 
is created or an existing Job Set is opened the name will replace [untitled]. 
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Figure 10-2:  Batch Print 

3. To open an existing job set select File>Open and select the desired job. 

Job Sets 
Job Sets are lists of files to be printed, along with the associated print specifications 
used to print the files such as which printer, what area to print, what scale, which pen 
table, etc.  Each job set created will have the extension, .job. 

Workflow 2:  Creating a New Job Set 
1. The user must first select the design files to be added to the Job Set.  Select 

Edit>Add Files… 

 

Figure 10-3:  Add Files pull down menu 

The user may also alternatively select the Add Design Files icon, as shown 
below. 

10-3 
3/27/2007 STANDARDS FOR USE WITH X30 CRITERIA 



 

 

EFLHD CADD Standards Manual 
Chapter 10 — Batch Printing 

 

Figure 10-4:  Add Files icon 

2. Once selected the following dialog box will activate. 

 

Figure 10-5:  Select Files to Add 

3. Select the desired directory from the upper right Directories box.  Once you 
have navigated to the correct directory, select the desired files from the upper 
left Files box.  You may select multiple files by using the control or shift keys 
while selecting. 

4. After selecting the desired files, the Add button will be active.  Select the Add 
button and the selected files will be populated in the selected files box at the 
bottom of the above dialog box. 

5. Once complete, select the Done button. 
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Figure 10-6:  Files Added to Job Set 

6. Once the desired files have been selected you may now set the plot 
specifications.  These specifications tell MicroStation how to plot the selected 
files. 

7. Select Specifications>Manage, or select the Manage Specification icon, as 
shown below. 

 
8. Once selected the following dialog box will activate. 

 

Figure 10-7:  Rename Printer 

 
10-5 

3/27/2007 STANDARDS FOR USE WITH X30 CRITERIA 



 

 

EFLHD CADD Standards Manual 
Chapter 10 — Batch Printing 

9. Begin by renaming the default printer to be a more descriptive name.  Select 
Rename, the following dialog box will activate.  Give a descriptive name, shown 
as 8150DNCA below, and select OK. 

 
10. Once renamed highlight the printer on the left and the newly renamed 

8150DNCA on the right and select Properties. 

 

Figure 10-8:  Specification Manager 

11. Once selected the following dialog box will activate allowing the user to select 
the desired printer driver.  Select the driver and choose OK. 
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In most cases the EFLHD user will want to select 
one of the plot driver files found in the 
m:\cadd_resource_v8\Plotting\plotdrv\ directory in 
order to achieve special plotting effects such as 
shading contours or p&p sheet grids. 

 

 
12. The next step will be to set the desired print area.  Using the EFLHD standard 

sheet border cells will ensure that a plot shape will be available to define the 
area to be plotted for each sheet.  Included with each border is a plot shape on 
level D_Plot_shape that has been created as a construction element so it will not 
plot unless desired. 
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13. As with step 9 above, rename the Print Area specification to be more 
descriptive, shown below as EFLHD. 

 
14. Once renamed select Properties. 

 

Figure 10-9:  EFLHD Plot Properties 

15. The print area properties dialog, shown above, allows the user to select the 
attributes of the plot shape and to look for the plot shape in either the master 
file, reference files, or both.  If any of the design files to be plotted has more than 
one sheet then check the Process Multiple Boundary Elements box at the 
bottom of the properties dialog 

 

STANDARDS FOR USE WITH X30 CRITERIA 
10-7 

3/27/2007 

 
 

The level of the plot shape must be typed in.  The 
drop-down box will only include the levels in the 
master file, as the list could get quite long.
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16. Select the attributes of the plot shape and click OK.  When selecting the 
References check box the box below becomes active to allow the user to select 
certain reference files by logical or file name.  If this box is left empty all of the 
reference files will be searched. 

17. From the Batch Print Specification Manager dialog box select Layout. 
 

 
 

18. Select Default from the right hand box and then select Properties.  For layout, 
the name (default) may be renamed if desired however there may be little need 
to change these specifications so default may be fine. 
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If a EFLHD standard sheet border cell is used 
and the Print Boundary Method is set to Shape 
as outlined in steps 12 and 13 above, always 
setup the Properties as shown below. 

 

 
19. Select Maximize, Center, and the correct units and select OK. 
20. From the Batch Print Specification Manager dialog box select Display. 
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21. Select New to create a new set of specifications.  Input a new name and click 

OK. 

 
22. Select the new name from the right hand box and then select Properties. 

 
23. The display dialog is similar to the view attributes dialog box, but is specific to 

printing.  In MicroStation 2004 Edition you have the ability to plot with attributes 
different than the current view.  From this dialog box you also have the ability to 
specify a pen table. 
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EFLHD users will, in most cases, want to specify a pen 
table here in order to implement special plotting features 
such as shading certain plotted elements (e.g., P&P sheet 
grids, contours) or labeling the plot with the plot date and 
time.  The standard EFLHD pen tables can be found in the 
M:\Cadd_resource_v8\Plotting\pen_tables\directory. 

 
 
 
 
 
24. From the example above we have turned Constructions, Print Border, and Ref 

Boundaries Off.  This allows us to use these features during our work but not to 
plot them. 

25. Select the desired attributes and select OK. 
26. Close the Batch Print Specification Manager by selecting the X in the upper right 

corner. 
27. Once the files have been added and the specifications set, select File>Save.  

This will save all of the settings in a Job Set file with a .job extension.  Job Set 
files may be stored in any convenient directory.  There is no standard or default 
directory where batch print looks for these files. 

Workflow 3:  Printing 
1. If reprinting a previously saved Batch Print Job Set use File>Open in the main 

Batch Print dialog pull down menus to select the .job file for that Job Set.  This 
will populate the dialog with the files to be printed and the associated print 
specifications.  If continuing directly from Workflow 2 above (Creating a New 
Job Set) then skip this step. 

2. From the Batch Print dialog, shown below, select the printer icon. 

 
3. The Print Batch dialog will activate. 
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4. From this dialog box the user can select a print range, and log file. 
 
5. Select OK and the files will be sent to the printer.  A status bar will be displayed 

during the process, as shown below. 

 

 

 

EFLHD Internal Ploting 
At EFLHD there are several plot drivers and pen tables for both 11x17 and 8 ½ x 11 
and for both color and black and white.  Listed in the tables below are the plot drivers 
(.plt), the pen tables (.tbl) that are automatically attached, and the output produced 
for each combination. 

 

For Print Sheet: 

11"x17" / 8½” x11” Black-and-White Sheets (Metric and English) 
Plot driver files location:   
M:\Cadd_resource_v8\Plotting\Plot_Driver\plt_lpt1\e_lpt1.plt  
M:\Cadd_resource_v8\Plotting\Plot_Driver\plt_lpt2\e_lpt2.plt 
 Example: Use this driver for all plan sheet except p&p Sheets and Cross Section 
Sheets. 

11"x17" / 8½” x11” Shaded Black-and-White Sheets (Metric and English) 
Plot driver files location:   
M:\Cadd_resource_v8\Plotting\Plot_Driver\plt_lpt1\e_lpt1s.plt  
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M:\Cadd_resource_v8\Plotting\Plot_Driver\plt_lpt2\e_lpt2s.plt 
Example: Use this driver for p&p Sheets and Cross Section Sheets. 
 

For PDF File: 

11"x17" / 8½” x11” Black-and-White Sheets (Metric and English) 
Plot driver files location:   
M:\Cadd_resource_v8\Plotting\Plot_Driver\PDF\eflhd_bw-pdf.plt 
Example: Use this driver for all plan sheet except p&p Sheets and Cross Section 
Sheets. 

11"x17" / 8½” x11” Shaded Black-and-White Sheets (Metric and English) 
Plot driver files location:   
M:\Cadd_resource_v8\Plotting\Plot_Driver\PDF\eflhd_shade&color-pdf.plt 
Example: Use this driver for p&p Sheets, Cross Section Sheets, and all color sheet. 
 

Pen tables:  Appropriate pen table is automatically attached when the user selects 
the plotter driver file. 
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Chapter 11:  GEOPAK Introduction 

Purpose 

GEOPAK 2004 Edition (GEOPAK), the civil engineering design 
software in use at the Federal Highway Administration’s 
Eastern Federal Lands Highway Division (EFLHD), is complex 
software with many options to select from while working on 
projects for or at EFLHD.  This manual is not intended to 
teach the novice user how to use GEOPAK, but rather how 
EFLHD intends GEOPAK to be used on EFLHD projects.  As 
with any powerful software, and many complex processes, 
there are many different ways to accomplish a given task.  
This manual will outline the necessary procedures to ensure 
proper adherence to EFLHD standards for project design. 

EFLHD is implementing new criteria files and a new 
generation of Microstation/Geopak standard files.  This new 
generation is known as the X30 Generation of standard files, 
these files will need to be run using Microstation 2004 and 
Geopak 2004 Edition Typical Section Generator. 

 

Overview of GEOPAK 2004 

The GEOPAK 2004 Edition has been updated to take 
advantage of all of the new features of Microstation 2004 
including level names, level filters, models, and true type 
fonts, as well as providing a more consistent look.  In each of 
the following chapters we will outline the EFLHD standard as 
well as discuss the more pertinent new tools available. 
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Files Used 

There are many types of GEOPAK files in use at EFLHD.  In 
many cases you will use the default files delivered with 
GEOPAK, as these take their settings from the AASHTO green 
book.  This chapter will outline the files used by EFLHD and 
GEOPAK, paying particular attention to those that are specific 
to EFLHD, which must be substituted for the default GEOPAK 
files.   

.GPK
GEOPAK coordinate geometry 
file

Created the first time COGO is accessed.  The EFLHD project 
manager will assign a file name to use.

.SMD Survey manager database
Controls how survey information, feature codes, are interpreted 
by GEOPAK.

.SEP Superevelation preferences Controls how superelevation is calculated by GEOPAK

.PRJ Project manager Stores information for use by the GEOPAK project manager.

.DAT Data file used to create .TIN Contains string and point information used to create DTM's.

.TIN Triangulated irregular network Triangulation based on the points stored in the .dat file

.DDB D&C manager database

Hierarchical database containing information concerning 
functional clasification and display preferences for each feature 
and item used in a MicroStation design file.

.X08, .X10 Criteria file Previous version of EFLHD criteria files.

.X30 Criteria file New version of EFLHD criteria files.

Table 1.1: GEOPAK Files 

 

The following chapters discuss in detail where to find these 
files, how to attach them, and information that will be helpful 
on the use of EFLHD files. 

Of the files listed above, the .SMD, .SEP, .DDB, and all 
criteria files, are specific to EFLHD projects and must be used 
in place of the GEOPAK defaults. 

For the locations of the files listed above, see chapter 2, 
directory structures.  For EFLHD consultants, see the EFLHD 
web site to download these files.  EFLHD standard files 
required to run Geopak 2004 Edition Typical Section 
Generator is available through the download 
CADD_Resource_v8.zip.   Detailed use of each of these 
files, as well as directions for finding or downloading is 
contained in the chapter relating to each tool. 
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The following GEOPAK chapters cover the topics listed below: 

• User Preferences 
• Project Manager 
• Survey Manager 
• DTM creation 
• Design and Computation Manager 
• Horizontal and Vertical Design 
• Cross-Sections 
• Plan & Profile Sheet Clipping 
• Quantities 
• Reports 
 

 
Consultants working on EFLHD projects must download 
current versions of all EFLHD standard files at the start of 
each project.  EFLHD standard files may be updated from 
time to time, however, files current at the start of each 
project will typically be used for the duration of the project.   
The COTR will notify the consultant if an updated file 
needs to be used during a project. 
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GEOPAK 2004 Tools 

WFLHD has developed an extensive guide to 
using the Geopak 2004 software.   The guide is 
called  “The Complete Knucklehead’s Guided 
Tour of Geopak 2004 Edition”.  This site 
contains tips, examples and procedures.    
Selecting the following link can access this 
guide:  

The Complete Knucklehead's Guided Tour 
of GEOPAK 2004 Edition   

 

http://www.wfl.fhwa.dot.gov/geopak/idiot2004/idiot2004.htm
http://www.wfl.fhwa.dot.gov/geopak/idiot2004/idiot2004.htm
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Chapter 12:  GEOPAK Preferences 

Purpose 

GEOPAK Preferences control many different aspects of 
GEOPAK, including how data is displayed, where data is 
stored, and how to handle complex procedures such as 
survey data and superelevation.  This chapter will outline the 
preferences that must be set when working on EFLHD 
projects.  This chapter will not detail every preference, as 
many are not consequential to EFLHD.  The preferences not 
detailed in this chapter may be set to GEOPAK defaults or as 
the user desires.  Information on preferences not detailed 
here may be found in the GEOPAK help files. 

User Preferences 

User preferences may be accessed from the main GEOPAK 
pull-down menu, by selecting Applications>GEOPAK 
ROAD>User Preferences. 

 

Figure 12-1: Accessing User Preferences 
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Once selected the User Preferences dialog will activate. 

 

Figure 12-2: User Preferences Dialog 

Generic Preferences 

The preferences set in the top portion of this dialog box are 
utilized by many GEOPAK functions including; plan view and 
cross section labeling, DP Station Offset, and Design and 
Computation Manager.  

The setting of the decimal places only affects rounding of 
the screen output.  Internally, GEOPAK still computes to 
double precision accuracy. 
 
Generic preferences are set here.  Project specific 
preferences may be set through Project Manager and will 
take precedence over preferences set here.  See the 
chapter on Project Manager for more information. 
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The setting of the Unit option button, English or Metric, is 
critical to getting the correct results for GEOPAK 
earthwork and cross-section reports. 
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The following chart describes the settings to use when 
working on EFLHD projects. 

GEOPAK User Preferences 

Preference 
Setting for 

EFLHD Notes 

Unit System 
Dependent 
on project 

Determines whether GEOPAK operates 
according to the English or Metric 
system of measurement.  The Unit 
parameter affects every GEOPAK 
component. 

Coordinates NE 
Sets either NE (Northing/Easting) or XY 
coordinate values in Labeling 
components. 

Direction Bearing 

Sets the direction format for such 
variables as line direction in Labeling, 
and components within the Design and 
Computation Manager.   

Station Format 
1+234 (M) 
12+34 (E) 

Sets the format for station variables in 
Labeling, and components within the 
Design and Computation Manager. 

Distance 
999.123 (M) 
999.12 (E) 

Sets the number of decimal places for 
most non-station and non-angle 
variables in the GEOPAK Labeling, and 
components within the Design and 
Computation Manager.  Variables 
affected by the Distance Decimal 
parameter include point coordinates, 
curves parameters such as length and 
radius, inverse distance, elevations, 
etc. 

Station 
9+99.123 

(M) 
9+99.12 (E) 

Sets the number of decimal places for 
station variables in Labeling, and 
components within the Design and 
Computation Manager. 

Angle Seconds 

9°9'9.123” 
(M) 

9°9’9.12” 
(E) 

Sets the number of decimal places for 
angle variables in Labeling and 
components within the Design and 
Computation Manager.  Variables 
affected by the Angle Sec. Decimal 
parameter include curve delta and 
degree, bearings and inverse angles.   

Table 12-1: EFLHD User Preference Settings 
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The Working Directory option directs GEOPAK to where the 
.gpk file and other data files can be found.  If left blank, 
GEOPAK will look in the directory where the Microstation file 
was opened.  Either the Working Directory or the COGO Job 
Directory should always be defined so that GEOPAK can find 
the .gpk file. 

Feature Preferences 

Feature preferences pertain to how survey data is interpreted 
by GEOPAK.  Information for each element is stored in a 
Survey Manager Database, or .smd file.  The .smd file 
controls how survey elements and visualized COGO elements 
are displayed in Microstation.  For example, the .smd file 
determines which cell will be used to represent a fire hydrant, 
or what level, color, weight and line style will be used to 
depict a fence line that was surveyed in the field.  The .smd 
file also controls whether a point recorded in the field will be 
part of the DTM.  The .smd file is specific to EFLHD and for 
consultants, .smd file is available at EFLHD website through 
the CADD_Resource_v8.zip download.   

The .smd file can be found on the EFLHD network at: 
M:\Cadd_resource_v8\X_30\Standards\SMD.   

This .smd file only controls survey information and therefore 
does not need to be set once the survey mapping has been 
completed. 

Workflow 1: Attaching the Correct .smd File 

1. From the User Preference dialog shown on Figure 
12-2, select the Feature Preferences button. 

2. The Feature Preferences dialog will activate, 
showing the currently attached .smd file. 

 

Figure 12-3: Feature Preferences 

3. The EFLHD standard .smd file to use with the .x30 

criteria is  Press the Select button  and browse 
to the location of the EFLHD .smd file. 
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4. Check the Apply Best Match Feature box and set 
the Plot Scale field to 1.00 

 

 

 

EFLHD .smd file is automatically attached 
when entering MicroStation using the project 
configuration file (*.pcf).   

COGO Preferences 

The COGO preferences dialog box allows the user to specify 
the Job Open Mode, what GEOPAK will do when a new or 
incorrect job number is specified, setup COGO directories, 
and redefinition of COGO elements. 

 

Figure 12-4:  COGO Preferences 

Job Open Mode 
The job open mode specifies what happens when a job 
number is input. 

 

Figure 12-5:  Coordinate Geometry 

When coordinate geometry is accessed, a job number must 
be specified.  This number corresponds to the file 
jobXXX.gpk, where XXX is the job number, shown above as 

STANDARDS FOR USE WITH X30 CRITERIA 12-5 
3/27/2007 



 

 

EFLHD CADD Standards Manual 
Chapter 12 — GEOPAK Preferences 

101.  GEOPAK uses the following three rules to search for the 
specified job number:   

• If the Job Directory is defined (in the COGO 
Preferences dialog box) then GEOPAK looks for the 
.gpk file exclusively in the Job Directory. 

• If the Job Directory is not defined and the Working 
Directory is defined (in the main GEOPAK 
Preferences dialog box) then GEOPAK looks for the 
.gpk file exclusively in the Working Directory. 

• If neither the Job Directory nor the Working 
Directory is defined then GEOPAK looks for the .gpk 
file exclusively in the directory that the active 
design file resides in. 
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If the .gpk file is found in the directory selected 

according to these rules then the job will be opened and Job 
Open Mode doesn't come into play.  On the other hand, if the 
.gpk file is not found then the option chosen for Job Open 
Mode controls how GEOPAK deals with not finding the .gpk 
file as follows: 

Both A/E Contractors and EFLHD roadway designers 
should get GEOPAK job numbers from their Design 
Team Leader or Project Manager.

 
• Create:  When set to Create, the job will be opened 

if it is found, or created if no job matching the 
number exists in the working directory.  This option 
can be dangerous if an incorrect working directory 
has been specified.  In this case, a new .gpk file will 
be created with no warning to the user. 

 
• No Create:  When set to No Create, GEOPAK will 

open the job, if found, or show the following dialog 
box if the job number is not found. 

 

 
 

Figure 12-6:  No Create Information 
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• Query:  The Query option is the option preferred by 
the majority of users.  If the job is found, it will be 
opened, if not a dialog box will open stating that the 
job could not be found and asking if the user would 
like to create the specified job in the working 
directory. 

 

Figure 12-7:  Create Job Number 

The job open mode Query is the EFLHD 
recommended mode. 

 

 

Job Directory and Working Directory 
The working directory is where GEOPAK puts all of the files 
created by GEOPAK and is also the first place GEOPAK will 
look for files when you need to open something from 
GEOPAK. 

The job directory is an ALTERNATE directory to store the .gpk 
file. If this is set, any .gpk you create will be placed in that 
directory and any time you need to open a .gpk, GEOPAK will 
look in that alternate directory as well. 

These two parameters work in unison, the Job Directory is 
supplemental to the Working directory. 
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Chapter 13: Project Manager 

Introduction 

The GEOPAK Project Manager is a tool which associates the 
COGO job number, users, project files, working directories, 
and various user preferences (such as whether to use Metric 
or English units) with a specific project.  Within the project, 
Project Manager keeps track of all the numerous bits of 
information for each working alignment (whether one 
alignment or several) that GEOPAK needs to "fill in" the dialog 
boxes for all its various procedures.  This includes things such 
as:  dgn file name and directory path where the pattern lines 
and superelevation shapes are drawn; level symbology for 
the pattern lines and shapes; existing and design profile 
names, dgn file name, directory path, grid origin, and scale 
for the profiles; etc.   Project Manager "remembers" all this 
information and automatically shares it among the various 
GEOPAK procedures as needed, thus eliminating the need for 
the designer to retype the same information into several 
GEOPAK dialog boxes.   Project Manager also provides the 
user with an easy to follow on-screen flowchart diagram 
showing the GEOPAK workflow.  All of the various GEOPAK 
procedures (e.g., cutting existing ground cross-sections, 
laying out the design profile, drawing pattern lines, etc.) can 
be accessed by clicking on the buttons in the flowchart, 
shown later in this chapter.  In addition to the storage of 
information based on the overall project and working 
alignments, Project Manger also allows for the storage of 
information related to each process (e.g., creating 
superelevation autoshapes or processing proposed cross 
sections) for a working alignment in a GEOPAK "run".  For 
example, the information needed to process proposed cross 
sections along the mainline could be stored in a run called 
MAINLINE.  Information specific to the run such as cross 
section file, shapes, typical section, re-definable variables, 
etc. is stored within the run.  Changes made to the chain, 
proposed profile, pavement width, etc., causing the need to 
rerun proposed cross sections will now be a painless process.  
By selecting the run MAINLINE and selecting Files>run, new 
cross sections will be generated without having to re-enter 
any of the defined information. 

The use of Project Manager is required to create proposed 
cross sections through the Typical Section Generator.  A/E 
contractors working on EFLHD projects in Microstation V8 and 
Geopak X30 will be required to use the Project Manager.  
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Workflow 1: New Project Creation 

1. Select Applications>GEOPAK ROAD>Project 

Manager, or select the project manager icon  
from the GEOPAK Road toolbar.  The following 
dialog box will open. 

 

 

Figure 13-1: Project Manager 

2. From the Directories section of the Project 
Manager dialog box, middle right side, path to the 
desired directory to create the project.  This 
should be the M:\Projects\Project 
name\Roadway\GEOPAK directory. 

3. From the Projects pull down menu, select New. 

4. Fill in the desired project name, working 
directory, job number, and a brief description of 
the project. 
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Figure 13-2: Create New Project 
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The Project Name specified is combined with a ".prj" extension to 
create the main Project Manager set-up file in the working directory.  
Therefore, the name specified must be a valid Windows file name 
(i.e., it cannot contain the special characters  \  / : * ? " < > | )  
Although there is no standard naming convention used for .prj files in 
EFLHD, it's good practice to use a name that relates to the project's  
route designation because the Project Name specified here is used 
to access the Project Manager setup for the project in subsequent 
sessions. 
 
For EFLHD roadway designers the Working Directory selected 
should always be the M:\Projects\project name\proj_dev\CADD 
subdirectory under the main project directory on the M: drive. 
 
A/E Contractors should get GEOPAK job numbers from their EFLHD 
Project Manager.  EFLHD roadway designers should also get 
GEOPAK job numbers from their Project Manager. 
 
If the user is creating a new project definition that does not have an 
existing .gpk file then the GEOPAK job number should be keyed into 
the Job Number field.  This is how a new .gpk file is created within 
Project Manager.  If the user is creating a new project that has an 
existing .gpk file, click on the Select button and select the existing 
.gpk file.  If the existing .gpk file isn't visible in the selection window 
then either the Working Directory is incorrect or the existing .gpk file 
is not in the Working Directory. 

5. Select the Preferences button, and set the 
desired project related preferences. (See the 
chapter on GEOPAK Preferences, for information 
related to the preferences dialog box.)  Unit 
specific preferences are shown in the dialog 
boxes below. 
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Figure 13-3: English Preferences 

 

Figure 13-4: Metric Preferences 

6. Select the COGO Preferences button.  Set the Job 
open mode to Query. 

 

Figure 13-5: Job Open Mode 
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7. Select OK to return to the User Preferences 
dialog. 

8. Select OK button in the User Preferences dialog 
to exit and accept the preferences. 

9. Select OK button on the Create New Project 
dialog box to finish creation of the new project. 
(If the .GPK file, corresponding to the job 
number, does not exist the user will receive an 
alert stating that the job number does not exist 
and asking if the job should be created in the 
working directory.) 

 

Figure 13-6: .GPK File Alert 

 
At this point, if the job number exists and the user gets the 
above alert then the existing .gpk file does not reside in the 
Working Directory that was specified in the GEOPAK User 
Preferences dialog (See step 6 above).  The user should 
always click the No button.  Clicking Yes here will create a 
new empty job200.gpk, leaving the user with 2 different 
.gpk files of the same name in different locations.  Fix this 
problem either by moving the .gpk file to the specified 
Working Directory, or by changing the Working Directory to 
point to the directory where the .gpk file resides, whichever 
is appropriate.  Then repeat steps 6-10.   

 

 

 

 

 
 
 
 

10. Select Yes on the Create New Project dialog 
box, the user is taken back to the original Project 
Manager dialog box to select the desired project.  
In the case of a newly created project, the name 
will now be in the projects window ready for 
selection. 
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Users should create only one .prj project file per 
project and only one .gpk file per .prj file unless 
special circumstances exist. 

Once you are finished, users must be created within each 
project.  At least one user must be created for each project. 
See workflow 3 for user creation. 

Workflow 2: Selecting an Existing Project 

1. Select the Project Manager icon , or select 
Applications>GEOPAK ROAD>Project Manager. 

2. From the Project Manager dialog box, existing 
projects are listed in the middle left window 
labeled, Projects: 

 

 

Figure 13-7: Project Manager 

3. Select the desired existing project and select OK.  
This will take you to the Project Users dialog box. 
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Workflow 3: New User Creation 

1. Once the project has been selected, the Project 
Users dialog box will be activated.  Select an 
existing user from the list or create a new user 
with the following steps. 

2. Select Users>New from the Project Users pull 
down menu. 

 

Figure 13-8:  Project Manager Users 

3. From the New Users dialog, shown below, fill in 
the Name, Full Name, OP Code, and, if desired, 
the Description fields. 

 

Figure 13-9:  Create New User 
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Name:  Users first name 
Full Name:  Users first and last name 
OP code:  Users first and last initials 

For EFLHD projects, the following standards apply for 
filling in the New User dialog box:  

 

 

 

 

4. Select the OK button once the information is 
correct. 

5. Once the OK button is picked, GEOPAK will 
activate an alert box asking if you wish to define 
a password for this user. Click on the No button. 

 

Figure 13-10:  User Password 

6. When finished you will be returned to the Project 
Users dialog box and the newly created user will 
be seen in the pick box on the left side of the 
dialog box. Select the user by double-clicking on 
the users name, or by highlighting the user and 
selecting the OK button. 

7. This will activate the roadway design Project 
Manager dialog, as shown below. 

 New to GEOPAK 2004, there is no longer 
the option to select Project Manager for 
Survey or Road at this point.  Survey has 
been removed from this workflow and Road 
is the only option. 
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Figure 13-11:  Project Manager Roadway Flow 
Chart 

You have now completed the preliminary setup for Project 
Manager. The dialog above will be the starting point for many 
of the GEOPAK functions that have previously been accessed 
through GEOPAK pull-down menus or icons. The bottom 
sections of the project manager dialog, commonly referred to 
as the flowchart, will take you to the tools you have already 
been using. We will get into these tools in more depth in 
future chapters. 

The title bar of the roadway design project manager dialog 
displays the name of the project. In the example above, the 
name of the project is FHWA.prj.  The following section has 
three pull-down menus; File, Remember, and Options.  For 
details of these menus, see the GEOPAK help documentation.  
(Remember is shown below, as it can be a time saver that 
many users do not use.) 

Remember:  There are two options under the Remember 
menu: Project and User.  Checking any or both 
of these options will allow Project Manager to 
skip certain steps.  For example, checking 
Project will take the user directly to the Project 
Users dialog immediately upon accessing 
Project Manager the next time, remembering 
the current project. If a user works on only one 
project for the majority of the time this will 
save time.  Likewise checking User will 
remember these settings as well.  If there is 
typically only one user working on the project 
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it is beneficial to skip the Project Users dialog 
box, remembering this user each time. (As 
stated earlier, there should be only one .prj file 
per project located on the network therefore 
this setting is machine independent), 
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It is advisable to check both of these options on.  It is 
very easy to check them off when a switch to another 
project is necessary.  Checking both on will take the 
user directly to the main Road Project Manager dialog 
when Project Manager is accessed. 

The next row down on the project manager dialog shows the 
working directory on the left with the user and job number on 
the right. This is for information only. 

Next is the section on working alignment and runs. Below is a 
definition of each of these new concepts. 

Working Alignment:  A working alignment is a user-
defined group of the basic design components (e.g. horizontal 
alignment, design profile, roadway template, cross-sections, 
etc.) that make up a single roadway design.  The purpose of 
a working alignment is to allow Project Manager to 
“remember” and automatically fill in these components in the 
dialog boxes for the various GEOPAK procedures.  Creating 
working alignments allows the user to organize data specific 
to the project or to specific alignments within the project.  
Many projects will have only one working alignment, while 
others may have many, depending on the complexity of the 
job.  Project details such as the level and color of the existing 
ground, the location and attributes of the pattern lines and 
superevelation shapes, and the location of the plan view file 
and the chain name, are associated with the working 
alignment.  Defining this information within a working 
alignment greatly reduces time by not having to re-enter this 
information each time a different GEOPAK tool is accessed.  
For example: If all the information about the cross-sections is 
defined, the user will not have to input the attributes 
associated with existing and proposed ground when creating 
proposed cross sections. 

Run: Each time a tool is selected the user will create a run or 
select an existing run. The data associated with the use of a 
tool, for a particular purpose will be saved in the run. This 
allows the user to redo work without re-inputting information. 
For example: Creating an existing ground profile requires 
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inputting profile name, chain, beginning and ending station, 
how to cut, and the tin file name. With all of this information 
stored in a run, no inputting of information will be required 
for each additional time the profile may need to be re-cut. 

There are three buttons to the right of the working alignment 
information; Select, Define, and Port Viewer. These are 
discussed below. 

Select: Allows the user to select or create a working 
alignment. 

Define: The Define button allows the user to define 
information specific to the working alignment. 

 

Figure 13-12:  Working Alignment Definitions 

For each selection on the left, the dialog changes on the right 
to accommodate the selection. For example: For Plan View, 
Profile View, and Cross Section View, GEOPAK is looking for a 
file name, and a chain or profile name. For Pattern and 
Shapes, GEOPAK needs a file name and attributes of these 
elements. 

Workflow 4: Creating a Working Alignment 

 Be sure the Working Alignment Influence Runs box is 
checked before continuing with this workflow.  When 
checked, all information defined will be attributed to the 
current working alignment.  You may create multiple 
alignments as needed. 
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1. From the Road Project Manager dialog box, click 
on the Select button. 

 

Figure 13-13:  Select Working Alignment 

2. The Select Working Alignment dialog will be 
activated. Select Run>New from the pull down 
menu. 

 

Figure 13-14:  Create New Working Alignment 

3. Fill in the Run Name box and, if desired, fill in the 
description box. Select OK box to finish. 

 

Figure 13-15:  Create New Working Alignment Run 
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4. The newly created working alignment run has 
been created and will now be displayed in the 
select working alignment dialog box. Highlight 
the desired working alignment and select the OK 
button. 

 

Figure 13-16:  Select Working Alignment 

5. The new working alignment name is now 
displayed on the Road Project Manager dialog 
box and the user is now ready to begin project 
work. 

 

The workflow outlined above merely creates the empty 
shell of the working alignment.  At this point, or as the 
project progresses, select the define button and fill in 
the information, as it becomes available, to complete 
the working alignment definition.  All information 
defined will be attributed to the selected working 
alignment. 

Port Viewer 

The Port Viewer is a handy tool for simultaneously 
viewing and editing each of the three main elements of 
a road design: plan, profile, and cross-section.  Before 
invoking the Port Viewer, the user must have the plan 
view, profile view, and cross-section view, defined in 
the working alignment definitions, as detailed above. 
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Once these files have been defined, the Port Viewer will 
open three additional MicroStation view windows 
containing the three files listed above. 

Workflow 5: Port Viewer 

1. Begin by accessing the Working Alignment 
Definitions dialog box from the main Project 
Manager dialog. 

 

Figure 13-17:  Access Working Alignment 
Definitions 

2. From the Working Alignment Definition dialog 
box, shown below, complete the information on 
the right side of the dialog box.  The information, 
including design file names, chain/profile, cell 
origin and scale of the profile, etc., must be 
defined so that the Port Viewer can find the 
desired files. 
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Figure 13-18:  Working Alignment Definitions 

3. Once the Working Alignment information has 
been defined, the port viewer can be accessed.  
From the main Project Manager dialog, select the 
Port Viewer button. 

 

Figure 13-19:  Accessing Port Viewer 

4. The three views should now be visible, along with 
the Port Viewer tool menu. 
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Figure 13-20:  Port Viewer 

5. As shown above, the Port Viewer allows 
simultaneous viewing of each element.  Also, the 
port viewer provides index lines for easy locating 
of stations along the alignment.  Shown as a line 
perpendicular to the centerline in the plan view, a 
vertical line in profile, and cross hairs in cross-
section, the index lines allow the user to see 
where, for example, a problem in profile falls in 
the plan view.  Move through stations by 
selecting the greater than and less than symbols 
in the center of the Port Viewer dialog box. 

 

Figure 13-21:  Port Viewer Tools 
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6. From the view pull down, the user can fit each of 
the views or set any of the views as the active 
view. 

 

The Port Viewer can be a powerful timesaving tool, as 
opposed to switching back and forth from the different 
drawings, during the design process.  For more information 
on the Port Viewer, access the GEOPAK help from the 
GEOPAK pull down menu. 

Related links: Setting up Project Manager for Proposed 
Cross-Sections using Knucklehead’s Guide for GEOPAK Road 
2004 Edition. 

Setting up the Proposed Cross Section run for the 5 typical 
sections available through the Typical Section Generator, 
using Knucklehead’s Guide for GEOPAK Road 2004 Edition. 

 Existing Features

 Right of Way

 Rehabilitation(3R)

 Undivided New Construction

 Automated Cross Section Labeling

http://www.wfl.fhwa.dot.gov/geopak/idiot2004/proj_man.htm
http://www.wfl.fhwa.dot.gov/geopak/idiot2004/proj_man.htm
http://www.wfl.fhwa.dot.gov/geopak/idiot2004/exist_typ.htm
http://www.wfl.fhwa.dot.gov/geopak/idiot2004/row_typ.htm
http://www.wfl.fhwa.dot.gov/geopak/idiot2004/rehab_typ.htm
http://www.wfl.fhwa.dot.gov/geopak/idiot2004/new_typ.htm
http://www.wfl.fhwa.dot.gov/geopak/idiot2004/auto_lab_typ.htm
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Chapter 14: Survey Manager 

Overview 

Survey Manager is used to input raw or corrected ASCII 
survey data into MicroStation and GEOPAK.  This will allow the 
user to create a .tin, and a topo file, and also input surveyed 
cross sections used in the final design.  Survey Manager will 
also allow the user to make modifications to the data if there 
is a bust in the original survey.  This section will describe the 
workflows used to input and modify the survey data provided 
by surveyors. 

SMD File 

This file contains the parameters GEOPAK uses to draw the 
survey data, including information such as: 

• The cell to be associated with the survey shot. 

• The elements to be included in the DTM.  For example, 
a ground shot would be included in the DTM, and a fire 
hydrant will not be included. 

• The shots that should be part of a string, such as an 
edge of pavement line. 

• The shots that should be part of a break line 

• The shots that are spot elevations. 

The EFLHD standard .smd file is EFLHDeng.smd.  This file 
can be attached by clicking on the Feature Preferences button 
in the GEOPAK User Preferences dialog box, as shown in the 
GEOPAK preferences chapter. 

 
The Survey cell library, EFLHDcell.cel, must also 
be attached for the .smd file above to produce the 
desired symbology.  See chapter 8, Cell Libraries, 
for more information on attaching the correct cell 
library. 

 

 

 

Importing Survey Data 

The survey team should provide an ASCII file with a .cor, txt, 
and .cvs extension.  This file will be in a comma-separated 
format. The columns will be point number, northing, easting, 
elevation, point code/line code and then a semi colon with any 
comments.  GEOPAK will read this file and, if the correct .smd 
file is referenced, draw the survey data using the standard 
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level symbology.  Workflow 1 will describe the procedure for 
importing the .cor file into GEOPAK. 

Workflow 1: Importing Survey Data 

1. Select Applications>GEOPAK SURVEY>Survey 
from the pull down menu: 

                        

Figure 14-1:  Geopak Survey  

2. This will bring up the following dialog box: 

 

Figure 14-2:  Geopak Survey Dialog Box 

 Select Project>New to get the following dialog 
box: 

 

 Project Name or extension of project 

 

Figure 14-3:  New Project 

14-2 
3/27/2007 

STANDARDS FOR USE WITH X30 CRITERIA 



 

 
 

EFLHD CADD Standards Manual 
Chapter 14— Survey Manager  

3. Fill in the dialog box with the required information 
and select Ok.  This will change the title in the 
Survey dialog box to show the project name. 

4. Select  Dataset>New to get the following dialog 
box: 

 

Figure 14-4:  Select Dataset 

5. Fill out the dialog box as shown, using the add file 
to list button  to load the desired file.  Select Ok 
to get the following dialog box. 

 

Figure 14-5:  Process Dataset 
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6. The Linking Code button brings up dialog box in 
which you set the line codes read from the ASCII 
file.  Usually “Code-BL*” is used for begin line and 
“Code-EL*” is used for end line. 

7. Make sure the Delimiter is a comma and the 
Comment Delimiter is a semi-colon.  Highlight any 
line in the data box and GEOPAK will put that 
information above the buttons at the bottom of 
the dialog box.  Select the buttons as shown in the 
above example.  The PNum stands for Point 
Number, Y is the Northing, X is the Easting, Z is 
the Elevation, and LCodePCode is the Code that 
the Survey Manager uses to draw the elements 
properly.  If there is a Next button and it is picked 
it will show one more column, which is the 
comment column.  This button should be set at 
none.  Check the Store Elements into GPK and 
Import After Process boxes.  This will import the 
points into the GPK. 

8. Go to the 3D MicroStation file that the survey data 
needs to go in and pick Visualization>Visualize the 
get the following dialog box: 

 

Figure 14-6:  Visualization 

9. Set Search allows the user to select the Data Set 
to import into the drawing.  After the correct data 
set is chosen, select Process. 

10. Once these values are set, select the Process 
Survey button on the Survey Operations dialog 
box. 

11. GEOPAK will draw the elements into the 
drawing.  If there are error messages during the 
process, pick the Dataset>Review 
Reports>Feature Code Error Report pull downs to 
find out what the error is.  Go to the .cor file and 
modify to the correct feature code. 

12. This next step will build the .tin.  Select the 
DTM>Build DTM>From Survey data pull downs. 
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Figure 14-7:  Select Build DTM 

It will bring up the following dialog box. 

 

Figure 14-8:  Build DTM 

13. Type in the new name for the .tin.  Select 
dissolve option side with a side length that is long 
enough to avoid any voids along the outside edges 
of the data.  The creation of a. DAT file is not 
necessary but can be done at this point.  Select 
Process and the .tin will be created. 

 

Making Corrections 

There will be times when there is a problem in the survey and 
a correction to a chain or a point will need to be made.  If you 
know where this point is in the .cor file, it is easy enough to 
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fix.  But the size of the .cor file can be too large to find the 
error without spending a large amount of time.  The most 
efficient way is to fix it using the Chain and Point Editing 
features in Survey Manager.  Workflow 2 will describe the 
procedure for editing a chain and Workflow 3 will describe how 
to edit a point. 

Workflow 2: Chain Editing 

1. While in the drawing containing the graphical 
elements to be changed select the 
Geometry>Chains>Edit pull downs.  GEOPAK will 
bring up the following dialog box. 

      

 

Figure 14-9:  Edit Chain, Compact 

2. Click on the Select Chain icon and choose the 
chain that needs to be modified.  GEOPAK will fill 
all the chain information into the data fields. 

3. Click on the double arrows at the right side of the 
dialog box to show all the chain information.  The 
GEOPAK Chain Edit dialog box will expand to the 
following. 
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Select Point 

Update Point

Figure 14-10:  Edit Chain, Expanded 

4. Click on the Select Point icon in the Chain Points 
section and highlight the point that is to be 
modified.  All of the fields will be filled in with that 
point’s information.  Make the necessary change 
and Select the Update Point button.  

5. Once all of the modifications have been made, the 
.tin file can be updated by repeating steps 12 and 
13 of Workflow 1. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

By using the Chain Editing tool, the user can 
break a chain, add points to the chain, and delete 
points.  GEOPAK will also highlight the point that 
is selected. 
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Workflow 3: Point Editing 

1. While in the drawing containing the graphical 
elements to be changed select the 
Geometry>Points>Edit pull downs.  GEOPAK will 
bring up the following dialog box.  ALPHIA instead 
of numeric spot 
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Select Point 

Figure 14-11:  Edit Point 

 

2. Click on the Select Point icon and highlight the 
point to be modified.  GEOPAK will fill in all the 
fields with the values for that point. 

3. Click the Update button at the bottom of the 
dialog box. 

4. Once all of the modifications have been made, the 
.tin file can be updated by repeating steps 12 and 
13 of Workflow 1. 

Reference Hub Cross Sections 

Once the alignment is set.  The surveyors will provide a 
Reference Hub survey.  These are provided in a .soe file.  
These sections will need to be imported into the cross section 
cells for comparison to the existing sections based on the tin 
and then the proposed sections will need to be modified to tie 
into the surveyed sections.  Workflow 4 will describe the 
procedure for importing the .soe file into the existing cells 
cross-section cells. 
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Workflow 4: Importing Reference Hub Sections 

1. While in the cross section drawing, go through the 
same first four steps as in Workflow 1 above.  
Instead of changing the Download Raw button to 
ASCII XYZ, change it to SOE => Cross-Section.  
This will bring up the following dialog box. 

 

 

Figure 14-12:  SOE =>XS Data Source 

2. Select the Dataset Add Source File button to load 
the .soe file to get the following dialog box. 

 

Figure 14-13:  Process SOE =>XS Data 
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3. Make sure the Delimiter button is correct (either 
Space, or Comma).   

4. Highlight a row in the Contents of File and 
GEOPAK will drop those values in the space above 
the bottom buttons.  Set the bottom buttons to 
match the example.  

5. Select the Plot Parameters button to get the 
following dialog box. 

 

Figure 14-14:  Ref Hub Mapping Option 

6. Since the sections are going into the existing cells, 
the only changes to be made are in the Cross 
Section Element Symbology.  Change the Level, 
Color, Weight and Style values to match the 
example below: 

 

Figure 14-15:  Plot Parameters 

7. Select Process and the sections will be drawn into the 
drawing. 
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Chapter 15: Digital Terrain Model (DTM) 
 

Overview 

An existing ground DTM will be the base with which to create 
existing profiles, existing cross-sections, generate earthwork, 
etc.  Proper creation is imperative for the success of each of 
these procedures.  This chapter will explain the process for 
extracting graphics from a DGN file containing 3D elements 
that represent existing ground. 

Extracting Graphics 

There will be occasions when a tin will need to be created from 
a 3D drawing.  This can be done using the Extract Graphics 
command.  The following paragraphs and workflows will 
describe the steps in creating and checking a tin.  

This is a two-step process. The first step is to create a .dat 
file; the second step will use the .dat file to create the .tin.  
Workflow 1 will describe these two processes. 

 

Workflow 1: Extracting Graphics 

1. Open the .dtm file that contains the 3 
dimensional elements that will be used to create 
the tin. 

 

 

2. Access the DTM Menu by clicking on 
Applications>GEOPAK ROAD>DTM Tools as 
shown below: 
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Figure 15-1:  Accessing DTM Tools 

 

 or by clicking on the DTM icon in the GEOPAK 
toolbar. 

 

Figure 15-2:  DTM Tools Icon 

3. This will bring up the following dialog box.  
Select the Extract Graphics button. 
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Figure 15-3:  DTM Tools Dialog 

 

4. The following dialog box will come up. 

 

Figure 15-4:  Extract Graphics 

 Fill in the file name for the .dat file, make sure the 
File open button is on Create unless adding 
information to an existing .dat file. 

5. EFLHD leveling convention allows for easy 
separation by level only so the Levels Numbers 
box should be the only one marked in the Search 
Criteria area.  Pick the Select box by the Levels 
label to bring up a Microstation Level Name 
Search Filter dialog box.  Since Spots is the 
Feature identified above in the Search Criteria 
area, make sure all spots are on level 
E_GEO_Spot_Elevation and then mark level 
E_GEO_Spot_Elevation only, then select OK. 

6. Fit your Microstation view so all elements are 
included within the current view, make sure 
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View is selected in the Extract portion of the 
Extract Graphics dialog box and pick Apply. 

7. Once that data is extracted change the Extract 
Graphics dialog box to show File Open = Append 
and Feature = Breaks as shown below. 

 

Figure 15-5:  Append Settings 

8. Make sure all the break lines are on level 
E_GEO_Break Line and then change the Selection 
Level to level E_GEO_Break Line and select 
Apply. 

9. Once the .dat file is completed, pick the Build 
Triangles button.  

 

Figure 15-6:  Build Triangles 

 

This will bring up the following dialog box. 
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Figure 15-7:  Build Triangles 

10. GEOPAK will automatically input the .dat file 
just created.  Type in the .tin file name and 
change the Dissolve Option from None to Side.   

11. Select process and GEOPAK will build the tin 

 
The side length refers to the length of a triangle leg 
placed on the exterior of the tin.  We do not want the 
triangles jumping across areas on the exterior boundary 
of the survey where there is no survey data.  Make sure 
this length is long enough to avoid any gaps in the 
middle of the tin, but short enough to keep the triangles 
from spanning areas where there is no survey. 

 

 

 

 

 

. 
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Checking TIN 

Once the tin is created, it is important to make sure no 
elements with zero elevations or no busts in the survey have 
been included in it.  First, check the triangle statistics to verify 
that the elevation range is realistic.  Then draw the contours 
to make sure they look reasonable.  The following workflow 
will guide the user through these steps. 

 

Workflow 2: Checking the .tin 

1. Select the DTM Menu button from the DTM 
toolbar. 

 

 

Figure 15-8:  DTM Menu 

This will bring up the following dialog box. 

 

Figure 15-9:  DTM Toolbar 

2. Select Reports>Triangle Statistics to access the 
TIN statistics dialog box shown below. 
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Figure 15-10:  Accessing Triangle Statistics 

 

 

Figure 15-11:  TIN Statistics 

3. GEOPAK will automatically input the current .tin 
name.  Press Process and GEOAPK will fill in the 
fields.  Check the Elevation values to make sure 
they are consistent with the survey.  If there is a 
zero value or the range does not seem correct, 
the best way to determine the location of the 
bust is to draw the contours as described below.  
Once the bust is located, the correction to the 
.dtm file can be made and the .dat file can be 
recreated. 

4. To check the .tin by drawing the contours, select 
the Load DTM Features button. 

STANDARDS FOR USE WITH X30 CRITERIA 



 

 
 

15-8 
3/27/2007 

EFLHD CADD Standards Manual 
Chapter 15— DTM  

 

Figure 15-12:  Load DTM Feature 

 

 

 

 

 

The following dialog box will come up. 

 

Figure 15-13:  Load DTM Features 

5. GEOPAK will fill in the current .tin file.  Choose 
Extent and either Display Only or Graphic Group. 

 

 

 

 

If Display Only is selected, the contours will 
disappear when the view is refreshed.  Selecting 
Graphic Group will allow the user to easily delete 
the contours. 
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6. Set the Display for Contours, Major Lines, Major 
Label, and Minor lines ON by highlighting each 
and picking the yellow light bulb without the 
arrows next to it.  Set the parameters for the 
lines and labels. Set the Major and Minor 
Intervals as above and pick the Read button to 
set the range equal to the range of the tin.  Once 
the parameters are defined select Load button at 
the top of the dialog box. 

7. Review the contours to determine if there are 
any busts.  Make any corrections necessary and 
start the process over with Workflow 1. 

 
These contours are not meant for plan production.  
This process is strictly for checking the tin. 
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Chapter 16:  D & C Manager 

Overview 

Elements such as edges of pavement, centerlines, curb and 
gutter, and guardrail, whether created through GEOPAK 
coordinate geometry, or simply drawn into MicroStation must 
be placed with the correct symbology.  This is vitally 
important for such things as plotting, automated quantities, 
cross-sections, and ease of checking.  GEOPAK’s design and 
computation (D & C) manager is the tool that automates this 
task through the use of a hierarchical database, .ddb, 
containing information about each element to be placed 
within a set of plans. 

EFLHD 

At EFLHD, there are English and Metric versions of the 
database for use on their respective projects.  Each .ddb file 
is broken into 3 categories: Pay_items, Criteria, and 
Features.  Pay_items is then further broken down into the 
correct division, as shown below, then to section, then 
individual item, etc. 

 

Figure 16-1:  Design and Computation Manager 
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Workflow 1: Downloading and Attaching the Correct 
.ddb File 

1. The .ddb file in use at EFLHD can be found at: 

http://www.eflhd.gov/cadd/standard_files
/ddb_files.zip

2. From the above link, download file and unzip the 
.zip file. 

3. Place the unit correct .ddb file in a location where 
it can be easily accessed for each project. 

 

 

 

 

 

 

Placing the .ddb file in a project specific location ensures 
several things: 

• That the current .ddb file will be used on the project 
for which it was intended. 

• That the .ddb file used on the current project will be 
archived with the project for future use. 

• That the file is less likely to be copied to a future 
project, which must, again, download the most 
current .ddb file. 

 

 

 

 

4. Access the D&C Manager by selecting 
Applications>GEOPAK Road>Design and 
Computation Manager, as shown below, or by 
selecting the D&C Manager icon from the GEOPAK 
Road tool frame.  Once accessed, two dialog 
boxes appear.  The main D&C Manager dialog 
box, as shown in step 5, and a secondary dialog 
showing various D&C Manager options. 

http://www.eflhd.gov/cadd/standard_files/ddb_files.zip
http://www.eflhd.gov/cadd/standard_files/ddb_files.zip
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Figure 16-2:  Access D&C Manager 

5. From the D&C Manager dialog select File>Open. 

 

Figure 16.3:  Open Database 
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6. Select the .ddb file specific to the units of the 
current project from the location of the saved 
files. 

 

Figure 16-4:  Select EFLHD Database 

7. Select OK, the correct .ddb file will now be 
attached. 

 

Using the D & C Manager 

As stated in chapter 11, this manual is not intended to teach 
the use of GEOPAK to the novice user.  However, the 
following workflows will outline the most important uses of 
the D & C Manager, and their importance to EFLHD.  There 
are two types of information drawn by the D & C Manager: 
elements such as centerlines, which have been stored in the 
coordinate geometry database, and elements, such as 
shoulder lines, which have not been stored.  See the chapter 
on Horizontal and Vertical Geometry for a list of elements for 
which a coordinate geometry chain must be created. 

 

Workflow 2: Drawing Elements from Coordinate 
Geometry 

8. Once a chain, profile, or other coordinate 
geometry element has been stored in the 
coordinate geometry database, it will be drawn 
into Microstation using the D & C Manager’s Draw 
Plan and Profile tool.  From the D & C 
Manager dialog box, select the type of 
element to be placed.  Make sure the Design 
button, shown as a pencil drawing a line below, is 
selected. 
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Figure 16-5:  Select Database Item 

 

The feature has all of the attributes, as 
determined by EFLHD, needed to draw the 
element into Microstation.  The following 
dialog box shows how EFLHD has created 
each item with the correct level, color, 
weight, and style, for use with EFLHD 
criteria, quantities, etc. 
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Figure 16-6:  Item Review 

From the above dialog, selecting any of the 
buttons from the preferences portion of the 
dialog box will access information specific to the 
preference selected.  In the case of the dialog 
below, preferences for drawing lines is shown. 
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Figure 16-7:  Line Preferences 

 

 Double click on the window under the format 
button to get the following dialog box. 

 

Figure 16-8:  Line Feature Preferences 

The task of creating all of this information has 
already been done by EFLHD.  It is password 
protected and cannot be modified by the user. 

9. Once the correct element has been selected, click 
the Draw Plan and Profile button in the secondary 
D&C Manager dialog. 
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Figure 16-9:  Draw Plan and Profile Dialog 

 

10. Clicking the Draw Plan & Profile will 
activate the dialog box shown below, allowing 
the user to select the desired COGO element, 
shown on the left side of the dialog box.  The list 
of elements shown in this box will correspond to 
the category set by the operation button in the 
upper left corner of the dialog box.  Categories 
include Chains, Stationing, Profiles, Curves, 
Spirals, and Parcels. 

 

 

Figure 16-10:  Select Chain 

11. The various types of annotation that can be 
placed with the active category of COGO element 
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are listed along the right side of the dialog box 
as a series of check boxes.  The default setup of 
these check boxes has been determined by 
EFLHD.  The information to be placed, in this 
case, Line Direction Label, Curve Label, Curve 
Data, Spiral Label, Spiral Data, is what EFLHD 
expects to see on a typical project.  As such, for 
final submission to EFLHD, these toggles must 
not be changed.  For preliminary, in-house work, 
these may be toggled on/off as needed. 

12. The Label Scale field in the lower left corner 
of the dialog controls the size of text and graphic 
annotation for the selected coordinate geometry 
category.  The value in this field corresponds to 
the plot scale on 11x17 size plan sheets where 
the elements will be used.  For example, if D&C 
Manager is being used to draw a chain for a 
Metric units project that will be used for 1000:1 
scale plan sheets then the value in the Label 
Scale field should be 1000.  Similarly, if D&C 
Manager is being used to draw a chain for an 
English units project that is being used for 100' = 
1" plan sheets then the value in the Label Scale 
field should be 100. 

 
For the Stationing category there are a limited number of 
values that are allowable in the Label Scale field.  For Metric 
units Stationing the allowable values for Label Scale are 50, 
100, 200, 250, 300, 400, 500, 1000, and 2000.  For English 
units Stationing the allowable values for Label Scale are 10, 
20, 40, 50, 100, and 200.  If a value other than those listed is 
used for the Stationing category no stationing will be drawn. 

 

 

 

 

 

13. Select the coordinate geometry element to 
draw by single clicking on it in the list box along 
the left side of the dialog.  The element will be 
immediately drawn into the active design file. 

 

 When drawing a chain into MicroStation, select the desired 
chain only once.  It will plot immediately upon selection.  If 
the plotted chain is not visible, do a MicroStation fit view to 
fit the chain into the MicroStation window. 
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Placing Design Elements Using Microstation Commands 

Placing elements into Microstation which have not been 
designed using coordinate geometry, but rather will be drawn 
using Microstation becomes an easy process with the D & C 
Manager.  EFLHD requires that elements be placed using the 
correct symbology, for the reasons stated above.  Most 
importantly, EFLHD criteria files search for elements placed 
with the correct symbology to create proposed cross-sections.  
The D & C Manager can be used in conjunction with both 
Microstation commands, such as move parallel and place line, 
and GEOPAK commands, such as draw transition.  This is 
accomplished with the Place influence command in the D & C 
Manager. 

 

Figure 16-11:  Place Influence 

Toggling on place influence will allow the user to place any 
element with the attributes of any element selected in the D 
& C Manager.  With the Adhoc Attributes toggled on, GEOPAK 
will give the new or modified element the same adhoc values 
as the active item.  With new element only toggled on, any 
modifications to a selected item will not result in changing the 
attributes of that element. In the example above, a line 
drawn using Microstation’s place line command will be drawn 
with the attributes of BL Proposed Base/Centerlines. 

 

Workflow 3: Drawing Elements Not Designed in 
Coordinate Geometry 

1. From the D & C Manager select the element to be 
drawn.  In the example below, 42” Pipe culvert. 
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Figure 16-12:  Select Database Item 

 

2. Select the desired Microstation or GEOPAK tool, 
in this example, the move parallel tool. 

 

 The move parallel tool, when used without Place 
Influence, will always place the new element with the 
symbology of the existing element, regardless of the 
active attributes.  Place Influence over-rides the existing 
attributes with that of the selected element. 
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Figure 16-13:  Place Influence 

 

3. With Place Influence toggled on, select the 
existing element and accept in the desired 
direction. 

4. The new element will be drawn with the correct 
attributes of the element selected in the D & C 
Manager, regardless of the active Microstation 
attributes. 
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Figure 16-14:  Copy Parallel with Place Influence 

 

Information for Advanced Users 

Simply setting the active level, color, weight, and style or 
toggling on the Use Active Attributes button is not the same 
as using the GEOPAK Place Influence command.  The two 
information dialog boxes shown below are, first, from the 
element placed with Place Influence toggled on, and, second, 
without using Place Influence. 
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Figure 16-15:  Element Information, with Place 
Influence 

 

Figure 16-16:  Element Information, without Place 
Influence 

As shown above, the element created with place influence has 
user data linkage attributed to the element.  The element 
created without place influence does not.  This extra data is 
read by GEOPAK for things such as automated quantities, etc. 
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Chapter 17: Horizontal and Vertical Design 

Introduction 

Since there are many different, and acceptable, methods of 
creating horizontal and vertical geometry using GEOPAK, this 
chapter will not dictate the exact methods to use.  Instead we 
will describe the different methods that can be used.  This 
chapter will be in two sections: Horizontal Design and Vertical 
Design. 

Horizontal Design 

There are four methods of setting a horizontal alignment: 
Coordinate Geometry (COGO), Graphical COGO, Horizontal 
Alignment Generator, and Store Graphics.  Any of these 
methods are acceptable to EFLHD.  Each one of these 
methods have their advantages and disadvantages, since 
graphical COGO and the horizontal alignment generator are 
similar, we will address these tools together.  This chapter 
will describe each of the above listed methods and indicate 
their advantages and disadvantages.  Regardless of the 
method used, the final alignment must be drawn into 
MicroStation using the GEOPAK D&C Manager, with the 
EFLHD .ddb file.  This will assure that the elements are 
drawn with the correct symbology, matching the EFLHD 
standards. 

Coordinate Geometry 
Coordinate Geometry can be accessed using Project Manager 
by selecting the Coordinate Geometry button. 

 

Figure 17-1:  Accessing COGO through Project Manager 17-1
3/27/2007  
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You can also select the Coordinate Geometry button on the 
GEOPAK main dialog box. 

 

Figure 17-2:  Accessing COGO through Road Tools Icon 

If you are using Project Manager, Coordinate Geometry dialog 
box will be invoked.  Otherwise, the Job Number and 
Operator code will have to be entered in the COGO Startup 
dialog box.  Project Name and Subject are optional fields.  
Press the OK button to bring up the Coordinate Geometry 
window. 

 

Figure 17-3: Coordinate Geometry 

You can create the horizontal geometry by typing commands 
in at the COGO command line, by creating an input file with a 
sequence of COGO commands and loading it into COGO, or 
by using the dialog box driven Store Curve from Tangents, 
Locate Traverse, etc., tools that are accessed from the COGO 
pull down menus to generate the commands.  If you use the 
input file method, remember that the COGO input file name 
can only be 8 characters long, must have the job number as 
the last three digits in the name, and the extension has to 
have an “i”+ the operator code.  (i.e. XXXXX101.ijd), where 
the i stands for input file. 
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Advantages. 

• This method allows the user to have more precise 
control over tangent bearings, control point 
coordinates, etc., than with Store Graphics, if done 
properly. 

• The user can set visualization on to view progress of 
design. 

 

Disadvantages. 

• Commands for the command line and input file 
methods are difficult to memorize. 

• Small adjustments are hard to make. 

• Process is time consuming. 

Uses. 

• Reviewing both horizontal and vertical alignments. 

• Creating output of alignments for printing. 

• Tweaking alignments that were created using store 
graphics, or any of the other methods. 

• Storing as-built centerline chain and profiles, especially 
those for which there are only hard copy paper plans. 

Graphical COGO / Horizontal Alignment Generator 
Overview 
Graphical COGO and the Horizontal Alignment Generator, 
allow the user to create coordinate geometry elements, much 
the same as the original COGO tools, but with a much more 
graphic and user-friendly process.  Graphical COGO and the 
Horizontal Alignment Generator can be accessed by selecting: 

Applications>GEOPAK 
ROAD>Geometry>Graphical Coordinate 
Geometry, or  

Applications>GEOPAK ROAD>Geometry>Layout 
Horizontal Alignments 
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Figure 17-4:  Accessing Horizontal Alignment 
Generator and Graphical COGO  

Or by selecting the icons from the main GEOPAK Road tool 
box. 

             

Figure 17-5:  Graphical COGO Icons 

The Horizontal Alignment Generator can also be accessed 
using Project Manager by clicking on the Horizontal Alignment 
button on the flow chart and selecting Graphical Element 
Based geometry.  Graphical COGO cannot be accessed 
directly from Project Manager. 

Graphical COGO 
The Graphical COGO tool frame, shown below contains tools 
for creating COGO elements such as lines, points, curves, 
modifying COGO elements, manipulating elements, and 
grouping elements. 

 

17-4
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Figure 17-6:  Graphical COGO Tool Frame 

From the main Graphical COGO tool frame, shown above, 
additional tools may be accessed from each of the four main 
tool boxes. 

 

 

 

 

Figure 17-7: Graphical COGO Tools 

 

 

 The Graphical COGO tools shown above, and those 
in the Horizontal Alignment Generator, look and act 
the same as many MicroStation tools.  However, 
these tools are not relying on the accuracy of 
MicroStation graphics, but rather the much more 
accurate GEOPAK coordinate geometry engine.

 

 

 

Horizontal Alignment Generator (Element Based) 
 
Horizontal Alignment Generator can be accessed by selecting 
third icon in the Horizontal & Vertical Geometry toolbox.  
Selecting this icon will invoke the Horizontal Alignment 
Generator Menu. 

17-5
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Figure 17-8:  Horizontal Alignment Generator  

 

Figure 17-9:  Horizontal Alignment Generator Menu 

The File pull-down menu allows the user to set preferences 
for how newly created elements will be displayed, how to 
name elements, and which geometry tables to use as a 
default.   EFLHD uses the Spiral Design Tables.  To access the 
Spiral Design Tables, path should be set to 
M:\Cadd_resource_v8\X_30\Standards\Bin\english or metric. 

 

Figure 17-10:  Horizontal Alignment Generator 
Preference 

The Design Tables menu allows the user to view the settings 
for the current default design tables.  In the Design Tables 
pulldown, the user sets the paths and file names for the 
tables to be accessed.  Currently EFLHD uses only the Spiral 
Curve tables (Metric and English).  Once the English or Metric 
Spiral Curve table is selected, select the design speed and 
number of lanes.  These tables correspond with the AASHTO 
Green Book.   

17-6
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Figure 17-11:  Design Tables – Spiral Curve 

The tools menu activates the COGO tools that will be used to 
create geometry elements.  Selecting Tools>Main accesses 
the following tool frame. 

 

Figure 17-12:  Horizontal Alignment Generator Tool 
Frame 

From the main tool frame, shown above, additional tools may 
be accessed from each of the six main toolbox icons. 

17-7
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Figure 17-13:  Horizontal Alignment Generator Tools 

Each of the tool boxes shown above, as well as the tools from 
Graphical COGO, may be used together to create any 
combination of geometry, from the simplest to the most 
complex. 

Advantages 

• Using these tools to set a horizontal alignment, if done 
properly, is just as accurate as traditional command 
line COGO. 

• The user does not have to remember syntax of COGO 
commands.  

Disadvantages 

• The Graphical COGO and Horizontal Alignment 
Generator tools can be complicated. 

• The process is slower than using store graphics, as 
detailed below. 

Uses 

• When the geometry is known, as the input of As-Built 
alignments. 

17-8
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• When the user wants to give exact bearings and 
distances. 

Store Graphics 
The store Graphics procedure is the simplest and quickest 
method to create a horizontal alignment.  The user can use 
standard Microstation draw utilities to layout the alignment 
then use the Store Graphics tool to store the alignment into 
COGO.  Even though Microstation measurements are to single 
precision, GEOPAK stored elements are computed to double 
precision accuracy.  Store Graphics will make slight 
adjustments to the graphical element locations as required 
forcing each element in the chain to be exactly tangent to the 
immediately preceding element and the immediately following 
element.  These adjustments are always minor (e.g. the 
coordinates of a curve’s PC and/or PT may be adjusted a few 
millimeters to force the curve to match the tangents exactly) 
but they do occur and the user has no control over them.  
However, if the graphical elements were drawn correctly then 
the chain that gets stored into the gpk file is exactly as 
“accurate” as a chain stored using any of the other methods. 

This command cannot be accessed using Project Manager, but 
can be accessed the following two ways.  From the GEOPAK 
pull down menus select, Applications>GEOPAK 
ROAD>Geometry>Store Graphics 

 

Figure 17-14:  Accessing Store Graphics 

17-9
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Or by selecting the icons from the Geopak Road tool box as 
shown below: 

 

 

Figure 17-15:  Store Graphics Icon 

Selecting the Store Graphics Icon will invoke the Store 
Graphics Dialog box.  You can store the elements as Complex 
Chain, Selection Set or Single Element. 

 

Figure 17-16:  Store Graphics 

Advantages 

• Use simple Microstation commands to layout 
alignment, adjustments to alignment are quick, and 
the only point numbers used are on the alignment 
(usually just the first and last). 

Disadvantages 

• Not as accurate as COGO.  Store Graphics makes minor 
adjustments to the as-drawn elements in order to get 
them to tie together mathematically. 

• Cannot draw spirals using Microstation commands.  If 
spirals are needed, you must use Horizontal Alignment 
Generator to create that element, and then you may 
continue using Microstation commands.  

17-10
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Uses 

• For long alignments with many elements.   

 

Horizontal Design – Geopak 2004 
In GEOPAK 2004 there have not been many enhancements to 
the workings of the existing coordinate geometry tools.  The 
main COGO dialog box has been enhanced to include utilities 
for each type of COGO element such as points, lines, curves, 
chains, etc.  The utility dialog box will allow the user to 
functions such as visualize, print, transpose, etc., for each 
element type.  This allows the user to more efficiently work 
with each type of element independently.  The new COGO 
dialog box, along with some of the utility dialog boxes is 
shown below. 

 

 

Figure 17-17: New COGO Tools 

Vertical Design 

There are two tools used to set proposed vertical alignments, 
and both are acceptable to EFLHD.  Engineers and designers 
have used the the VPI based Vertical Alignment Generator 
since the early days of GEOPAK.  This tool, although having 
been around for years is still a user-friendly, accurate method 
for creating and storing vertical alignments.  The second 
method is the Component Based Vertical Alignment 
Generator.  This tool has been updated and improved over 
the VPI based tool, and has yet to be fully utilized by most 17-11
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GEOPAK users.  Both these methods are just as accurate and 
depending on your preference, as easy to use.    There are 
two methods available for creating and storing an Existing 
Ground profile; Traditional method and a the new Draw 
Profile Tool method. 

Existing Ground Profile 
Once a run is created for the working alignment, the existing 
ground profile should be cut and drawn using the D & C 
Manager.  EFLHD’s traditional method for cutting existing 
ground profile is shown below.  Existing Ground Profile can be 
accessed using Project Manager by selecting the Existing 
Ground Profile button. 

 

Figure 17-18:  Accessing Existing Ground Profile 
through Project Manager 

The Existing Ground Profile dialog can also be accessed by 
typing in mdl load ex_prof command in the Microstation 
Key-in box. 

 

Figure 17-19:  Microstation Key-in 

The following Existing Ground Profile dialog box will appear. 

17-12
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Figure 17-20:  Traditional Existing Ground Profile  

Enter in the required information and select Apply.  Apply will 
cut your existing ground profile for the chain and store it into 
the GPK file.  Existing ground profile can be accessed and 
drawn into MicroStation using the Geopak D & C Manager, 
with the EFLHD .ddb file.  This will assure that the existing 
ground profile is placed with the correct symbology. 

Draw Profile Tool - GEOPAK 2004 
New to GEOPAK 2004 is a streamlined way to create existing 
ground profiles, and plot both existing and proposed profiles.  
The Draw Profiles tool is not available through project 
manager, but can be accessed by selecting 
Applications>GEOPAK ROAD>Plans Preparation>Draw 
Profiles, as shown below. 

17-13
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Figure 17-21: Select Draw Profiles 

The Draw Profiles tool may also be accessed from the Plans 
Preparation tool palette as shown below. 

 

Figure 17-22: Draw Profile Icon 

 
All that is needed for this tool is a horizontal alignment and a 
.tin file.  This tool allows for the creation of an existing 
ground profile in much the same way as the Traditional 
method, but does so behind the scenes, with increased 
efficiency and a much cleaner workflow.  This tool also allows 
the user to draw profiles into MicroStation using the D&C 
Manager .ddb settings ensuring adherence to the CADD 
standards.  Also, with the Draw Profiles tool, there is no need 
to delete before re-drawing updated profiles. 

17-14
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Workflow 1:  Creating an existing ground profile using 
Draw Profiles Tool 

1. Select the Draw Profiles tool using one of the 
methods described above. 

  

Figure 17-23: Draw Profile Dialog Box 

 
2. Select the job number where the chain is stored 

and the associated chain. 

3. Select the Dialog Profile Cell Control icon located 
to the right of the job number.  The following 
dialog box will appear. 

 

Figure 17-24: Profile Cell Control 
17-15
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4. Select the Place Profile Cell icon on the top right 

side of this dialog. 

5. Once selected the following dialog box is 
activated allowing the user to set the station and 
elevation for the origin of the profile, set the 
horizontal and vertical scale, and set the top and 
bottom ranges for the cell.  Elevation and Cell 
Range should match the range of Z value for your 
project.   Notice how similar this dialog looks to 
the D&C Manager dialog for placing a profile cell. 

 

 

Figure 17-25: Place Profile Cell 

 
6. Once this dialog box has been populated, the user 

may place the cell where desired.  The Profile Cell 
Control dialog box will now be populated. 

 

Figure 17-26: Profile Cell Control 

 
7. Dismiss the Profile Cell Control dialog box and 

return to the Draw Profile dialog.  Notice that 
before placing the profile cell everything below 
the chain name on this dialog box was grayed 
out. 

8. This dialog box is now active and the user is now 
able to populate the Surfaces and COGO tabs. 

 17-16
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Figure 17-27: Draw Profile Method 

9. Begin by selecting the correct .tin file. 

10. Once the .tin file is selected the user must 
now decide how to cut the existing ground 
profile.  The options shown above; Triangles, 
Break Lines, POT, Increment, and Even, are the 
same options allowed in the original Ground 
Profile tool.  Select the Triangles option. 

11. Next the user must tell GEOPAK how to 
draw the profile with the correct symbology.  
Previously, the user would use the D&C Manager 
exclusively to accomplish this.  As shown below, 
the Draw Profile tool will use either the D&C 
Manager or allow the user to input symbology. 

 

17-17
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Figure 17-28: Display Settings 

12. Select By feature to access the D&C 
Manager. 

13. Once selected, the paintbrush becomes 
active.  Click on the paintbrush to access the D&C 
Manager.  

17-18
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Figure 17-29: D&C Manager 

14. Select the correct element, shown above as 
CHAINS/PROFILES>CFL/EFL>EXPROF Existing 
ground profile Profile. 

15. Select the OK button in the upper right 
hand corner of the dialog box. 

17-19
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Figure 17-30: Add Surface 

 
16. Once the above dialog box has been 

populated with the correct .tin file, the Method, 
and the symbology, Select the Add Surface 
Settings icon, circled above. 

17. Selecting the Add Surface Settings icon will 
populate the surface into the dialog box and 
instantly draw the profile onto the previously 
drawn profile cell. 

 

17-20
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Figure 17-31: Store Surface in COGO 

 

So far this workflow has allowed us to create the existing 
ground profile and draw it into MicroStation with the correct 
symbology.  In the continuation of this workflow, we will store 
the profile into COGO and plot more information such as 
elevation and station labels, along with anything else that 
was previously available to be plotted from the D&C Manager. 

18. To Store this profile into COGO, select the 
Store Surface in Cogo icon, as shown above. 

17-21
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Figure 17-32: Store Profile 

19. Populate the Profile Name box with the 
desired name.  Check the box labeled Store 
Profile in GPK. 

20. Select Apply. 

21. The profile is now stored in the GPK. 

22. Dismiss the Store Profile dialog box and 
return to the Draw Profile dialog box. 

23. Select the COGO tab and from the Profile 
Name box, select the correct profile. 

 

Figure 17-33: Draw Profile Dialog Box 
17-22
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24. Under the options section, located in the 
bottom quarter of the dialog box, select General. 

 

 

Figure 17-34: Profile Options 

 
25. This allows the user to select the Axis 

labels and the Strip Grade Increment, if desired.  
The additional options are shown below. 

 

 
 

 

Figure 17-35: Profile Options 

 
26. From the options shown above the user has 

the same flexibility in drawing the profile into 
MicroStation as the D&C Manager.  Once the 
desired options have been selected, click the Add 
Cogo Profile Settings icon, as shown below, and 
the profile will be complete.  Multiple profiles can 
be drawn using the COGO tab. 

 

17-23
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Figure 17-36: Profile Drawn Into MicroStation 

The projection tab can be used when the chain and profile 
that needs to be drawn is different than the chain and profile 
used to create the profile cell. 

 

Figure 17-37: Profile Projection Tab 
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Proposed Vertical Alignment 
The VPI based Vertical Alignment Generator is the traditional 
method used by EFL designers in creating vertical alignments.  
Vertical alignment generator can be accessed through Project 
Manager by selecting the Vertical Alignment button. 

 

Figure 17-38: Accessing Vertical Alignment through 
Project Manager 

The VPI Based Vertical Alignment Design Tool may also be 
accessed from the Horizontal & Vertical Geometry tool palette 
as shown below. 

 

Figure 17-39: VPI Based Vertical Alignment  Icon 

 

Selecting the VPI Based Vertical Alignment Design Tool will 
invoke the dialog box below: 

 

 

 

17-25
3/27/2007  



 

STANDARDS FOR USE WITH X30 CRITERIA

EFLHD CADD Standards Manual 
Chapter 17 — Horizontal and Vertical Design 

 

 

 

Figure 17-40: VPI Based Vertical Alignment 
Settings 

Once the settings are defined, selecting OK will invoke the 
GEOPAK Profile Generator.   

 

Figure 17-41: Profile Generator 

For EFL projects, the User Preferences are as shown below:   

 

17-26
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Figure 17-42: User Preferences 

If the project requires the use of Maintaining K value instead 
of Maintain VC Length, commonly used, attach the correct K-
Value table.  K Value Table can be accessed by selecting 
User>K-Values. The following dialog will appear: 

 

Figure 17-43: K-Value Table 

Use File>Open to attach the correct unit K-Value table 
(.kvl).  K-Value table can be attached from 
M:\V8_RESOURCE\X_30\Standards\Bin\ english or metric. 

After the proposed vertical alignment is created and saved, 
use the Draw Profile Tool or the D&C Manager to drawn 
profile in MicroStation, ensuring adherence to the CADD 
standards.  For EFLHD projects, the toggles shown below 
must be selected prior to drawing the profile. 
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Figure 17-44: D & C Manager to Draw Profile 
Draw 

Workflow 2:  Creating Proposed Vertical alignment 
using Component Based Vertical Alignment Design Tool 

The new method to create vertical alignment introduced with     
Geopak 2000 is the Component Based Vertical Alignment 
Design Tool.  This method allows for vertical alignment to be 
created graphically and stored using Store graphics 
command, similar to the horizontal alignment Store Graphics 
command.  The Component Based Vertical Alignment Design 
Tool requires COGO to be active as well as an Active Chain 
and Active Profile Cell.  Component Based Vertical Alignment 
Design Tool requires the use of Active Chain Control, a 
method introduced with Geopak 2000.  Active Chain Control 
can be used in place of the 3 port viewer. 

1. Select the Active Chain Control tool by Selecting 
Application>Geopak Road >Active Chain Control 
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Figure 17-45: Accessing Active Chain 
Control 

 

Or by selecting Active Chain Control button from the 
Geopak Main dialog box.   

 

 

Figure 17-46: Accessing Active Chain Control through 
Road Tools Icon 

 

Selecting the button will invoke the Active Chain 
Control dialog. 
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Figure 17-47: Active Chain Control Dialog 

 

2. Using the Active Chain Control dialog box, 8 
MicroStation view are available to set the 
graphical data for Plan, Profile and Cross Section.   
In the dialog box shown below, View 1 is the plan 
view, View 2 is the profile view and View 3 is the 
cross section view.  To use the Component Based 
Vertical Alignment Tool, assign your profile to a 
view by right clicking on one of the 8 
MicroStation views and selecting the Profile. 

 

Figure 17-48: Assigning Profile View 

3. Select the Component Based Vertical Alignment 
Tool by Selecting Application>Geopak Road 
>Geometry>Layout Profiles (Component 
Based)

 

Figure 17-49: Accessing Component Based Vertical 
Alignment Tool 

 

Or by selecting Component Based Vertical Alignment 
Tool from the Geopak Main dialog box.  Component 
Based Vertical Alignment Tool is not available 
through the Project Manager.  
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Figure 17-50: Accessing Component Based Vertical 
Alignment Tool through Road Tools Icon 

 

4. Once selected the main Component Based 
Vertical Alignment Tool frame is activated as 
shown below.  The tool frame contains tool boxes 
to place vertical alignment lines, manipulate 
vertical alignment elements, place vertical 
alignment curves and profile tools.  

 

Figure 17-51: Component Based Vertical Alignment 
Tool Frame 

5. From the main Component Based Vertical 
Alignment Tool frame shown above, following 
additional tools can be accessed from each of the 
four main tool boxes.  

 

Figure 17-52: Component Based Vertical Alignment 
Tools 

6. Prior to using the Component Based Vertical 
Alignment Tools to draw, select the Dialog 
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Graphical Profile Preference icon as shown 
below. 

 

Figure 17-53: Dialog Graphical Profile Preferences 

7. Set the Element Symbology for the Line and 
Curve.  Setting the element symbology will allow 
for easier viewing when designing the vertical 
alignment using the Component Based Vertical 
Alignment Tools. 

 

Figure 17-54: Graphical Profile Preferences 

8. Use the Component Based Vertical Alignment 
Tools to graphically draw the vertical alignment. 

 

 

Figure 17-55: Draw Graphical Profile  

9. Once the vertical alignment is drawn using the 
Component Based Vertical Alignment Tools, 
vertical alignment can be stored.  Select Store 
Vertical Alignment icon from the Profile Tools 
dialog to store the vertical alignment. 
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Figure 17-56: Store Vertical Alignment Icon 

10. Once the Store Vertical Alignment icon is 
selected, the following dialog will activate if the 
COGO dialog is not already activated.  Select OK.  
The Component Based Vertical Alignment Tools 
requires COGO to be active. 

 

Figure 17-57: COGO Activation 

11. Selecting Store Vertical Alignment icon will 
activate the following dialog box.  Input the 
profile name and select the elements to store. 

 

Figure 17-58: Store Vertical Alignment 

The various methods for creating horizontal and vertical 
geometry using GEOPAK are describe in this chapter.  
Regardless of the method used, the final alignment and 
profile must be drawn into MicroStation using the GEOPAK 
D&C Manager, with the EFLHD .ddb file.   

Related links:   Using Knucklehead’s Guide for GEOPAK 
Road 2004 Edition. 

To Create the Horizontal Alignment 

Generate the Existing Ground Profile  

To Create the Vertical Alignment  
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Chapter 18:  Cross Sections 

Overview 

Proposed Cross sections are used to determine the limits of 
construction, earthwork, construction staking reports, and 3D 
modeling.  It is very important that they are drawn 
consistently and to the standards outlined in this chapter.  
Federal Lands Highway (FLH) has developed a new generation 
of criteria files know as the X30 Criteria files.  With the 
development of the X30 criteria, creating the proposed cross 
sections no longer requires the traditional input files and 
exception data files. With X30 criteria files, Proposed Cross 
Sections are created through the Project Manager using the 
Typical Section Generator.  Proper setup and use of the Project 
Manager is crucial in running the Typical Section Generator to 
create the proposed cross sections. All cross section slopes 
are labeled 1V:1H as per the FP03. 

Prior to running Proposed Cross Section the Project Manager 
need to be setup as outlined in Chapter 13 of the Geopak 2004 
- X30 CADD Standards Manual. 

Federal Lands Highway have developed 6 Typical Sections 
for the use of developing proposed cross sections.  The 6 
Typical Sections are Divided New Pavement, Existing 
Features, Existing and Proposed Right of Way, 
Rehabilitation Typical Section (3R), Undivided New 
Pavement and Cross Section Labeling. 

 

Figure 18-1:  FLH Typical Sections 18-1 
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Figure 18-2: Project Manager Dialog 

Once the working alignment has been selected and defined, 
proposed cross sections can be run through the Project 
Manager Dialog.  Follow Workflow 1 below to setup the 
Working alignment Definition.  An example Working Alignment 
called MAIN will be used to outline the Workflows in this 
Chapter.  The Project Manager was setup in Chapter 13, but 
the working alignment definition will be explained in detail in 
Workflow 1. 

Workflow 1: Working Alignment Definition 

1. Select Define button from the Project Manager 
Dialog as shown below. 

 

Figure 18-3:  Define Working Alignment 

2. The Working Alignment Definition Dialog Box for 
the Chain MAIN will appear.  In the Plan View 
category select the proposed design file and select 
the Geopak alignment chain. 
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Figure 18-4: Plan View Definition 

3. In the Pattern category populate the dialog By 
Station or By Design File.  Use named levels 
P_GPK_Pattern_01 to P_GPK_Pattern_10 to place 
pattern lines in a design file.  Horizontal Scale and 
Vertical Scale should be set to 1. 

 

Figure 18-5: Pattern Definition 

4. In the Shapes category populate the dialog By 
Search Criteria.  Search Criteria will process the 
cross sections faster than the All in DGN mode.  
Use named level P_RDW_Super_Shapes to draw 
superelevation shapes in the Shapes dgn file. 
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Figure 18-6: Shapes Definition 

5. In the Profile View and Location category populate 
the dialogs defining your design profile file, 
existing profile and proposed profiles.  Profile 
Location can be populated by selecting the 
Identify Cell button and selecting the profile cell.  
Profile View and Location are not required to be 
populated to run Proposed Cross Sections. 

6. In the Cross Section View category populate the 
dialogs defining your XS DGN file. 

 

Figure 18-7: Cross Section Definition 
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7. In the Existing Ground category populate the 
dialogs defining the parameters of your existing 
ground. 

 

Figure 18-8: Existing Ground Definition 

8. The Proposed Finished Grade and DTM categories 
should be completed, but they are not required to 
be populated to run Proposed Cross Sections. 
Once all the categories in the dialog box are 
completed, Select OK to save and close the 
Working Alignment Definition for the working 
alignment (example: MAIN). 

Once the working alignment definitions are set for a working 
alignment, Proposed Cross Sections can invoked from the 
Project Manager Dialog Box.  The Proposed Cross Section can 
be run for the 6 FLH Typical Sections.  Follow Workflow 1 
below to process the proposed cross sections: 
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Workflow 2: Proposed Cross Sections 

1. Select Proposed Cross Sections button from the Project 
Manager Dialog. 

 

Figure 18-9:  Invoking Proposed Cross Sections 

2. The following dialog will be activated, since no run 
exist for the example Select New to create a Run. 

 

      Figure 18-10:  Create a New Run 

 

3. Create a New Run by entering the run name and 
description and select OK. 
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      Figure 18-11:  New Run 

4. From the Select Run dialog, select the newly 
created run MAIN and select OK. 

 

            Figure 18-12:  Select New Run 

5. Selecting a Run will access the Proposed Cross 
Section Dialog. 

 

 Figure 18-13:  Proposed Cross Sections 
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The Proposed Cross Section run shown in the workflow is for 
an Undivided New Pavement Typical Section.  

 

 

 

The proposed Cross section run holds the same 
information as the old Proposed Cross Section Input File 
and Exception Data File combined.   

6. Select the XS DGN File from the Proposed Cross 
Section dialog.  Note that the dialog box is already 
filled in by the Working Alignment definition. 

 

Figure 18-14:  Selecting XS DGN File 

 

 

 

 

 

The tolerance should always be set to 0.010 for English 
projects and 0.003 for Metric projects.  The tolerance 
setting is very important and the proposed cross section 
will not process without setting this value. 

7. Select the Pattern and toggle on Use Working 
Alignment Definition. 
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Figure 18-15 Selecting Pattern  

8. Select the Existing Ground and toggle on Use 
Working Alignment Definition. 

 

   Figure 18-16 Selecting Existing Ground 

9. Select the Shapes and toggle on Use Working 
Alignment Definition. 
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Figure 18-17:  Selecting Shapes 

The Working Alignment Definition toggle can be used for 
Pattern, Existing Ground and Shapes; these were previously 
defined for the working alignment.   

10. Select Shape Clusters from the Proposed 
Cross Section dialog.  The following dialog box will 
appear.  Select Scan. 

 

Figure 18-18:  Selecting Shape Clusters 
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11. Selecting Scan button will access the List of 
Clusters dialog box.  Select the shape cluster and 
close the dialog box. 

 

 

Figure 18-19:  List of Clusters 

12. Select the add button from the main shape 
cluster dialog box to add the shape cluster to the 
list box as shown. 

 

Figure 18-20:  Add List of Clusters 

13. Once the shape cluster is added to the list 
box, highlight the information in list box shown 
and the Typical button will become active.  Select 
the Typical button to access the Typical Section 
Generator. 

 

Figure 18-21:  Select Typical Section 
18-11 
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14. In the Typical Section Generator, 6 typical 
are available.  Select UNPAVT for undivided new 
pavement.  In the Range window, select Apply to 
Whole Chain.  Apply to Station Range to process 
by station range.  Select Apply. 

 

 

Figure 18-22:  Choose Typical Section 

 

 

 

 

The help files can also be accessed outside the Typical 
Sections Dialog Box.  For Consultants, Help documentations 
are available through the CADD_Resource_v8.zip download 
on EFLHD Website.  Help files (*.wri files) are available in the 
M:\Cadd_resource_v8\X_30\Standards\Bin\ English or Metric 
directory. 

The Help documentations can be found on the EFLHD network 
at: M:\Cadd_resource_v8\X_30\Standards\Bin\English or 
Metric directory. 

Select the Description button in the Typical Section dialog 
box to access the online help for the selected typical 
section.  Online help document provides detailed 
drawings and information on how each of the typicals 
work. 

15. The criteria files associated with the Typical 
Section are populated into the main Proposed 
Cross Section dialog. 
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Figure 18-23:  Populated Shape Cluster 

16. The Define DGN Variables should be left 
blank for Undivided New Pavement Typical.  This 
variable is used only with Automated Cross 
Section Labeling Typical. 

17. Select Define Variables and edit Cross 
Section dgn, Proposed Plan Dgn and Geopak Lines 
Dgn values.  Edit the default value of the variable 
and select Modify to accept. 

 

 

If any of the dgn files are not in the working 
directory, the full path must be specified. 
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Figure 18-24:  Populated Shape Cluster 

18. Select Re-Definable Variables as shown 
below.  Select the Edit button to modify the 
default variables and to set project specific values. 

 

Figure 18-25:  Re-Definable Variables 

19. Select Plot Parameters and toggle off all the 
plot options. 
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Figure 18-26:  Plot options 

20. Select the drainage, this should be left 
blank.  This will not apply to the 6 Typical 
Sections.  Once the run has been modified for the 
working alignment, Select Files >Save Settings to 
save your run. 

 

Figure 18-27:  Save Settings 

21. Select Files >Run to process your proposed 
cross sections. 
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Figure 18-28:  Run Proposed Cross Section 

22. The following Proposed Cross Section Run 
dialog box will appear. Set the To Log File to To 
Screen, if no log file is desired.  Select Apply 
process the Cross Sections. 

   

Figure 18-29:  Process Proposed Cross 
Section 

Cross Section Navigator 

Now that you have completed the cross section run, you will 
want to view them.  The cross section navigator is a tool that 
makes the viewing of cross sections much easier.   Two types 
of Cross Section Navigators can be used to review the cross 
sections.  A new tool for the Geopak 2004 Edition is the Super 
Cross section Navigator which allow you to view your cross 
section based on your profile.  The new tool prevents drifting 
of the cross sections and provides speed controlled cross 
section movie navigation. 

Workflow 3: Cross Section Navigator 

1. Select Applications>GEOPAK ROAD>Cross 
Sections>Navigator, or Select the Cross Section 
Navigator icon from the GEOPAK Road toolbar. 

18-16 
4/5/2007  



 

STANDARDS FOR USE WITH X30 CRITERIA

EFLHD CADD Standards Manual 
Chapter 18 — Cross Sections  

 

Figure 18-30:  Cross Section Navigator Icon 

2. The Cross Section Navigator dialog will appear. 

 

Figure 18-31:  Cross Section Navigator 

3. Navigator will automatically center the first cross 
section found, using the station on the cross 
section cells. 

4. Use the arrows  to move up or 
down station through the cross sections.  You can 
also use the station pull down menu to go to a 
specific cross section. 

Workflow 4: Super Cross Section Navigator 

5. Select Applications>GEOPAK ROAD>Design & 
Computation Manager, or Select the Design & 
Computation Manager icon from the GEOPAK Road 
toolbar. 

 

Figure 18-32:  Design & Computation       
Manager Icon 

6. In Design and Computation Manager dialog box, 
select MVBA Applications>Super Cross Section 
Navigator.  Double Click on Super Cross Section 
Navigator.  The following dialog box will appear. 
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Figure 18-33:  Super Cross Section Navigator 

Related links:   Setting up the Proposed Cross Section run for 
the 5 typical sections available through the Typical Section 
Generator, using Knucklehead’s Guide for GEOPAK Road 2004 
Edition. 

 Existing Features

 Right of Way

 Rehabilitation (3R)

 Undivided New Construction

 Automated Cross Section Labeling
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Figure 18-2: Project Manager Dialog 

Once the working alignment has been selected and defined, 
proposed cross sections can be run through the Project 
Manager Dialog.  Follow Workflow 1 below to setup the 
Working alignment Definition.  An example Working Alignment 
called MAIN will be used to outline the Workflows in this 
Chapter.  The Project Manager was setup in Chapter 13, but 
the working alignment definition will be explained in detail in 
Workflow 1. 

Workflow 1: Working Alignment Definition 

1. Select Define button from the Project Manager 
Dialog as shown below. 

 

Figure 18-3:  Define Working Alignment 

2. The Working Alignment Definition Dialog Box for 
the Chain MAIN will appear.  In the Plan View 
category select the proposed design file and select 
the Geopak alignment chain. 
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Figure 18-4: Plan View Definition 

3. In the Pattern category populate the dialog By 
Station or By Design File.  Use named levels 
P_GPK_Pattern_01 to P_GPK_Pattern_10 to place 
pattern lines in a design file.  Horizontal Scale and 
Vertical Scale should be set to 1. 

 

Figure 18-5: Pattern Definition 

4. In the Shapes category populate the dialog By 
Search Criteria.  Search Criteria will process the 
cross sections faster than the All in DGN mode.  
Use named level P_RDW_Super_Shapes to draw 
superelevation shapes in the Shapes dgn file. 
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Figure 18-6: Shapes Definition 

5. In the Profile View and Location category populate 
the dialogs defining your design profile file, 
existing profile and proposed profiles.  Profile 
Location can be populated by selecting the 
Identify Cell button and selecting the profile cell.  
Profile View and Location are not required to be 
populated to run Proposed Cross Sections. 

6. In the Cross Section View category populate the 
dialogs defining your XS DGN file. 

 

Figure 18-7: Cross Section Definition 
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7. In the Existing Ground category populate the 
dialogs defining the parameters of your existing 
ground. 

 

Figure 18-8: Existing Ground Definition 

8. The Proposed Finished Grade and DTM categories 
should be completed, but they are not required to 
be populated to run Proposed Cross Sections. 
Once all the categories in the dialog box are 
completed, Select OK to save and close the 
Working Alignment Definition for the working 
alignment (example: MAIN). 

Once the working alignment definitions are set for a working 
alignment, Proposed Cross Sections can invoked from the 
Project Manager Dialog Box.  The Proposed Cross Section can 
be run for the 6 FLH Typical Sections.  Follow Workflow 1 
below to process the proposed cross sections: 
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Workflow 2: Proposed Cross Sections 

1. Select Proposed Cross Sections button from the Project 
Manager Dialog. 

 

Figure 18-9:  Invoking Proposed Cross Sections 

2. The following dialog will be activated, since no run 
exist for the example Select New to create a Run. 

 

      Figure 18-10:  Create a New Run 

 

3. Create a New Run by entering the run name and 
description and select OK. 
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      Figure 18-11:  New Run 

4. From the Select Run dialog, select the newly 
created run MAIN and select OK. 

 

            Figure 18-12:  Select New Run 

5. Selecting a Run will access the Proposed Cross 
Section Dialog. 

 

 Figure 18-13:  Proposed Cross Sections 
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The Proposed Cross Section run shown in the workflow is for 
an Undivided New Pavement Typical Section.  

 

 

 

The proposed Cross section run holds the same 
information as the old Proposed Cross Section Input File 
and Exception Data File combined.   

6. Select the XS DGN File from the Proposed Cross 
Section dialog.  Note that the dialog box is already 
filled in by the Working Alignment definition. 

 

Figure 18-14:  Selecting XS DGN File 

 

 

 

 

 

The tolerance should always be set to 0.010 for English 
projects and 0.003 for Metric projects.  The tolerance 
setting is very important and the proposed cross section 
will not process without setting this value. 

7. Select the Pattern and toggle on Use Working 
Alignment Definition. 
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Figure 18-15 Selecting Pattern  

8. Select the Existing Ground and toggle on Use 
Working Alignment Definition. 

 

   Figure 18-16 Selecting Existing Ground 

9. Select the Shapes and toggle on Use Working 
Alignment Definition. 
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Figure 18-17:  Selecting Shapes 

The Working Alignment Definition toggle can be used for 
Pattern, Existing Ground and Shapes; these were previously 
defined for the working alignment.   

10. Select Shape Clusters from the Proposed 
Cross Section dialog.  The following dialog box will 
appear.  Select Scan. 

 

Figure 18-18:  Selecting Shape Clusters 
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11. Selecting Scan button will access the List of 
Clusters dialog box.  Select the shape cluster and 
close the dialog box. 

 

 

Figure 18-19:  List of Clusters 

12. Select the add button from the main shape 
cluster dialog box to add the shape cluster to the 
list box as shown. 

 

Figure 18-20:  Add List of Clusters 

13. Once the shape cluster is added to the list 
box, highlight the information in list box shown 
and the Typical button will become active.  Select 
the Typical button to access the Typical Section 
Generator. 

 

Figure 18-21:  Select Typical Section 
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14. In the Typical Section Generator, 6 typical 
are available.  Select UNPAVT for undivided new 
pavement.  In the Range window, select Apply to 
Whole Chain.  Apply to Station Range to process 
by station range.  Select Apply. 

 

 

Figure 18-22:  Choose Typical Section 

 

 

 

 

The help files can also be accessed outside the Typical 
Sections Dialog Box.  For Consultants, Help documentations 
are available through the CADD_Resource_v8.zip download 
on EFLHD Website.  Help files (*.wri files) are available in the 
M:\Cadd_resource_v8\X_30\Standards\Bin\ English or Metric 
directory. 

The Help documentations can be found on the EFLHD network 
at: M:\Cadd_resource_v8\X_30\Standards\Bin\English or 
Metric directory. 

Select the Description button in the Typical Section dialog 
box to access the online help for the selected typical 
section.  Online help document provides detailed 
drawings and information on how each of the typicals 
work. 

15. The criteria files associated with the Typical 
Section are populated into the main Proposed 
Cross Section dialog. 
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Figure 18-23:  Populated Shape Cluster 

16. The Define DGN Variables should be left 
blank for Undivided New Pavement Typical.  This 
variable is used only with Automated Cross 
Section Labeling Typical. 

17. Select Define Variables and edit Cross 
Section dgn, Proposed Plan Dgn and Geopak Lines 
Dgn values.  Edit the default value of the variable 
and select Modify to accept. 

 

 

If any of the dgn files are not in the working 
directory, the full path must be specified. 
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Figure 18-24:  Populated Shape Cluster 

18. Select Re-Definable Variables as shown 
below.  Select the Edit button to modify the 
default variables and to set project specific values. 

 

Figure 18-25:  Re-Definable Variables 

19. Select Plot Parameters and toggle off all the 
plot options. 
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Figure 18-26:  Plot options 

20. Select the drainage, this should be left 
blank.  This will not apply to the 6 Typical 
Sections.  Once the run has been modified for the 
working alignment, Select Files >Save Settings to 
save your run. 

 

Figure 18-27:  Save Settings 

21. Select Files >Run to process your proposed 
cross sections. 
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Figure 18-28:  Run Proposed Cross Section 

22. The following Proposed Cross Section Run 
dialog box will appear. Set the To Log File  to To 
Screen, if no log file is desired.  Select Apply 
process the Cross Sections. 

   

Figure 18-29:  Process Proposed Cross 
Section 

Cross Section Navigator 

Now that you have completed the cross section run, you will 
want to view them.  The cross section navigator is a tool that 
makes the viewing of cross sections much easier.   Two types 
of Cross Section Navigators can be used to review the cross 
sections.  A new tool for the Geopak 2004 Edition is the Super 
Cross section Navigator which allow you to view your cross 
section based on your profile.  The new tool prevents drifting 
of the cross sections and provides speed controlled cross 
section movie navigation. 

Workflow 3: Cross Section Navigator 

1. Select Applications>GEOPAK ROAD>Cross 
Sections>Navigator, or Select the Cross Section 
Navigator icon from the GEOPAK Road toolbar. 
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Figure 18-30:  Cross Section Navigator Icon 

2. The Cross Section Navigator dialog will appear. 

 

Figure 18-31:  Cross Section Navigator 

3. Navigator will automatically center the first cross 
section found, using the station on the cross 
section cells. 

4. Use the arrows  to move up or 
down station through the cross sections.  You can 
also use the station pull down menu to go to a 
specific cross section. 

Workflow 4: Super Cross Section Navigator 

5. Select Applications>GEOPAK ROAD>Design & 
Computation Manager, or Select the Design & 
Computation Manager icon from the GEOPAK Road 
toolbar. 

 

Figure 18-32:  Design & Computation       
Manager Icon 

6. In Design and Computation Manager dialog box, 
select MVBA Applications>Super Cross Section 
Navigator.  Double Click on Super Cross Section 
Navigator.  The following dialog box will appear. 
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Figure 18-33:  Super Cross Section Navigator 

Related links:   Setting up the Proposed Cross Section run for 
the 5 typical sections available through the Typical Section 
Generator, using Knucklehead’s Guide for GEOPAK Road 2004 
Edition. 

 Existing Features

 Right of Way

 Rehabilitation (3R)

 Undivided New Construction

 Automated Cross Section Labeling
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Chapter 19:  Plan & Profile Sheet Clipping 

Overview 

This chapter will describe the methods used to create plan and 
profile sheets.  The following workflows will show the user how 
to set up sheets using GEOPAK Plan and Profile Sheet 
Composition tool.  This application has evolved over the years, 
allowing for profile stair stepping, ability to automatically clip 
the graphics with notches (Title block, project information, 
etc.,), and customized sheet numbering and station 
adjustment on sheets.    

 

Note:  CFLHD policy is to create one sheet 
per file.  This will allow the use of plan an
profile labelers when detailing the sheet

d 
s.   

Note:  EFLHD policy is to create all sheet per 
file with rotate view only.  This will use 
models for all the sheets in one design file 
and also allow the use of plan and profile 
labelers when detailing the sheets.    

 

Plan/profile sheet creation 

GEOPAK will create separate plan and Profile, double plans and 
plan/profile sheets.  These sheets are generally created at   
20, 40, 50, and 100 scale English (ft/in).   Workflow 1 will 
describe the steps necessary to create a plan/profile sheet.  
Station range, drawing areas, and many other variables are 
contained in the sheet library files eflhd_Eng_sheets.psl.  
The sheet library file contains many values specific to EFLHD 
such as cell library names and locations, specific sheet cells to 
be used, drawing scales, and a variety of text parameters and 
cannot be modified by the user.  

The sheet library files for EFLHD projects are located on the 
EFLHD network at:  
M:\Cadd_resource_v8\Plan&Profile_Shts\ 
 
  

For EFLHD employees, the unit correct .psl file will 
be automatically attached while opening a design 
file using the Project Configuration (*.pcf). 

 
 
For consultants, EFLHD sheet library files are available through 
the Cadd_resource_v8.zip download.  Download the file and 
extract the file to the server or local drive, keep the 
Cadd_resource_v8 directory structure intact.  The unit correct 
.psl file will be attached when opening a design file using the 
project configuration file. 
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Clip Sheets and Motif Files 

Prior to using the GEOPAK Plan and Profile Sheet Composition 
tool, three files need to be created.  Clip.dgn, 
Plan_motif.dgn and Profile_motif.dgn should be created to 
assure proper setup of plan and profile sheets.  Outlined below 
are the uses and instructions for creating each file. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Clip.dgn Creating a drawing to display the sheet boundaries will allow the user to 

always have a visual representation of how each sheet will layout in 
relation to the others.  If the design changes, having this file will allow 
the user to move sheets around to better fit any design changes.  To 
create this sheet, create new design file and select the seed file 
“Sur_ft2D.dgn” and reference the horizontal alignment design file 
and profile design file into this new file.  By referencing the overall 
design back into the Clip.dgn file, any future design changes will be 
displayed in this new file, instantly showing the designer which sheets, if 
any, will need to be adjusted.   

    
 
Motif files Motif files act as seed files for clipping plan and profile sheets.  Motif file 

should be a blank file with the proper reference files attached, and the 
proper levels for each file turned on or off.  The Plan and Profile Sheet 
Composition tool will then use these files when clipping each sheet 
and each clip sheet will have the correct files displayed with the correct 
levels on.  For example, if the plan view in a final plan sheet needs to 
show overall design, mapping, raster images, ROW, etc., with specific 
levels on or off for each of these files, you would only need to setup this 
combination once in the motif file.  This information would then be used 
to create each sheet. These sheets should be named Plan_motif.dgn 
and Profile_motif.dgn.  To create Plan_motif.dgn, create new design 
file and select the seed file “Sur_ft2D.dgn”and attach each reference 
file that should be shown in the plan view, and turn on or off any levels 
to make the display look exactly like the final plan sheets in plan view.  
Repeat these steps for the Profile_motif.dgn, referencing the profile 
sheet into the motif file. 
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Workflow 1: Plan/Profile sheets using GEOPAK 

1. Open the Clip.dgn and invoke Plan and Profile Sheet 
Composition tool from Project Manager by selecting 
the button for Plan & Profile Sheets.  Select a Run or 
create a new Run.  

 

                    Figure 19-1:  Project Manager 

 

 

The example below is focused on clipping an English 
project using 100 Scale Plan/Profile sheets. 

 

2. The following Plan Sheet Layout dialog box appears. 
Select 100 Scale Plan/Profile using the drop down 
arrow, and adjust the Scale field to 100 ft/in as 
shown below:  

 

Figure 19-2:  Plan Sheet Layout Dialog 
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3. From the pulldowns, select Settings > Sheet Layout 
and adjust the Sheet Layout Settings as shown below 
and press OK: 

 

 

Figure 19-3:  Sheet Layout Settings 

 

4. Invoke the Sheet Composition dialog by clicking on 
the Sheet Composition icon from the Plan Sheet 
Layout dialog as shown below: 

     Figure 19-4:  Plan Sheet Layout Dialog 

 

5. Modify the Sheet Composition dialog box as shown 
below:    
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             Figure 19-5:  Sheet Composition 

 

The dialog shown is settings for a 100 Scale PLAN/PROFILE  
"sheet style".  Other "sheet styles" have been created for 
English and Metric projects. The settings can be found at the 
end of this documentation... To go directly there, click HERE.

6. Invoke the Layout Sheets tools by selecting the 
Layout Sheets icon from the Plan Sheet Layout dialog 
as shown below: 

        

  Figure 19-6:  Plan Sheet Layout Dialog 

 

 

       Figure 19-7:  Layout Settings 
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7. Select Multiple Sheets from the dialog box and Select 
the GPK file by keying it into the “Job:” box, or by 
browsing using the file open icon. 

 

8. To populate the Plan Port Data dialog box, double 
click anywhere along the row for Port 1 in the Layout 
Settings dialog box and the following dialog box will 
be invoked. 

 

  Figure 19-8:  Plan Port Data 

9. Select the correct Chain and the appropriate Plan 
Motif file.  Press OK.   If the Motif File has not been 
created, create Motif files using the second icon as 
shown below: 

 

 

Figure 19-9:  Plan Port Data - Create Motif File 

 

Motif file should be created from a “Sur_ft2D.dgn” seed file. 
After creating the Motif file, make sure to attach the required 
reference files. 

 

10. To populate the Profile Port Data dialog box, 
double click anywhere along the row for Port 2 in the 
Layout Settings dialog box and the following dialog 
box will be invoked. 
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Figure 19-10:  Profile Layout 

11. If a profile cell exist for the file that is referenced 
to the Clip.dgn file then click on Identify cell, place 
data point on the profile cell and accept.  Profile Data 
dialog fields can be populated using this method, or 
manually enter in the required information. 

 

12. Select the appropriate Profile Motif file.  Press OK.   
If the Motif file has not been created, create Motif 
files using a “Sur_ft2D.dgn” seed file as outlined in 
step 9. 

 

13. GEOPAK will calculate the number of sheets to 
layout, number of sheets calculated will be placed on 
the button at the bottom right of the Layout Settings 
dialog box.  The extend distance filed will allow the 
user to enter a value that will shift the clipping 
shapes backwards or forwards a given distance.  If 
the number of sheets is acceptable, press the Layout 
8 Sheets button and GEOPAK will draw clipping 
shapes into the drawing. 
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Figure 19-11:  Layout Settings 

 

In order for the data to be clipped correctly, use the Sheet 
Layout Modify Tools.  Two most common types of modification 
supported are sliding the sheets and modifying the drawing 
area.  The drawing area cannot be increased in Length 
(Horizontal) or Height (Vertical) to exceed the Drawing Area 
setup in the sheet library. 

 

14. Once the clipping shapes are placed, for extremely 
curved chains and steep vertical curves it may be 
necessary to modify the clipping shapes.  To invoke 
the Modify tools, use the Modify Sheets icon, from 
the Plan Sheet Layout dialog, as shown below: 

 

 

     Figure 19-12:  Plan Sheet Layout Dialog 
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        Figure 19-13:  Modify Sheet Layout-Plan 

 

15. Identify the Sheet (Clipping Shape) to be modified 
by clicking on the ID button and then data pointing 
the clipping shape or simply select it from the pick 
list, via the down arrow.   

 

 

      Figure 19-14:  Modify Sheet Layout-Profile 

 

STANDARDS FOR USE WITH X30 CRITERIA 

 NOTE: The application is intelligent enough to know 
whether a Plan clipping shape or Profile clipping shape has been 
identified. When a Profile clipping shape is identified, the "Sheet 
Chord Offset" field changes to "Bottom Elevation", (as shown 
above). When modifying the vertical position of a Profile clipping 
shape, toggle "Bottom Elevation" ON, type in the desired "bottom of 
the shape" elevation, or press Dynamic and move the shape up or 
down. 
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16. Use the Sheet Number Manager tool to number 
sheet to EFL standards.  To invoke the Sheet Number 
Manager tool, use the Sheet Number Manager icon, 
from the Plan Sheet Layout dialog, as shown below: 

 

       

Figure 19-15:  Plan Sheet Layout Dialog 

 

 

     Figure 19-16:  Sheet Number Manager 

 

17. Click inside the white area anywhere on row one, 
hold down the shift key and click a second time 
anywhere on the last row.  Once all rows are 
selected, click on Edit Sheet Number as shown above. 

 

18. For EFL specific sheet numbering scheme where 
the sheets are numbered in sequence beginning with 
D1, complete the Edit Sheet Number dialog as shown 
below and press OK: 

 

19-10 
3/27/2007 

STANDARDS FOR USE WITH X30 CRITERIA 



 

 
 

EFLHD CADD Standards Manual 
Chapter 19 — Plan & Profile Sheet Clipping 

 

Figure 19-17:  Edit Sheet Number  

 

19. When OK is pressed the Sheet Number Manager 
dialog will appears as shown below: 

 

                     Figure 19-18:  Sheet Number Manager 

 

20. Once the clipping shapes are placed and 
satisfactorily modified, invoke the Clip Sheets tool, 
Select the Clip Sheets icon from the Plan Sheet 
Layout dialog as shown below: 

 

Figure 19-19:  Plan Sheet Layout Dialog 
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Figure 19-20:  Clip Sheets 

 

21. Select the working directory in the Output File 
box.  Keep the sheet name prefix in the second field 
as blank, change the design file name latter after 
process.  

 

 

NOTE: The software appends the beginning sheet 
number to the "Sheet Name ". You most likely will 
have to rename this (or these) file(s) later . 

 

22. Select Orientation to Rotate View.  The sheet cell 
and the view are rotated and the clipped graphics 
maintains it’s coordinate grid intelligence, thus  

allowing for labeling right on the sheet. 

 

NOTE:  EFLHD policy to choose Rotate View, thus 
not to loose coordinate grid intelligence of the clipped 
graphics. 

 

23. Select Sheet per File to total number of sheets, 
thus sheet will be drawn in different models of the 

19-12 
3/27/2007 

STANDARDS FOR USE WITH X30 CRITERIA 



 

 
 

EFLHD CADD Standards Manual 
Chapter 19 — Plan & Profile Sheet Clipping 

design file. EFLHD prefer to use all sheet shown in 
different models of one design file.    

 

24. Select the Sheet Range required from the pick list, 
using the drop down arrows.  Use the Sheet Number 
Manager Tool to renumber sheets to EFL specific 
sheet numbering scheme, (such as D1, D2, D3….) as 
explained earlier.   

 

25. Enter Labels and Annotation.  An example of a 
completed Clip Sheets dialog is shown below 
(illustrating the results of the completed Labels and 
Annotation fields)… when completed press Process 
Sheets. 

                                   

 

                              Figure 19-21:  Clip Sheets  

Note: Keep 9 space between SE(Region) and PR(state), and 
11 space between PR(state) and ERFO-RRP 10(2)[Project 
Number] 
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EFLHD Sheet Composition Dialog Settings:  

ENGLISH Sheet Styles:  

                              Table 19-1:  English Sheet Styles 

Sheet Style Scale 

(ft/in) 

Station 

Range 

Horizontal Overlap 

(if using overlap 

option) 

100 Plan/Profile 100 1400 25 Multiple of 25 

50 Plan/Profile 50 700 12.5 Multiple of 12.5 

40 Plan/Profile 40 550 15 Multiple of 10 

20 Plan/Profile 20 280 15 Multiple of 5 

100 Double Plan 100 1400 25  

50 Double Plan 50 700 12.5  

40 Double Plan 40 550 15  

20 Double Plan 20 280 15  

100 Separate 

Plan/Profile 

100 1400 25 Multiple of 25 

50 Separate 

Plan/Profile

50 700 12.5 Multiple of 12.5 

40 Separate 

Plan/Profile

40 550 15 Multiple of 10 

20 Separate 

Plan/Profile

20 280 15 Multiple of 5 

10 Separate 

Plan/Profile

10 140 5 Multiple of 5 
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METRIC Sheet Styles:  

                              Table 19-2:  Metric Sheet Styles 

Sheet Style Scale 

(n:1) 

Station 

Range 

Horizontal 

Overlap 

 

1000 Plan/Profile 1000 350 10  

500 Plan/Profile 50 700 12.5  

400 Plan/Profile 40 550 15  

300 Plan/Profile 20 280 15  

100 Plan/Profile 100 1400 25  

500 Double Plan 50 700 12.5  

400 Double Plan 40 550 15  

300 Double Plan 20 280 15  

100 Double Plan 100 1400 25  

1000 Separate 

Plan/Profile

50 700 12.5  

500 Separate 

Plan/Profile

40 550 15  

400 Separate 

Plan/Profile

20 280 15  

300 Separate 

Plan/Profile

10 140 5  

100 Separate 

Plan/Profile

10 140 5  
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Chapter 20:  Quantities 

Overview 

Quantities are calculated by many different methods.  The 
type of quantity, its unit of measurement, and how it is shown 
in the plans will dictate the method used to calculate it.  Since 
this is a CADD manual, this chapter will go through the 
procedures used to calculate quantities using plan and cross 
section drawings.  A detailed description of each item to be 
calculated, the means of calculation, and the accuracy needed 
is reserved for another publication. 

 

 

 

These methods will only work if you use D&C 
Manager to draw or set the symbology of the 
elements you need to quantify. 

 

This chapter is broken into two sections.  Calculations in plan 
view and calculations in cross sections.  D & C Manager will be 
used to calculate items in the plan drawing and XS Reports will 
be used to calculate items in the cross section drawing. 

 

Quantities in Plan Drawings 

Three different types of quantities can be calculated in the 
plan drawing: each, linear, and area.  All of these will be 
calculated using the computation tool in Design & Computation 
manager.  Most of the items that need to be calculated are set 
up in EFLHD’s Design & Computation Manager database.  So, if 
you followed these standards while drawing each element, 
quantity calculations will be easy. See the chapter on D&C 
Manager for more information on drawing elements. 

The D&C manager can be selected by picking Plan View 
Quantities on Project Manager, or by selecting Design and 
Computation Manager icon on the GEOPAK Main menu. 

 

Figure 20-1:  D&C Manager Icon 
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If you use Project Manager, GEOPAK will automatically set 
Design & Computation Manager in Compute mode.  If you 
select Design & Computation Manager from the GEOPAK Main 
menu, you will need to shift it to Computation mode by picking 
the Compute button in the menu bar. 

 

Figure 20-2:  Compute Icon 

This will pop up the following two dialog boxes. 

 

Figure 20-3:  Select Item for Computation 

 

Figure 20-4:  Compute Dialog 
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The first dialog box will allow you to select the items to be 
calculated.  The second dialog box sets up the parameters for 
calculating and reporting the quantities.  The following 
workflows will explain the processes for calculating quantities 
in each of the three types: each, linear, and area. 

Examples of quantities to be calculated in units of each are, 
manholes, trees, lights, survey monuments, etc.  The following 
workflow will guide you through the calculation process.  

Workflow 1: Calculating “By Each” Quantities 

1. Select item or items that you want calculated 
using the D & C Manager item list.  Double-clicking 
on the item to be calculated will populate 
collection box at the bottom. 

 

Figure 20-5:  Item Selection 

2. Make sure the Job Number and Chain Name are 
correct.  Set the Extents to View, Fence, or Active 
Design File.  Pick Compute Quantities. 

 

Figure 20-6: Compute Dialog 

3. This will bring up the following dialog box: 
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Figure 20-7: Computation Results Dialog 

4. To get an itemized calculation (Station and Offset 
to each item), change the Export Format from 
Item Report to Comp Book, then give it an output 
file name to look like the following: 

 

Figure 20-8: Computation Results Dialog for Comp Book 

5. Pick Export.  The following report will be created: 

 

Figure 20-9: Output 

Examples of linear quantity calculations are fence, gutter, 
guardrail, etc.  The following Workflow will guide you through 
the calculation process. 

Workflow 2: Calculating “Linear” Quantities 

1. Select item or items that you want calculated 
using the D & C Manager item list. 
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Figure 20-10: Multiple Item Selection 

2. Make sure the Job Number and Chain Name are 
correct.  Set the Extents to View, Fence, or Active 
Design File.  Pick Compute Quantities. 

 

Figure 20-11: Compute Dialog 

3. This will bring up the following dialog box: 

 

Figure 20-12: Computation Results 

4. Set Export Format to Comp Book and add a file 
name.  Pick Export, get the following output file: 
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Figure 20-13:  Output 

 
 

 

 

 

 

Notice, in the example above, multiple quantities 
were calculated at once.  You can add the items that 
you need calculated in the collection box by double 
clicking on it.  If you want to remove an item from 
the collection box, simply double click on it in the 
box. 

Examples of area quantities that are calculated in the plan 
view are, sidewalk and concrete pavement.  Since GEOPAK 
uses shapes to calculate areas, area quantities are not quite as 
simple as the “By Each” and “linear” quantities, but once you 
get used to it, it is a time saver.  The following Workflow will 
guide you through the process. 

Workflow 3: Calculating “Area” Quantities 

1. Highlight the item you want to calculate, then pick 
the Shape button on the menu bar. 

 

Figure 20-14:  Place Shape Icon 

2. The following dialog box will come up. 
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Figure 20-15:  Place Shape Dialog 

The correct level symbology will be automatically 
input.  The Automatic button has three choices: 
Semi-auto, Automatic, and exclusive.  Semi-auto 
will allow you to pick the items you want to create 
the shape with, Automatic will create a shape 
around a point that you pick inside your area, and 
exclusive will create a shape where you want to 
exclude an area such as a planter in the sidewalk. 

3. The two methods that you can use are Automatic 
and Exclusive.  Exclusive is used when there is a 
deduction from the area, for example a planter in 
the middle of a sidewalk.  Automatic is used when 
there is no need for deduction.  The easiest 
method is Automatic; the tolerance and radius 
values can be adjusted if automatic is not 
working.  Pick Draw and pick a data point in the 
middle of the area that you want the shape in.  
GEOPAK will draw the shape.  When you pick draw 
with Exclusive, GEOPAK will prompt you to pick a 
data point inside the outside shape.  Once you 
pick that data point, GEOPAK will highlight the 
outer shape and then prompt you to pick inside 
the inner shape to deduct.  Once that data point is 
selected, GEOPAK will draw the shape with the 
hole in it. 

4. Go back to Plan Quantity Computation dialog box, 
Pick Compute Quantities and the following dialog 
box will appear. 

 

Figure 20-16: Compute Dialog 
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5. Change the Output to Item Report and pick 
Compute.  The following report is what will be 
produced. 

 

 

Figure 20-17: Output 

GEOPAK can also calculate volumes and weights of items such 
as pavement and base course.  But because the pavement and 
base course have edge tapers, these quantities are more 
accurately calculated using a spreadsheet or in the earthwork 
run. 

Quantities in Cross Sections 

Besides Earthwork, surfacing, pavement removal, and topsoil, 
the cross sections are used to calculate seeding and clearing.  
The earthwork and topsoil calculations will be covered in 
another chapter.  This chapter will provide workflows that 
show you how to calculate the other two quantities. 

Workflow 4: Calculating “Clearing” Quantities 

1. Open your cross section file and access the XS 
Reports dialog box.   This can be done by pressing 
the Reports & XS Quantities button in the bottom 
right hand corner of Project Manager, or by 
pressing Applications>GEOPAK ROAD>Cross 
Sections>Reports,  
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Figure 20-18: Accessing Reports 

or by pressing the XS Reports button on the main 
cross-section palette. 

 

Figure 20-19:  Reports Icon 

2. This will bring up the following dialog box. 
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Figure 20-20:  Reports Dialog 

Press User>Preferences to bring up the following 
dialog box. 

 

 

Figure 20-21: Report Settings 
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3. This information will be put at the top of the 
quantity report.  Include the Project Number in 
the Master Header 1 space, and the Road Name in 
the Master Header 2 space.  

4. Press the Clearing button in the XS Report dialog 
box. 

 

Figure 20-22:  Clearing Button 

5. This will bring up the following dialog box.  Make 
sure you check the Beg Station and End Station to 
ensure that they are the stations you want. For 
multiple station ranges, the report may need to be 
run multiple times.  The symbology for the 
Existing Ground will not change (lv = 
X_E_Ground_XS, co = 4, wt = 0, style = 2), and 
the symbology for the Proposed Ground should 
allow GEOPAK to trace completely across from the 
left catch point, over the top of pavement to the 
right catch point. To view the selected symbology, 

pick the symbology button  next to either 
Existing Ground Line or Proposed Finished Grade. 
Cut slope rounding, Additional Clearing in Cut, and 
Additional Clearing in Fill should match what is 
shown in the typical sections.  Each project may 
have different values.  However, typical values are 
3.0 m or 10 ft. for Cut Slope Rounding and the 
Additional Clearing in Cut and Fill should be set at 
1.0 m or 3 ft.  The increment is set at 500 m or 
1000 ft.  

 



 

 
 

EFLHD CADD Standards Manual 
Chapter 20 — Quantities 

20-12 
3/27/2007 

 

Figure 20-23:  Clearing Report Dialog 

The Except Width can be used to subtract out the 
existing pavement width. EFLHD typically does not 
subtract the existing pavement out, but this can 
be used if needed.  Press the Except Width button 
to get the following dialog box 

 

 

Figure 20-24:  Exception Width 

6. Fill in the beginning station, ending station, and 
width, then press the add button .  

7. Type in the filename for your output, then press 
Apply.  The following output file is produced. 
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Figure 20-25:  Output 

Workflow 5: Calculating “Seeding” Quantities 

1. Follow steps 1 through 4 in workflow 4. 

2. Press the Seeding button on the XS Report dialog 
box. 

 

Figure 20-26:  Seeding Button 

3. This will bring up the following seeding dialog 
box.  The elements are the same as the clearing 
report with some additional needed information.  
The Candidate Seeding Element section needs the 
symbology of the slopes that will be seeded 
(typically the cut, fill, and ditch foreslopes).  
These are the slopes that will be seeded.  The Max 
allowable slope can vary on each project.  This 
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slope will be determined during the project, but 
for preliminary quantity calculations, you should 
use 1V:2H as the max allowable slope.   

 

Figure 20-27: Seeding Report Dialog 

4. Pick the Additional Distance button to bring up the 
following dialog box. 

 

Figure 20-28: Additional Distance 

5. Fill in the appropriate values. They should be the 
same as the Cut Slope Rounding and Additional 
clearing in fill values used in the clearing report.  
Type in the output file you want GEOPAK to write 
the quantities into and press Apply.  GEOPAK will 
produce the following file. 
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Figure 20-29:  Output 
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Chapter 21:  Reports 
 
 

Introduction 

GEOPAK uses the cross section files to produce staking 
reports in EFLHD format.  The creation of these will be 
required on all EFLHD projects that have cross sections.  
These reports include staking details, slope stake reports, and 
red and blue top reports.  The following sections will describe 
the processes used to create each of the reports. 

GEOPAK progresses from left to right across each cross 
section while preparing each report.  To do this, the user will 
need to provide the level symbology of the existing ground 
and all the proposed elements required to progress through 
the points and lines, to be reported on, completely across the 
cross section. 

These reports will be placed in ASCII files for ease of printing 
and electronic transfer. 

 

Workflow 1: Access Cross Section 
Reports 

1. While in the cross section file, open the 
Project Manager Dialog Box. 

2. The Reports & XS Quantities button is located 
at the bottom right. 

 

 

 

 

 

 

 

 

 

 



 

STANDARDS FOR USE WITH X30 CRITERIA 
 
 

 

EFLHD CADD Standards Manual 
Chapter 21 — Reports 

 

 

 

 

 

 

 
Figure 21-1:  Accessing Reports from Project Manager 
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3. The XS Reports dialog box will appear. 
 

 
Figure 21-2:  Reports Menu 

Alternatively, reports may be accessed outside of Project Manager by 
selecting Applications>GEOPAK ROAD>Cross Sections>Reports, 
as shown below. 
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Figure 21-3:  Accessing Reports 

Report Headers 
All reports will require a header to describe the project and report type.  
The header can be modified by picking the User>Preferences button 
at the top of the XS Report dialog box.  This will bring up the Report 
Header dialog box. 
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Figure 21-4: Reports Settings 

The date, first two master headers and page number should be 
marked.  The first master header should have the complete project 
name and number, i.e. Nevada Forest Highway Project FH 24-1(1). 

The second master header should have the name of the road.  The 
tolerance should be around the values shown.  If GEOPAK stops at 
many cross sections these values can be adjusted.   
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The File pull down menu will allow you to save this 
information to a text file.  If you are working on more 
than one project, you can easily import the correct 
information on subsequent runs. 

 

 
Keep in mind that the Radius of Display Circle needs 
to be less than the smallest line segment on the 
proposed cross section.  If the smallest line 
segment is the top of curb and it is .15 m (6 in.) then 
the Radius of Display Circle needs to be .1 (.25 ft.). 
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Staking Detail Report 
The Staking Detail Report is used to locate the catch points at each 
section.  The Staking Detail button is located third from the bottom on 
the XS Report dialog box.  When selected, you will get the following 
dialog box. 

 
Figure 21-5: Staking Report Dialog 

To set the symbology values for the Existing Ground Line and 
Proposed Finish Grade, pick the symbology button  to get 
the following dialog boxes: 

 

    Figure 21-6: Existing Ground Line 
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     Figure 21-7: Proposed Finish Grade 

The buttons to the right of the data field allow the user to select the 
values to populate the data field. The Reset button clears the values 
that populate the fields, Display highlights the elements that meet the 
criteria, and Match allows the user to pick the elements to include in 
the selection set. The values shown in the Existing Ground Line and 
Proposed Finish Grade sections will allow GEOPAK to progress 
through the top of subgrade.  This is the path needed to get the correct 
report.   

The values shown in the Proposed Finish Grade are only for a 
standard ditch or fill section.  There will need to be additional 
symbology added to the Proposed Finish Grade section if 
retaining walls and other elements are added to the cross 
sections. 

 

 

 

 

Slope Stake Report 
The Slope Stake button is located above the Staking Detail button.  
When selected, the following dialog box will appear. 

 
Figure 21-8:  Slope Stake Report Dialog 
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The values in the Existing Ground Line and Proposed Finish Grade 
sections will be the same as used in the Staking detail Report.  The 
only difference is the addition of the Reference Hub.  This is the cell 
used to indicate the location of the reference hubs on the cross 
section. 

 

 

21-8 
3/27/2007 

 

 

Make sure you use FHWA Ver 1.  Not FHWA Ver 2.   

Red Tops Reports 
Red Tops reports indicate all breakpoints at the top of subgrade 
between the hinge points.  There are two reports that are needed; the 
standard Red Top Report and the XYZ Red Top Report.  The Blue & 
Red Top button is at the top of the XS Report dialog box. 

 

 
Figure 21-9: Blue and Red Top Report Dialog 

Again for the Red Tops, use the same level symbology as for the 
Staking and Slope Stake reports.  The only information that is needed 
is in the Text button.  That will bring up the following dialog box: 
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Figure 21-10: Report Text Set 

The text is in the cross section at the point that you want reported.  
The Header label is how the report will label that point.  To add a point 
to the list simply type in the text you want reported on and the label for 
that text and hit the add button .  If you want to change the header 
or text, highlight the line you want changed and GEOPAK will put the 
information in the Text and Header Label spaces, make your 
modifications and hit the modify button .  To delete a label, 

highlight the line to delete and pick the Delete button . 
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You can save this information for future use by 
picking the file button at the top of the dialog 
box.   

 

Make sure the Red button is shown in the Blue & Red Top report 
dialog box and hit Apply. 

The XYZ Red Top Report is the same as the Red Top Report, just 
change the button that says Red to XYZ. 

 To differentiate the XYZ Red Top Report from the XYZ 
Blue Top Report, go back to the user button on the 
XS Report dialog box and add Red Top XYZ Report to 
Master Header 3.   

 

 

 

Blue Tops Reports 
Blue Tops reports indicate all breakpoints at the top of base course.  
There are two reports that are needed, the standard Blue Top Report 
and the XYZ Blue Top Report.  The Blue & Red Top button is at the 
top of the XS Report dialog box. 
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Figure 21-11: Blue and Red Top Report Dialog 

For the Blue Tops, use the level symbology for the top of Base 
course.  You may need to include the top of pavement 
symbology if the foreslope has the same symbology along the 
base course as the pavement section. The only information that 
is needed is in the Text button.  That will bring up the following 
dialog box: 

 
Figure 21-12:  Report Text Set 

The text is in the cross section at the point that you want 
reported.  The Header label is how the report will label that 
point.  To add a point to the list simply type in the text you want 
reported on and the label for that text and hit the add button.  If 
you want to change the header or text, highlight the line you 
want changed and GEOPAK will put the information in the Text 
and Header Label spaces, make your modifications and hit 
modify.  To delete a label, highlight the line to delete and pick 
the Delete button. 

21-10 
3/27/2007 



 

STANDARDS FOR USE WITH X30 CRITERIA 
 
 

 

EFLHD CADD Standards Manual 
Chapter 21 — Reports 

 

Make sure the Blue button is shown in the Blue & Red Top 
report dialog box and hit Apply. 

 

The XYZ Blue Top Report is the same as the Blue Top Report, 
just change the button that says Red to XYZ. 
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To differentiate the XYZ Red Top Report from the XYZ 
Blue Top Report, go back to the user button on the XS 
Report dialog box and add Blue Top XYZ Report to 
Master Header 3.   

There may need to be an occasion when yellow top 
reports are needed.  There is a button for yellow tops and 
the process is the same as both the red and blue tops.   
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Chapter 22: Print / Plot Procedures 
 
 

 

Creating PS Files Using Print/Plot 
1. Get into Microstation and call up the 

Print/Plot dialog using the Microstation 
pulldown menus. (File > Print/Plot) 
 

 
Figure 22-1:  Microstation Print/Plot 
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2. Select the PostScript Plot Driver File. 

The appropriate PostScript plot driver is 
pscript_ebid.plt. (Click here to download latest 

version of pscript_ebid.plt) 
The currently selected plot driver is displayed 
in the Plotter: field located at the top of the 
dialog. If pscript_ebid.plt is not the current 
plot driver, then click on File > Select Bentley 
Driver.  

 

    
 

3.  Locate pscript_ebid.plt, and select it. For 
EFLHD employees It will be in 
d:\Bentley\Workspace\system\plotdrv\post
script\ 
A pen table (date.tbl) that places the date, 
time, and file name along the left edge of any 
of the standard sheet borders is 
automatically attached when you select the 
pscript_ebid.plt plot driver 

 
Figure 22-2:  Select Plotter Driver 
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4. Set a fence around the plan sheet and select 
Fence as the Plot Entity. 
Generally the fence should be snapped to 
exactly the same points used for plotting 
hard copies of the plan sheets. 
Make sure that Fence rather than View appears 
in the General Setttings portion of the dialog. 
Pick the View button to change to Fence if 
necessary. 

 

                                      
Figure 22-3:  Select Plot by Fence 

5. Select the sheet orientation (landscape or 
portrait) to match the orientation of the 
sheets in the design file. The sheet in the 
Orientation box should reflect the option 
chosen.  

6. Make sure the Rotation button in the middle 
of the dialog box is set to No rotation.  

7. If the settings aren't as shown below, you 
don't have the correct version of the plot 
driver file (pscript_ebid.plt). The latest 
version of the plot driver can be downloaded 
from the link in step #2. 
(You should only have to do this step once 
per Microstation session.) 
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Figure 22-4:  Page Setup 

8. Check Plot Layout 
Click on the Plot Layout icon (circled in red 
below) or select Setup > Layout... from the 
pulldown menus. 
The two things to check here are:  

9. Scale to value should be set to 100  

10. There should be very little, if any, white 
space around the blue rectangle in the 
middle of the dialog 
(the white block represents the 11x17 paper 
and the blue rectangle represents the size of 
the plot for the current scale value)  
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11. If the settings in the Plot Layout dialog 
aren't as shown below, you don't have the 
correct version of the plot driver file 
(pscript_ebid.plt). The latest version of the 
plot driver can be downloaded from the link 
in step #2. 
(You should only have to do this step once 
per Microstation session.) 
 

 
Figure 22-5: Plot Layout 

12. Check Plot Options 
Click on the Plot Options icon (circled in red 
below) or select Setup > Options... from the 
pulldown menus. 
Neither Fence Boundary nor Plot Border 
should be checked. If they are, uncheck 
them. 
(You should only have to do this step once 
per Microstation session.) 
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Figure 22-6:  Plot Options 

13. Preview the plot (optional) 
The plot utility shows a preview on the right 
side of the dialog box or pick the Preview 
button on the button bar to get a larger 
preview. 
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Figure 22-7:  Plot Preview 

14. Create the PostScript plot file 
Click on the Plot icon (circled in red below) or 
select File > Plot from the pulldown menus. 
The Save Plot As: dialog will pop up.  

15. Notice the directory where the 
PostScript files will be written. Change the 
directory if you want the PostScript file to go 
somewhere else.  

16. In the Files: field type in a name for the 
PostScript file. Name the sheets so as to 
conform to the same naming convention as 
for .dgn files, but with the .ps extension.  See 
the Microstation chapter on file naming 
conventions for this information. 

17. When you hit the OK button the 
PostScript file will be created. 
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Figure 22-8:  Save Plot As 

Creating PS files for cross sections using the Print/Plot 
method would be very time consuming.  Since the 
cross sections are usually plotted in one file, you can 
use the Batch plot method.  To do this, you need to 
make sure the following four rules are followed. 

• Rectangular Microstation shape elements 
("plotting shapes") must placed around each sheet 
outlining the areas within the dgn file to be 
plotted. 
The standard preference files for BatchPlot are set 
up to look for the plotting shapes with the 
following level/symbology:  LV=61   CO=0   
LC=2   WT=1.  

• There should be no cross section sheets in a 
separate drawing that needs to be inserted within 
the sheets in your cross section drawing.  

• Plotting shapes within a each design file must 
have been drawn into the file in exactly the order 
the PostScript files are to be created. 
For example, if the design file contains sheets 
number 5 through 8, then the first plotting shape 
drawn into the file must be around sheet 5, the 
second plotting shape drawn into the file must be 
around sheet 6, etc.  

Duplicate or extra plotting shapes are not allowed 
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 Creating PS Files Using BatchPlot 
 

1. Make sure the design files to be translated 
are set up exactly as outlined in the four 
rules above. (If your design file contains 
GEOPAK cross-sections created with the 
standard cross-section layout files then it is 
already set up correctly.)  

2. If you're BatchPlotting standard cross-
section layout files, make sure to delete all 
the unused sheets cells from the design file. 
BatchPlot will plot each and every cross-
section sheet cell in the design file regardless 
of whether or not there are actual cross-
sections drawn in the sheet.  

3. Call up the BatchPlot dialog from the 
MicroStation pulldown menus (File > Batch 
Print/Plot). The dialog will initially appear as 
shown below with the Printer, Plot Area, 
Layout, and Display specifications set to 
Default.  

 
Figure 22-9:  Batch Plot 

4. Select the settings for creating PostScript 
files. There are pre-defined BatchPlot 
settings files that should be used.  

5. The appropriate settings are selected by 
choosing File > Open... from the pulldown 

menu (or the button) to bring up the Open 
Job Set File dialog, as shown below.  
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6. In the list box at the left of the Open Job Set 
File dialog select either 
postscript_files_landscape or 
postscript_files_portrait to match the 
orientation of the sheets in the design file, 
and then click on the OK button to attach the 
settings. 
(Note: If you don't see the 
postscript_files_landscape and 
postscript_files_portrait selections in the 
Open Job Set File dialog, it most likely means 
that you don't have the latest BatchPlot 
settings files on your computer. Click here to 
download the latest versions of these files.)  

 
Figure 22-10:  Open Job Set 

7. The Open Job Set File dialog will disappear 
and the BatchPlot dialog should appear as 
shown below with Printer set to either 
PostScript Files, Landscape or PostScript 
Files, Portrait to match the design file sheets, 
and Plot Area, Layout, and Display set to 
PostScript Files.  
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Figure 22-11:  Landscape Plots 

8. Select the design file(s) where the plan 
sheets are drawn.  

9. Use Edit > Add Files... from the pulldown 

menus (or the button) to bring up the 
Select Design Files to Add dialog, as shown 
below.  

10. In the Select Design Files to Add dialog, 
navigate to the directory where the design 
files reside.  

11. Select the file(s) with the plan sheets 
you want to create PostScript versions of.  

12. Click on the Add button to add the 
file(s) to the Selected Files list at the bottom 
of the dialog. (Note: The files will be plotted 
in the order they appear in the Selected Files 
list.)  

13. Click on the Done button to return to 
the main BatchPlot dialog.  
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Figure 22-12: Add Files 

14. The selected files should now appear in 
the Design Files to Plot section of the main 
BatchPlot dialog, as shown below.  
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Figure 22-13:  Landscape Plots 

15. Run BatchPlot to create the PostScript 
files. Select File > Print... from the pulldown 

menus (or the button) to begin creating 
the PostScript files. The dialog shown below 
should immediately pop up. Make sure the 
Print Range is set to All, and then click on the 
OK button to start the processing.  

 
Figure 22-14: Print Dialog 

The MicroStation window should begin flashing and the 
Percent Complete window should pop up. 
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Figure 22-15 Percent Complete 

16. When processing is completed, there 
will be a message in the Microstation status 
field summarizing the results of the 
procedure. Ideally the status message will 
indicate that there were no failures, as in the 
example shown below. If, on the other hand, 
the status message indicates that there were 
failures, check the BatchPlot log file 
(ustation\out\plot\batchplt.log) for details.  

 
17. If everything worked correctly there 

should now be one PostScript file per plan 
sheet in your project directory. The 
PostScript files should be named XSS000.ps, 
XSS001.ps, XSS002.ps, etc. 

 

You will need to check that all postscript files were 
created properly by running them through Acrobat 
Distiller to create .pdf files. 

 

As part of the final submittal of a project.  The designer 
will need to create a CD that has the following: 

• .PDF of every plan sheet 
• .PS of every plan sheet 
• All quantity spread sheets and reports 
• Staking reports. 

 

This CD will be provided to the Construction Engineer 
as part of the Project Engineer’s Notebook. 
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Chapter 23:  Working Units Policy 

 
 

Background: 

  
Federal Lands Highway Bridge Office has been in 

process of converting to the Microstation V8 format and 
producing standards using uniform cell libraries and seed 
files. Up until the use of Microstation V8, different Working 
Units had been used to develop drawings to different scales.  
 

Objective: 

  
 The objective of this plan is to develop a standard 
uniform procedure in developing drawings in the Microstation 
V8 format. This procedure includes the creation of new 
Microstation V8 files and the conversion of details and 
drawings that have been developed prior to Microstation V8 
to the Microstation V8 format.  
 

Findings: 

 
 A total of Seventeen states where contacted and 
surveyed on key elements in regards to Microstation V8 
working units and resolution. In addition, the three Federal 
Lands Highway Offices were also contacted and surveyed on 
the same topics. Both Highway Design and Bridge Design 
groups were contacted during the survey.  The following is a 
list of common findings: 
 

• Most states have converted or are in process of 
converting to English Units 

• Most states are using survey foot (Needs to be 
activated in units .def file to have available for use) 

• Most states started out using Bentley Working Unit 
defaults when converted from Microstation V7 to 
Microstation V8.  

• All States are maintaining as-built drawings  
• In several states, Bridge Design offices maintained 

architectural units in their resolution working units for 
Microstation V8 while Highway Design offices 
maintained engineering units.  
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• Some Highway Design offices have either converted to 

architectural units or considered the conversion. 
• Highway Design offices have found that resolution set 

at 1000 per foot is not enough resolution for cross 
sections. They have updated the resolution to 10000 
per foot. 

• It is not uncommon for a bridge design office to scale 
drawings from highway design offices for their details. 

 
 

Other Findings: 

 
 The definition between a foot and a US survey foot is 
as follows; 
 
1 foot = .3048000 m 
 
1 survey foot = .3048006 m 
 
The foot used by Microstation V8 as a default from the 
standard unit list is based on the foot definition, not the 
survey foot definition. This is the correct definition for most 
work outside of civil and surveying disciplines. If, however 
the data is based on geodetic survey measurements, using 
this default from the standard unit definitions list in 
Microstation will yield incorrect results on the order of 6 parts 
in a million. Therefore, survey foot must be used on details 
linked to mapping or highway details using an engineering 
scale, but not required for an architectural scaled detail like a 
bridge detail. 
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Federal Lands Highway Bridge - O FILE STRUCTURE 
FOR PROJECTS 

 

0Border.dgn (Copied from the Seed file directory) 

 

This is a file that contains 1 drawing. This drawing is 
referenced 40 times into 0Project.dgn so that all global 
project information is place on this drawing. Whatever is 
placed on this drawing will be shown automatically on all 
drawings in 0Project.dgn.  

Examples how you would put on 0Border.dgn 

Project title in Title Block – Natchez Trace Parkway 

Total number of sheets on Bridge Drawing field 

Team Leader Name 

PRELIMINARY NOT FOR CONSTRUCTION 

Etc. 

 

0Project.dgn (Copied from the Seed file directory) 

 

This file is solely a project assembly file. Nothing is to be 
drawn in this file. 0Border.dgn is referenced into 0Project.dgn 
for general information in relation to the project as described 
above. In addition to 0Border.dgn being attached several 
times to this file, individual drawing files will be attached. 
These individual drawing files will include information unique 
to that drawing.  
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pe.dgn (Created using a seed.dgn file) 

 
This is an example individual drawing file that will be attached 
into 0Project.dgn. This is your actual working file. All 
drawings and text will be placed in this file. All unique details 
and information in relation to this drawing will be located 
here. Microstation File Naming Convention in the FLHBO 
Manual is to be used to name files. Drawings are to be 
completed as models with logical names for easy future 
reference. Models are to be drawn to full scale then 
referenced strategically at a reduced scale into one of the 
borders from the seed file that was attached when the file 
was created. The Bridge Plans Planning Sheet also located in 
FLHBO Manual, must be used to identify which border will be 
used. 
 
Examples you would find in unique drawing file as pe.dgn: 
 

Unique details 
Specific sheet number, designer name or checker name 
for that drawing 
Scale 
Etc. 

 
Refer to attached FLHBO FILE STRUCTURE FOR PROJECTS for 
further clarification of project structure. 
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Figure: 24-1 
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               Figure: 24-2 
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          Figure: 24-3 
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     Figure: 24-4 
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Figure 24-5 
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Figure 24-6 
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EFLHD DISTRIBUTION PACKAGES 

 
Please note, in coordinating with Highway design, all EFLHD 
Distribution Packages are to incorporate the following format 
or changes: 
  
1. Sheet numbers are to start with a capitol R and be 
numbered R01, R02, R03 etc. 
  
2. PDF files are to have the following format and file name 
designations: 
  
    XXX -YYYYYYYY_ZZZ.dgn 
   sheet number-Project Name_sheet namethat is referenced 
into 0Project.pdf 
  
Example:  
    
   R01-NATR1J15_pe.pdf 
  
3. Total Sheets Box is to be removed. We will not show total 
sheets 
  
4. NPS NO. Box is only to be shown on project title sheet. 
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Final preparation of CADD files at 
PROJECTADVERTISEMENT 

 

Step 1: Copy “0Projects.dgn” file to “0ContractPlans.dgn” in 
same directory 

 
Step 2: Open “0ContractPlans.dgn” 
 
Step 3: Copy entire contents using fence (Must use Clip 
Fence!!!!!!) 
 
Step 4: Mark original location of files 
 
Step 5: Detach ALL Reference files
 
Step 6: Delete all other original lines and info 
 
Step 7: Move borders and contents back to original location 
using fence 

 
 

OR 
 

Complete Steps 1 & 2 
 
New step 3: Reference filename then drop tools to “ Merge 
to Master”. 
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                                                     Figure 25-1 
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Figure 24-2 
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HOW TO USE GEOPAK REBAR TO CREATE A BAR SCHEDULE 
 

Please note that all projects must follow Federal Lands Highway Bridge 
Office Standards. This includes file setup. Projects are to be developed by 
using the “oplot.dgn” method. In summary each drawing is to be in its 
own file and referenced to the oplot.dgn file for project organization and 
printing. No file is to contain more than one drawing.  Reinforcement 
schedules are also too located in a single file. The reinforcement schedule 
is the only file that will be associated with GEOPAK REBAR. This file name 
is to be called Rebar.dgn and the associated file that GEOPAK REBAR 
produces is called Rebar.rdb. Rebar.rdb is the file where all the GEOPAK 
REBAR logic is stored. 
 
 
 

 
1- Open MicroStation and click Applications 
2- Go to GEOPAK REBAR and click on Menu 

 

 
 

Figure: 26-1 
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3- Geopak Rebar Login bar menu will appear. 
4- Click on Menu and go to select Project. 
5- Select Project dialog box will appear, choose FHWA_M0705 for 

Metric projects and FHWA_E2004 for English projects and proceed. 
 

 
 
 
 
 
 

 
 

Figure: 26-2 
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6- The information box will appear, click OK 
 
 

    

 
 

Figure: 26-3 
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7- The Schedule Details dialog box will appear, fill the necessary 

information and under Bar Mark Numbering, check per layer box, 
this will create the schedule with all bars (no matter what the bar 
size is) in sequence, S1, S2, S3, …etc. 

8- Click Open Schedule, Status will change to Schedule OPEN, close 
the dialog box. 

 
 
 
 
 

 
 

Figure: 26-4 
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Figure: 26-5 
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9- GEOPAK Rebar menu will appear, click Tools and choose Bar 

Placement and Bar Editing. 
 

 
 

Figure: 26-6 
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10- Bar Placement Tools and Bar Editing menus will appear, you will 
need to click the Bar Placement Tools to expand the bar menu. 

 
 
 
 

 
 

Figure: 26-7 
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11- Click Settings and choose Schedule. 
 
 
 

 
 

Figure: 26-8 
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12- Schedule bar menu will appear. 
 

 
 

Figure: 26-9 
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13- To download the STANDARD BAR LAYERS (PF, P, AF, A, AT, W, 
…etc) for EFL, click on the Settings and choose Bar Defaults. 

 

 
 

Figure: 26-10 
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14- The Bar Defaults menu will appear click Read Defaults File button.  
 

 
 

Figure: 26-11 
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Figure: 26-12 
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15- Load Bar defaults window will open. 
16- Go to 

m:\apps\geopakv8\rebar\projects\FHWA_2004Edition\def71002E 
(for English and M for Metric). (Sterling path) 

17- Change List Files of Type to (All Files [*.*]), choose file 
def71002E.def (def71002E.def for English and def71002M.def for 
metric) and click OK. EFL STANDARD BAR LAYERS will be created.  

 

 

 

Figure: 26-13 
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18- Assume you have the following abutment footing details, the 
design calls for 16 stirrups #16 (12 between piles & 4 outside 
piles), 7 bars #22 at the top and 8 bars #25 at the bottom of 
footing.   

 
 

 
 

Figure 26-14 
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19- To create the bar schedule, copy or draw the concrete lines.  
20- To draw the #22 top bars, click on the One Legged Bar button on 

the Bar Placement Tools menu and using the cursor click on the 
top concrete line of the footing elevation.  

 
 
 

 

Figure 26-15 
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Figure: 26-16 
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21- The Bar Placement menu will appear, click the Bar End Details 
button, the Bar End Details and BARLEGENDS menus will appear.  

22- On the Bar End Details menu, check the appropriate cover (50 or 
75mm) and click left side, click Next End and repeat the step for 
right side.    

 

 
 

Figure: 26-17 

 

 

 

 

 

 

 



 

STANDARDS FOR USE WITH X30 CRITERIA 
 

 

26-19 
3/28/2007 

EFLHD CADD Standards Manual 
Chapter 26—Bridge - Geopak Guidelines 

 

 

 

 

 

 
 

Figure: 26-18 
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23- Geopak will create the top bar. 
24- From the BARLEGENDS choose bar diameter (#22) and bar layer 

(A), for epoxy coated bars use (#22E). 
Note: You can use AF (Abutment Footing) for bar layer if required.  

 

 
 

 
Figure 26-19 
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Figure: 26-20 
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Figure: 26-21 
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25- No labeling will be done in this file. All labeling 

Will be done in the files that contain the actual details. 
  
26- From the Bar Placement menu, click Schedule Data button, Bar 

Schedule Details will appear. 
27- Change Number of Bars to 7 and Number of Sets to 2 (Two 

abutments), Total Quantity will change to 14, close the window. 
 

 
 

Figure: 26-22 
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Figure: 26-23 
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28- Save the bar by clicking Save Bar button. 

 
 

 

 
 

Figure: 26-24 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

STANDARDS FOR USE WITH X30 CRITERIA 
 

 

26-26 
3/28/2007 

EFLHD CADD Standards Manual 
Chapter 26—Bridge - Geopak Guidelines 

 
 
 
29- Repeat the same steps for the bottom bar (bar size #25, Number 

of bars 8, Number of Sets 2) 
 
 
 
 

 
 

Figure: 26-25 

 
 
 
 
 
 
 
 
 
 
 
 

30- To draw the #16 stirrups, click on the FOUR SIDED STIRRUP 
button on the Bar Placement Tools menu and using the cursor click 
on the four sides of the footing side view.  
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Figure: 26-26 

 

 

 

 

 

 
31- Repeat the same steps as for the Top & bottom bars using bar size 

#16, the program will create the stirrup. 
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Figure: 26-27 
 
 

 

 

 
 

32- From the Bar Schedule Details window, change Number of Bars to 
16 and Number of Sets to 2 and close the window. 
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Figure: 26-28 
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33- Place fence around the details. 
 
 

 
 

 
Figure: 26-29 
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34- Click the Schedule Listing button on the Schedule Bar menu, the 

Schedule Listing window will open, check the Fence box and all 
footing bars will appear.  

 

 

 

 

Figure: 26-30 
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Figure: 26-31 

Note: There are different ways to create the bar schedule, by checking 
the Fence, Bar Chart, Member or Layer box, we used the Fence for this 
handout.     

 
 

 

 

 

 

 

 
 
 

35- Click Create Bar Chart button, Bar Chart Placement window will 
open, fill the necessary information and click the Locate button. 
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Figure: 26-32 
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Figure: 26-33 
 
 

 
36- Schedule Masses window will open and the total reinforcement 

quantity will appear. 
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Figure: 26-34 
 
 
39- Projects designed for EFLHD will require schedules to be turned off. 

This will be accomplished by masking the reference files. All masking is 
to be done in the Rebar.dgn file. Future Editions will have a different 
procedure involving importing and exporting schedules.  
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BATCH PLOT GUIDELINES 
To Plot a series of drawings or total project

Using Cell Name: “Batch plot area”  
 

Step 1: Place Cell “Batch plot area” over borders you want to print. 
Place them in the order you want. 

 
Step 2: Initiate Batch Print from “File” pull down menu. 
 

Step 3: Select “Print Area” 

 
Step 4: Select “Specifications” button 
 
Step 5: Select method “Cell” then hit OK. 
 
Step 6: Select “Specifications Properties” 
 
 Select “Cell” 
 Check off:  

 Master File 
 References 
 Process Multiple Boundary Elements (at 

bottom of menu) 
 Type in “Batch plot area” for cell name 
  
 Hit OK 
 
Step 7: Under “Edit” menu, Select “Add Active File” 
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  Note: may add more than one file 
 
Step 8: Select Print, verify pen table and print drive and hit OK 
   

PLOT DRIVE INSTRUCTIONS: 
  Highlight “Printer” 

Select “Specifications” button 
  Hit “Driver” button 
  Locate following:   
  M:\cadd\PLOTDRV\e_lpt1.plt 
  Hit “OK” 
   

PEN TABLE INSTRUCTIONS: 
Highlight “Display” and double click 
Select “Specifications” button 

  Hit “Browse” button 
  Locate following:   
  M:\cadd\PENTABLE\LABELS.TBL 
  Hit “OK” 

 
 
Step 9: Hit OK thru any other menu that pops up. 
 

Step 10: Save job in projects folder. File name is in format  

_name_.job 
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BRIDGE SEED FILES & CELL LIBRARIES 
 
 
You can find seed files for all three offices, Eastern, Central, and 
Western in both English and Metric. There are 6 directories total with 3 
files in each directory. The 3 file names are similar to the following, 
but may vary a bit to distinguish English vs.. Metric and other 
attributes of origin: 
  
0Border.dgn 
0Project.dgn (Formally 0Plot.dgn. This was renamed to 0Project) 
Seed.dgn 
  
The location of these seed files is at: 
  
M:\cadd\SEED\bridge\BridgeV8\Eastern Seed Files English 
M:\cadd\SEED\bridge\BridgeV8\Eastern Seed Files Metric 
  
M:\cadd\SEED\bridge\BridgeV8\Central Seed files English 
M:\cadd\SEED\bridge\BridgeV8\Central Seed Files Metric 
  
M:\cadd\SEED\bridge\BridgeV8\Western Seed Files English 
M:\cadd\SEED\bridge\BridgeV8\Western Seed Files Metric 
  
  
The location and names of the Updated Microstation V8 Cell Libraries 
are: 
  
M:\cadd\CELL\BridgeV8\V8English051706 
M:\cadd\CELL\BridgeV8\V8Metric051706 
  
These Cell Libraries are to be used on all projects regardless of 
geographical location. 
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Chapter 29: Consultants Deliverables 
Introduction  
Throughout the life of the contract, Consultants will be required to 
submit their files (Deliverables Items) to EFLHD.  If these standards 
are followed, the Consultant will only need to write their directory 
structure to a CD and submit with only a brief description of 
Geopak chain names, profile names, and file naming convention. 

 

Deliverable Items - Items that the Contractor provides the 
Government under the terms of the contract, including 
reports, documents, plans, maps, and other required 
items. 

 
 
 
Government Provided Data: 
 
The following items are provided to the Contractor:  
 

No. Item Description Format(1) (2)

 PDDM 
World Wide 
Web 

 FLH A/E Task Order Procedures Manual 
World Wide 
Web 

 EFLHD Construction Manual with EFLHD Slope Staking Procedures .pdf 

 
Standard Specifications for Construction of Roads and Bridges on 
Federal Highway Projects, FP03 

.pdf 

 NPS Park Road Standards  

 
NPS Sign Manual located at  
http://www.nps.gov/npsigns/ or 
http://www.nps.gov/hfc/acquisition/uniguide.htm

World Wide 
Web 

 Streetscape Manual located at http://www.nps.gov/streetscape/
World Wide 
Web 

 Design Scoping Report and Updates  
 Library of Specifications (LOS) Word 2000 
 EFLHD Special Contract Requirement Development Guidelines  
 GEOPAK standard input files  
 Microstation seed files (level and symbology, etc)  
 Photogrammetric mapping and horizontal and vertical datum   
 EFLHD Supplemental Survey Specifications  
 As-Builts .pdf 
 Bridge Inspection Reports  
 Soils and Foundation (Geotechnical) Report  .pdf 
 Engineering Study  .pdf 
 Traffic Safety Study  .pdf 
 Traffic and Accident Data  .pdf 
 FLH / EFLHD Standards and Details  
   

http://www.nps.gov/npsigns/
http://www.nps.gov/hfc/acquisition/uniguide.htm
http://www.nps.gov/streetscape/
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Sample Typical Sections, Drainage Summary Sheets, and Sign 
Schedule Sheets 

 

 
Engineer’s Estimate System (EES) Program, EFLHD Pay Item Lists, 
and Bid History 

 

 Environmental Documentation  .pdf 
 Highway Design Standards form  
 Roadside Design Guidelines form  
 PS&E Forms   
 PS&E Checklist .pdf 
 Sample Invoice Format  
   
   
   
   
   

 
Sample PS&E Package for each Design Phase described in the 
Statement of Work, including: 

.pdf 

    A. Sample Plans   

    B. Sample Special Contract Requirements (SCR)  

    C. Sample Engineer’s Estimate (EE)  

    D. Sample Unit Price Analysis (UPA) and sample UPA forms  

    E. Sample Slope Stake Books  

    F. Sample Critical Path Method (CPM) Schedule  

    G. Sample Design Narrative  

    H. Sample Traffic Control Narrative, if separate from the plans  

 
   I. Sample Sediment & Erosion Control Narrative, if separate 
from the plans 

 

    J. Sample Highway Design Standards form  

    K. Sample Utility Status Report  
  

Table 29-1 
 
 (1) Unless otherwise noted, all Government Provided Data will be in electronic 

format on CD-ROM or DVD. 
  (2) Electronic versions of select items listed here as well as other design 

related resources can be downloaded from 
http://www.efl.fhwa.dot.gov/design/design.htm. 

 
 (3) The lastest version of the pay item files for the ESS can be 

downloaded from http://www.cflhd.gov/design/ee.prog/ 
 
 
 
 
 
 
 
 
 

http://www.efl.fhwa.dot.gov/design/design.htm
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Plans Provided by Consultant: 
Provide plans that are similar in character and assembly to the 
sample plans provided by the Government, with all text being fully 
legible when the plans are printed at half size.  Careful attention 
must be paid to the layout, format, and appearance of the plans.  
The Government will not accept Plans that are excessively cluttered 
with information, are poorly organized, or do not meet the general 
requirements of the Project Development Design Manual (PDDM).  
Provide Plans that contain the following where applicable:   
 
 

No.
Description 

Notes

 Title Sheet  

 Conventional Symbols and 
Abbreviations Sheet 

Provide symbology and abbreviation legend. 

 Location Map and 
Construction Signing Sheet 

Provide sheets containing the location (overall 
site) of each roadway, indicating beginning and 
ending of construction, the Partner Agency’s 
right-of-way, preliminary traffic control, etc. 

 Survey Information Sheets For new and existing centerlines, survey 
control, baselines, or P-lines.  Provide sheets 
containing an overall site (location) map 
showing locations of primary and secondary 
control points, sketches of references, NEZ 
coordinate table of control points, horizontal 
and vertical datum notes, level of SUE survey 
conducted (Quality Level “  ”), etc. 

 Typical Section Sheets  

 Tabulation of Quantity 
Sheets 

Using the EES program. 

 Schedules and Summaries Mileage tabulation, removals, erosion control 
devices, earthwork, paving and pavement 
patching, drainage, underdrain, guardrail, 
permanent striping, permanent sign, remove 
and reset sign, construction sign, etc. 

 Plan & Profile Sheets Provide alternative rehab options. 

 Construction Plan Sheets Provide sheets indicating the work to be 
performed. 
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 Special Plan Views Separate blow-up views of all intersections 
requiring work, and other necessary locations 
requiring increased detail. 

 Pavement Elevation Sheets For areas of pavement not shown in the plan 
and profile sheets or construction plan sheets. 

 Erosion Control Narrative 
and Plans 

Provide separate sheets for erosion control 
narrative and plan views. 

 Landscaping Plans  

 Temporary and Permanent 
Signing and Striping Plans 

Provide separate sheets for temporary 
signs/striping and permanent signs/striping. 

 Traffic Control Plans Including construction phasing, if necessary. 

 Signal, Lighting, and 
Electrical Plans 

Traffic signal, showing heads, loops, poles, 
mast, and other appurtenances, and required 
phasing.  Include locations for street lights, 
conduits, manholes, pull boxes, etc. 

 Drainage and Utility Plans 
and Profiles 

Provide separate plan and profile for storm 
drainage systems, any box culvert construction 
or extensions.  Show headwater depths and 
hydraulic grade-lines. 

 Drainage Cross Sections For highway culvert and inlet replacements, 
and extensions.  Show headwater depth, limits 
of spread, and hydraulic grade-line for all 
culverts >36”. 
----------(Choose one or both as applicable)----
------ 
For all closed system storm sewers (all sizes). 

 Detail Sheets Retaining walls, traffic signals, streetlights, box 
culvert repairs including headwalls, and special 
inlets. 

 EFLHD Standard Details and 
Standard Drawings 

Provide separate sheets for special details for 
any details not included in the standard library. 

 Roadway Cross Sections Provide roadway cross-sections at 50’ intervals. 

 Bridge Plans and Details Show areas needing repair and types of repair 
for:  (Insert specifics) 

 
 

Table 29-2 
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    Deliverables:  The contract work and supporting 

documents will be created and delivered to the 
Government according to the following formats: 

 
 Electronic Transfer of Data:  The Government requires 

the following to ensure compatibility with software used by 
the Government and to ensure the efficient and timely 
exchange of computer files between the Government and 
the Contractor. 

 
 All files submitted must be fully compatible with the 

software versions listed in Chapter 1 of this document 
without any conversion or editing by the Government.  Any 
files requiring conversion and/or editing by the 
Government will not be accepted.  All files shall be virus 
free.  All files shall use the Government’s file naming 
convention. 

 
   1. Computer Aided Design (CAD) Files:  All CAD files 

shall be provided in Microstation (*.DGN) compatible 
format and  software versions as listed in Chapter 1 
unless specifically exempted by the Government. 

 
2. GEOPAK Interactive Highway Design Files:  The 

Government will provide the GEOPAK standard input 
files (*.GPK, *.INP, *.X, *.DDB) to the Contractor.  
These files include design standards, design criteria, 
slope selections, baseline name, profile names, 
contract plan sheet cells, guardrail information, etc.  If 
the Contractor is required to modify the design criteria 
or any other files, the Government’s Microstation level 
Library, color tables, line weights, symbology, etc., 
will be maintained.  The Government will provide the 
Government’s seed files, level library, color tables,  
line weights, symbology, font library, and cell files to 
the Contractor.  When the design is completed, all 
project input/output files shall be provided to the 
Government in a format fully compatible with the 
software versions listed in Chapter 1. 
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  The GEOPAK software has menu options to generate the 

following Government reports/files.  The Contractor shall 
provide the Government the following reports/files in 
GEOPAK’s current Government format:   

 
Slope stakes 

Red tops/Blue tops 

Clearing 

Seeding 

Staking detail 

Original cross section list 

Design cross section list 

Horizontal alignment 

Profile grade  

Earthwork volumes 
 

HEC2 terrain ASCII file (input file for the HEC2 hydraulic 
analysis software) 
WSPRO terrain ASCII file (input file for the WSPRO 
hydraulic analysis software) 
Radial staking ASCII file (in order by station) which 
contains the x-y-z coordinates of all of the transit points 
and, for each terrain station, the  
x-y-z coordinates for the ROW lines, reference hubs, slope 
stakes, hinge points, shoulders, and centerline. 

 

 
Table 29-3 

 
3. Location Survey Files:  The Contractor shall submit 

control point data in ASCII format with each record 
containing the point’s identification (see PDDM, Chapter 5), 
north coordinate, east coordinate, and elevation.  Digital 
terrain model high/low points and breakline points shall 
each have the same format as above.  
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   4. Photogrammetric Files:  The Government will 
provide the Contractor with the Government’s 
Microstation seed files, level library, line weights, color 
table, symbology, font library, and cell files.  Digital 
terrain model data shall be submitted in the most 
current 3-D Microstation software design files 
compatible with the software versions listed in Chapter 
1.  Contour and planimetric data shall be submitted in 
2-D Microstation design files. Note:  The Government 
will provide the Contractor with photogrammetric 
mapping, performed by the Government, in 3-D 
Microstation *.DTM files, 3-D mapping, and 
Microstation/GEOPAK *.TIN files. 

 
 
 
 
   5. Word Processing, Spreadsheet, and Database 

Files:  For each Phase, all relevant files shall be 
provided in a format fully compatible, as appropriate, 
with the following: 

 
     Word Processing:   Microsoft Word 2003 
     Spreadsheets:            Microsoft Excel 2003 
     Databases:  Oracle, Microsoft Access 2003 
 
      6. Engineer’s Estimate Files:  The Contractor shall 

provide the Engineer’s Estimate System (EES) in a 
format fully compatible for use as input to the 
Government’s EES database.  The Government will 
provide the Contractor with the current version of the 
EES program, including the pay item database and bid 
history. The EES is currently running on a Foxpro 
Database. Current versions of the EES pay items are 
available at http://www.cflhd.gov/design/ee.prog/. 

 
 
 These specifications will be updated as necessary to reflect 

changes in the Government software such as adding new 
software or updating to new versions of existing software.  
In such instances, the Contractor will be promptly notified. 
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Computer File Exchange Media:  Electronic files shall be 

exchanged between the Government and the Contractor 
using the following media as appropriate for Windows 
Operating Systems: 

 
   1. Compact Disc (CD):  Files on CD(s) should be actual 

size, not compressed. 
 

   2. DVD:  Files on DVD should be actual size, not 
compressed. 

 
 

3. EMAIL:  Files 5 MB or smaller may be transferred via 
EMAIL.  If compressed, the files should be self-
extracting.  Contact the COTR for access information. 
 

4. Files may be placed on EFLHD FTP web site. Contact 
the COTR for access information. 

 
5. Files maybe submitted by Portable Hard Drives, 

Flash Drives. Contact the COTR for procedures. 
 
 

 
 Copies:  The Contractor shall provide hard paper copies 

(plan size 11”X17”) and electronic copies of the 
deliverables for each Phase of Work.  For all deliverables, 
provide electronic copies in two electronic versions; an 
electronic version in the original electronic file format (i.e., 
Microstation (*.DGN), Microsoft Word (*.DOC), Microsoft 
Excel (*.XLS), etc.) and an electronic version in Adobe 
Acrobat (*.PDF) file format.  
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